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About this document

This document describes how to use the Nortel Networks Preside 
Multiservice Data Manager (MDM) Nodal Provisioning and Embedded 
Nodal Provisioning applications. 

Nodal Provisioning provides a graphical user interface for provisioning 
Passport components and selected services. Nodal Provisioning is intended 
for making large provisioning changes.

Embedded Nodal provisioning is launched from Passport Shelf View and lets 
you access a subset of the Nodal Provisioning functionality to make simple or 
limited provisioning changes to a node. This access is useful in 
troubleshooting situations where you want to change a few components or 
attributes. 

In this document, references to Passport refer to Passport 7000, Passport 
15000, and Passport 20000 devices.

The following topics are discussed in this section:

• “Who should read this document and why” (page 20)

• “What you need to know” (page 20)

• “How this document is organized” (page 20)

• “What’s new in this document” (page 20)

• “Text conventions” (page 21)

• “Related documents” (page 22)
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Who should read this document and why
You should read this document if you are responsible for managing and 
provisioning Passport devices with the Preside Multiservice Data Manager 
(MDM) Nodal Provisioning application.

What you need to know
This document assumes that you have knowledge of the Preside Multiservice 
Data Manager (MDM) and an understanding of the device being provisioned.

How this document is organized
This document contains the following sections:

• “Nodal provisioning overview” (page 23) 

• “Starting Nodal Provisioning” (page 39) 

• “Connecting to a Passport device” (page 51)

• “Component hierarchy view” (page 63)

• “Shelf view” (page 79)

• “Nodal Provisioning forms” (page 101)

• “Navigating component hierarchy and shelf view” (page 111)

• “Component provisioning procedures overview” (page 137)

• “Post-provisioning procedures” (page 197)

• “Nodal Provisioning user preferences” (page 205)

• “Nodal Provisioning Template Editor” (page 219)

• “Report Generator” (page 323)

• “Nodal Provisioning Log Viewer” (page 373)

• “Embedded Nodal Provisioning” (page 389)

What’s new in this document
The following feature was added to this document:

• “Nodal Provisioning for JVM Support” (page 21)
241-6001-610   14.3RSUP   



About this document   21
Nodal Provisioning for JVM Support
This feature affects the behavior of minimizing and closing windows. See 
“Minimizing and closing windows” (page 32).

Text conventions
This document uses the following text conventions: 

• nonproportional spaced bold type

Nonproportional spaced bold type represents words that you should type 
or that you should select on the screen.

• italics

Statements that appear in italics in a procedure explain the results of a 
particular step and appear immediately following the step.

Words that appear in italics in text are for naming.

• [optional_parameter]

Words in square brackets represent optional parameters. The command 
can be entered with or without the words in the square brackets.

• <general_term>

Words in angle brackets represent variables which are to be replaced with 
specific values.

• UPPERCASE,lowercase

In MDM, uppercase and lowercase letters that appear in UNIX 
commands and parameters must be matched exactly. The system matches 
upper and lowercase characters differently.

• |

This symbol separates items from which you may select one; for 
example, ON|OFF indicates that you may specify ON or OFF. If you do 
not make a choice, a default ON is assumed.
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• ...

Three dots in a command indicate that the parameter may be repeated 
more than once in succession.

The term absolute pathname refers to the full specification of a path starting 
from the root directory. Absolute pathnames always begin with the slash ( / )
symbol. A relative pathname takes the current directory as its starting point, 
and starts with any alphanumeric character (other than /).

Related documents
See the following documents for related information:

• 241-5701-060 Passport 7400, 15000, 20000 Components

• 241-6001-100 Preside MDM Installer Guide

• 241-6001-303 Preside MDM Administrator Guide

• 241-6001-310 Preside MDM Server Reference Guide

• 241-6001-600 Preside MDM Service Provisioning for ATM User Guide

• 241-6001-601 Preside MDM Service Provisioning for IP VPN Global 
Update User Guide

• 241-6001-602 Preside MDM Service Provisioning for CES SVC User 
Guide

• 241-6001-603 Preside MDM Service Provisioning for Frame Relay User 
Guide

• 241-6001-611 Preside MDM Nodal and Service Provisioning Reference 
Guide

• 241-6001-801 Preside MDM Overview
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Chapter 1
Nodal provisioning overview

For an overview of Nodal Provisioning see the following sections:

• “About Nodal Provisioning” (page 23)

• “Nodal Provisioning functionality” (page 24)

• “Nodal Provisioning architecture” (page 25)

• “Date Convention” (page 31)

• “Using the keyboard” (page 31)

• “Minimizing and closing windows” (page 32)

• “Help options” (page 32)

— “Accessing Help on the main window” (page 34)

— “Accessing attribute descriptive help” (page 35)

— “Accessing Help on dialogs and forms” (page 36)

— “Accessing attribute range tool tip help” (page 37)

About Nodal Provisioning
Nodal Provisioning is part of the Preside Multiservice Data Manager (MDM). 
It provides a graphical user interface (GUI) for provisioning Passport 
components and selected services. Nodal Provisioning lets you define, edit 
and display service data. Provisioning changes do not affect the operation of 
the device until the configuration is activated.
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Nodal Provisioning provides service templates for the following:

• ATM access 

• VPN FR DTE access 

• Frame Relay access

• Succession services (UA-ALL1 and PT-AL)

• MPLS Infrastructure and Services 

Nodal Provisioning functionality
Nodal provisioning provides the following main functions:

• “Component provisioning” (page 24)

• “Service provisioning” (page 24)

• “Service template creation” (page 25)

Component provisioning
You can create and edit components using Nodal Provisioning. 

You can add a component to the component hierarchy using a component 
creation form. You can add multiple instances of a component from a single 
component creation form. For a description of the component creation form, 
see the section “Component forms” (page 103)

You can also edit a single component instance using a dynamically generated 
component edit form. These forms display the attributes that comprise the 
component. For a description of the component edit form, see the section 
“Component edit form” (page 104):

Service provisioning 
You can create and edit services using Nodal Provisioning.

You can create some services by applying a service template to a valid 
dropsite in the component hierarchy. This action opens a service creation 
form which contains the provisionable attributes for the components in the 
service. Only those attributes that you need to set are visible. All other 
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component attributes are handled by the provisioning software. The service 
template form also lets you add multiple instances of a service from a single 
component creation form.

For additional information, see the following sections:

• for a generic description of the service template form, see the section 
“Service template form” (page 106)

• for information on how to provision specific services, and a description 
of the service templates for each service, see 241-6001-611 Preside 
MDM Nodal and Service Provisioning Reference Guide.

 You can also edit provisioned services, such as ATMIf, using a dynamically 
generated service edit form. 

The service edit form contains all the components in the service, and displays 
the attributes that you can provision. 

Note: Only the services that correspond to a single sub-tree in the 
component hierarchy can be edited (for example, FRUNI and ATMIF).

For a description of the service form, see the section “Service edit form” 
(page 108).

Service template creation
You can create and modify your own service templates using the Nodal 
Provisioning Template Editor. These templates, as well as the templates 
created by Nortel Networks, appear in the service template palette of the 
Nodal Provisioning window. For information on the template editor, see 
“Nodal Provisioning Template Editor” (page 219).

Nodal Provisioning architecture
For an overview of the Nodal Provisioning architecture, see the following 
sections:

• “Nodal Provisioning User interface” (page 28)

• “Configuration Manager (CONFIGMAN)” (page 29)

• “Passport configuration server (PCSERVER)” (page 29)
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• “Component model generator” (page 29) 

• “Model files” (page 30)

• “Nodal Provisioning Template Editor” (page 30)

For an illustration of the Nodal Provisioning architecture, see the figure 
“Nodal Provisioning architecture” (page 27).
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Figure 1
Nodal Provisioning architecture
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Nodal Provisioning User interface
The Nodal Provisioning user interface is driven by a set of components and 
service models. It provides the following features:

• device selection 

• hierarchical representation of components (referred to as the component 
hierarchy) 

• graphical representation of the physical and logical views of the Passport 
shelf (referred to as the shelf view)

• component and service provisioning using dynamically generated forms

• cut, copy and paste capability for components and subcomponents, 
within a device and between devices

• service template creation and modification

• nodal data spreadsheets 

• records of user actions 

The user interface also provides Passport specific session control:

• authenticating to a Passport device

• opening a Passport view

• saving a Passport view

• activating and committing a Passport view

For a description of the Nodal Provisioning user interface, see the following 
sections:

• “Component hierarchy view” (page 63)

• “Shelf view” (page 79)

• “Nodal Provisioning forms” (page 101)

• “Nodal Provisioning Template Editor” (page 219)
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Configuration Manager (CONFIGMAN)
The Configuration Manager (CONFIGMAN) provides configuration services 
and associated templates for the user interface. It also communicates with the 
Host Group Directory Server (HGDS) to get the host/node groups and 
members for managed Passport devices. 

For additional information on the Configuration Manager, see the 
Configuration Manager (CONFIGMAN) section in 241-6001-310 Preside 
MDM Server Reference Guide.

Passport configuration server (PCSERVER)
The configuration servers connect to devices and translate configuration 
requests from the configuration manager to device specific messages and vice 
versa. For example, the Passport configuration server creates and manages the 
Passport configuration providers. Each Passport configuration provider 
provides access to a single Passport device. The Passport configuration 
provider provides the communication with the Passport and all the functions 
related to Passport configuration including loading, modifying, or saving the 
view. It also generates the model data files that are used by the Configuration 
Manager, the user interface, and other MDM configuration management 
applications.

For additional information on the Passport configuration server, see the 
Passport Configuration Server (PCSERVER) section in 241-6001-310 
Preside MDM Server Reference Guide.

Component model generator
The component model generator converts device-specific component 
descriptions to component models that are used by the Configuration 
Manager and the user interface. The standard format is based on eXtensible 
Markup Language (XML).

The attribute information for each type of component that can be configured 
on the device is used by the user interface to create a component form for that 
component, or to display a subset of the attributes for the component in a 
service template form.
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Model files
Model files are an XML representation of the attributes that make up a 
component or service. There are four types of models:

• Component model (CM) contains data description and the attribute 
information for each type of component that can be configured on the 
device. These files are used to create the component forms or to display 
a subset of a component’s attributes in a service template form.

• Hierarchy model (HM) contains the hierarchical relationship between 
components in a device.

• Service model (SM) describes a service that can be configured 
generically for a device. It contains information about components that 
make up the service.

• Service template model defines the specific attribute values that are used 
in creating an instance of a service. The service template model also 
defines the acceptable drop points for the service and whether the 
dropsite is the parent of the service, or a component to which the service 
is linked.

The component and hierarchy models are generated by the Passport model 
generator. The service and service template models are generated manually. 

Nodal Provisioning Template Editor
The Nodal Provisioning Template Editor provides a graphical user interface 
for creating and modifying service templates based on existing model files. 
The template editor is data driven and uses the XML formatted service 
template (.st) files as input. Service template files are installed with the 
Preside Multiservice Data Manager (MDM). 

The Nodal Provisioning Template Editor is designed for expert users who 
create new templates and for intermediate users who modify existing 
templates. The template editor lets you create and modify templates that are 
based on existing model files. If a service has a service model, users can 
create and modify the templates for that service. 

You install and run the Nodal Provisioning Template Editor on the server 
workstation. 
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Date Convention
To account for the year 2000 and beyond, when years are shown as two-digit 
numbers, for example in the format yymmdd, the following conventions 
apply: 

• Years 80 to 99 represent the twentieth century. For example, 800101 
represents January 1, 1980.

• Years 00 to 79 represent the twenty-first century. For example 000101 
represents January 1, 2000.

Using the keyboard
You can use the keyboard instead of the mouse to select a menu command. 
You can execute a command by using a command accelerator. See the 
following sections:

• “Mnemonics” (page 31)

• “Command accelerators” (page 31)

Mnemonics
Every menu option in the menu bar has a mnemonic associated with it. The 
mnemonics are usually the Alt key followed by a single character that 
uniquely identifies a particular menu item. The single character that selects a 
given menu item is shown by the underscore under that letter in the name of 
the menu item.

You can use mnemonics by pressing the Alt key, entering the mnemonic for 
the menu bar option, and then entering the mnemonic for the entry that you 
want to use in the menu. For example:

Alt + F + N is the mnemonic for New Device
Alt + F + O is the mnemonic for External Tools

Command accelerators
You can use command accelerators to execute menu commands. The 
accelerators are usually the control key followed by the first letter of the menu 
option. For example:
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Ctrl + N is the command accelerator for New Device
Ctrl + O is the command accelerator for Open View

Cutting, copying and pasting text 
To cut, copy and paste text when using the Nodal Provisioning, you use the 
cut, copy and paste buttons on the Solaris keyboard.

Minimizing and closing windows
When a window is minimized, all its children windows are minimized. 
Similarly, when a window is closed, all its children windows are closed as 
well.

 Help options
Help is available in most Preside Multiservice Data Manager (MDM) tools 
from either a Help button or a Help menu item. General descriptive help is 
available for the main windows and many of the dialogs. General descriptive 
help provides information about the window or dialog box. It describes the 
user interface, menus and tool-bars.

Nodal Provisioning also provides the following types of help:

• attribute level help is accessed from a pop-up menu. The attribute help is 
displayed in a separate dialog and is based on the selected field. See the 
section “Accessing attribute descriptive help” (page 35).

Note: Not all attributes have attribute help.

• tool tip help provides valid data ranges for some fields. Where the range 
is large, or not easily quantified, you are provided a text field in which to 
enter the information. When you save, the data that you entered is 
validated against the range specified in the model. See the section 
“Accessing attribute range tool tip help” (page 37).

Nodal Provisioning and Nodal Provisioning Template Editor provide various 
types of help. For information on using the help options, see the following 
sections:

• “Accessing Help on the main window” (page 34)

• “Accessing Help on dialogs and forms” (page 36)
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• “Accessing attribute descriptive help” (page 35)

• “Accessing attribute range tool tip help” (page 37)
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Accessing Help on the main window

Purpose
Use this procedure to access the Help on Window from the Help menu from 
the Nodal Provisioning, Nodal Provisioning Template Editor, Log Viewer and 
Report Generator windows. Help on Window displays the Online 
documentation for the main window, menus and tool bars, and the general 
functions.

Procedure
1 In the menu bar of the Nodal Provisioning window, click Help.

2 Select Help on Window.

A window opens with general descriptive help for the Nodal Provisioning 
comprisewindow.and 
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Accessing attribute descriptive help

Purpose
Use this procedure to access a pop-up dialog box that provides descriptive 
information on selected attributes.

Procedure
1 Right-click on an attribute field.

2 On the pop-up menu, click Help.

A dialog box opens displaying information about the attribute.

For an example of attribute descriptive help, see the illustration “Example 
of attribute descriptive help” (page 35).

Figure 2
Example of attribute descriptive help
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Accessing Help on dialogs and forms

Purpose
Use this procedure to access help information for the Nodal Provisioning, 
Nodal Provisioning Template Editor, Log Viewer and Report Generator 
dialogs, and for component, service and service template forms. 

Procedure
1 Open a form.

2 Click Help.

A window opens with descriptive help for the form.
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Accessing attribute range tool tip help

Purpose
Use this procedure to access a pop-up dialog box that displays tool tips that 
give the valid ranges for some attributes.

Procedure
1  Place the mouse pointer on an attribute field for two seconds. 

A pop-up tool tip dialog box opens displaying the valid ranges for the 
attribute.
Preside MDM Nodal Provisioning User Guide   14.3RSUP



38   Chapter 1 Nodal provisioning overview
241-6001-610   14.3RSUP   



39
Chapter 2
Starting Nodal Provisioning

This section provides procedures for starting Nodal Provisioning. For more 
information, see:

• “Overview” (page 40)

• “Starting Nodal Provisioning without context from the Preside MDM 
window” (page 41)

• “Starting Nodal Provisioning without context from the service 
provisioning tools” (page 42)

• “Starting Nodal Provisioning with context from the Start Tool menu in 
the Fault toolset” (page 43)

• Starting Nodal Provisioning from a command line

— “Starting Nodal Provisioning from a command line without a device 
name or component specified” (page 45)

— “Starting Nodal Provisioning from a command line with a device 
name” (page 46)

— “Starting Nodal Provisioning from a command line with a 
component name” (page 47)

— “Command line options” (page 48)

• “Selecting the Configuration Manager server” (page 50)
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Overview 
On a Preside Multiservice Data Manager (MDM) workstation, you can start 
Nodal Provisioning without or with component context using the following 
methods:

• without context

— Preside MDM window. See “Starting Nodal Provisioning without 
context from the Preside MDM window” (page 41).

— Tools menu in the ATM, Frame Relay, and IP VPN Global Update 
service provisioning tools. See “Starting Nodal Provisioning 
without context from the service provisioning tools” (page 42).

• with component context from the Start Tool menu in the Fault 
Management tools. See “Starting Nodal Provisioning with context from 
the Start Tool menu in the Fault toolset” (page 43).

• command line. See “Starting Nodal Provisioning from a command line” 
(page 44).

You can start Nodal Provisioning on a workstation that is not running MDM 
(referred to as the client workstation) from a command line. See “Starting 
Nodal Provisioning from a command line” (page 44).

If the configuration file contains more than one Configuration Manager 
server, a dialog box opens asking you to specify a Configuration Manager 
server.

Once you have started Nodal Provisioning, and before you can provision 
service data on a Passport node you need to successfully log on to a network 
destination with a valid userid and password, and open a view. See 
“Connecting to a Passport device” (page 51).
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Starting Nodal Provisioning without context from the 
Preside MDM window 

Purpose
Use this procedure to start Nodal Provisioning without context from the 
Preside Multiservice Data Manager window. 

Procedure
1 From the Preside MDM window, select Configuration ->Passport 

Devices ->Nodal Provisioning.

If more than one Configuration Manager server is specified in the 
configuration file, a Select Server dialog box opens. 

Before you can provision a Passport device, you will need to complete the 
following procedures:

• “Selecting the Configuration Manager server” (page 50) 

• the sequence of procedures described in “Connecting to a Passport 
device” (page 51)

If only one Configuration Manager server is specified in the configuration 
file, the Nodal Provisioning splash screen opens followed by the Nodal 
Provisioning - Device Selection dialog box. Proceed to complete the 
sequence of procedures described in “Connecting to a Passport device” 
(page 51).
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Starting Nodal Provisioning without context from the 
service provisioning tools

Purpose 
Use this procedure to launch Nodal Provisioning from the Tools menu in the 
main window of the following service provisioning tools:

• ATM

• Frame Relay

• IP VPN Global Update

Procedure
1 Start the desired service provisioning tool:

• To start the ATM service provisioning tool, see 241-6001-600 Preside 
MDM Service Provisioning for ATM User Guide.

• To start the Frame Relay service provisioning tool, see 241-6001-603 
Preside MDM Service Provisioning for Frame Relay User Guide.

• To start the IP VPN Global Update tool, see 241-6001-601 Preside 
MDM Service Provisioning for IP VPN Global Update User Guide.

2 In the menu bar of the service provisioning tool window, select Tools -> 
Nodal Provisioning.

If more than one Configuration Manager server is specified in the 
configuration file, a Select Server dialog box opens. Before you can 
provision a Passport device, you will need to complete the following 
procedures:

• “Selecting the Configuration Manager server” (page 50) 

• the sequence of procedures described in “Connecting to a Passport 
device” (page 51)

If only one Configuration Manager server is specified in the configuration 
file, the Nodal Provisioning splash screen opens followed by the Nodal 
Provisioning - Device Selection dialog box. Proceed to complete the 
sequence of procedures described in “Connecting to a Passport device” 
(page 51).
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Starting Nodal Provisioning with context from the Start Tool 
menu in the Fault toolset

Purpose
Use this procedure to start Nodal Provisioning with component context from 
the Start Tool menu of any of the following Preside Multiservice Data 
Manager (MDM) Fault tools:

• Network Status Bar

• Network Viewer

• Component Status Display

• Alarm Display

• Component Information Viewer

Note: Since the device is determined from the context, you do not need 
to select a device. You therefore bypass the procedure for selecting a 
Passport Device.

Procedure
1 Select a component, and right-click on the component.

2 From the pop-up menu, select Start Tool -> Configuration -> Nodal 
Provisioning.

If more than one Configuration Manager server is specified in the 
configuration file, a Select Server dialog box opens. Before you can 
provision a Passport device, you will need to complete the following 
procedures:

• “Selecting the Configuration Manager server” (page 50) 

• the sequence of procedures described in “Connecting to a Passport 
device” (page 51)

If only one Configuration Manager server is specified in the configuration 
file, the Nodal Provisioning splash screen opens followed by a 
authentication dialog box. For the procedure to authenticate to a Passport 
device, see “Authenticating to a Passport device” (page 55).
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Starting Nodal Provisioning from a command line
You can start Nodal Provisioning from a command line. You have the 
following options: 

• “Starting Nodal Provisioning from a command line without a device 
name or component specified” (page 45)

• “Starting Nodal Provisioning from a command line with a device name” 
(page 46)

• “Starting Nodal Provisioning from a command line with a component 
name” (page 47)

See also, “Command line options” (page 48) for a description of the 
command line options.
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Starting Nodal Provisioning from a command line without a 
device name or component specified

Purpose
Use this procedure to start Nodal Provisioning from a command line, but 
without the device or component options specified. 

Procedure
1 Use one of the following commands to start Nodal Provisioning from a 

command line from the client machine or from the machine where the 
MDM server is located. 

/opt/MagellanNMS/bin/anpui

The Nodal Provisioning splash screen opens, and one of the following 
occurs:

If more than one Configuration Manager server is specified in the 
configuration file, a Select Server dialog box opens. Before you can 
provision a Passport device, you will need to complete the following 
procedures:

• “Selecting the Configuration Manager server” (page 50) 

• the sequence of procedures described in “Connecting to a Passport 
device” (page 51)

If only one Configuration Manager server is specified, the Nodal 
Provisioning - Device Selection dialog box opens displaying a list of 
managed devices. Proceed to complete the Passport pre-provisioning 
tasks described in “Connecting to a Passport device” (page 51).
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Starting Nodal Provisioning from a command line with a 
device name

Purpose
Use this procedure to start the nodal provisioning script with a device name 
specified. Nodal Provisioning opens with device context.

You can start the nodal provisioning script (anpui) without options or with any 
combination of options. If you do not specify any options and you have 
predefined user preferences, then Nodal Provisioning uses those preferences 
to open a provisioning session. If you do specify options, those options 
override any predefined user preferences. For details about user preferences 
and how to set them, see “Nodal Provisioning user preferences” (page 205).

If you specify all the options to the script, Nodal Provisioning opens directly, 
without dialog boxes prompting for authentication and views. 

Procedure
1 Use one of the following commands to start Nodal Provisioning with a 

Passport device name from either the client workstation or the workstation 
where the MDM server is located. 

/opt/MagellanNMS/bin/anpui 
[-emcomp <passport_node_name>]
[-aut <userid> <password>]
[-loadview <view_mode> <view_name>]
[-access <ro|rw>]
[-configman <host>]
[-help]

For example, /opt/MagellanNMS/bin/anpui -emcomp LONDON. For 
details about the command line options, see “Command line options” 
(page 48).

If you specify the full options when starting the nodal provisioning script 
and those options are correct, the Nodal Provisioning window opens. If 
you did not specify all options, dialog boxes prompt for the required 
information before opening the Nodal Provisioning window. 
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Starting Nodal Provisioning from a command line with a 
component name

Purpose
Use this procedure to start Nodal Provisioning with component context from 
a command line. When you start the nodal provisioning script with a full 
component name specified, Nodal Provisioning opens with component 
context.

You can start the nodal provisioning script (anpui) without options or with any 
combination of options. If you do not specify any options and you have 
predefined user preferences, then Nodal Provisioning uses those preferences 
to open a provisioning session. If you do specify options, those options 
override any predefined user preferences. For details about user preferences 
and how to set them, see “Nodal Provisioning user preferences” (page 205).

If you specify all the options to the script, Nodal Provisioning opens directly, 
without dialog boxes prompting for authentication and views. 

Procedure
1 Use one of the following commands to start Nodal Provisioning with a 

component’s full path. If you specify a component’s full path but no other 
options, Nodal Provisioning uses any predefined user preferences to 
determine the service data view. The -action option determines how the 
component displays. You can use this command to evoke Nodal 
Provisioning from a client workstation or from the workstation where the 
MDM server is located:

/opt/MagellanNMS/bin/anpui 
[-emcomp <component_full_path>] 
[-aut <userid> <password>]
[-loadview <view_mode> <view_name>]
[-access <ro|rw>]
[-action <select|edit>]
[-configman <host>]
[-help]

For example, /opt/MagellanNMS/bin/anpui -emcomp 
EM/LONDON AtmIf/11. For details about the command line options, see 
“Command line options” (page 48).
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For details about the command line options, see “Command line options” 
(page 48).

If you specify the full options when starting the nodal provisioning script 
and those options are correct, the Nodal Provisioning window opens. If 
you did not specify all options, dialog boxes prompt for the required 
information before opening the Nodal Provisioning window. 

Command line options
The following options are available when starting the Nodal Provisioning 
script (anpui) with a device or full component name. 

<passport_node_name> is the name of the Passport node to which you 
want to connect.

<component_full_path>  is the full path of a component that you want 
to provision. For example, /opt/MagellanNMS/bin/anpui -emcomp 
EM/LONDON AtmIf/11.

-aut <userid> <password> is the authentication option. Specify the 
appropriate authentication user ID and password for the node.

-loadview <view_mode> <view_name> is the service data view mode. 
Possible values for view_mode are commit, current, edit, key, date, or user. If 
you specify a view_mode value of key, date, or user, then you need to specify 
the view_name. For example, /opt/MagellanNMS/bin/anpui -emcomp 
EM/LONDON -loadview user myView.full.001.

-access <ro|rw> is the access mode when opening a data service view. 
Access can be read only (ro) or read and write (rw). 

-action <edit|select> specifies how nodal provisioning opens. Edit 
opens a component form; select opens a tree view with the specified 
component selected. If you do not specify the -action option, Nodal 
Provisioning uses the component tree display.

-configman <host> specifies the configuration manager. <host> is the 
host workstation.
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-help displays the nodal provisioning command and its associated 
options. If you specify an incorrect number of arguments for any option, then 
the help information displays.
Preside MDM Nodal Provisioning User Guide   14.3RSUP



50   Chapter 2 Starting Nodal Provisioning
Selecting the Configuration Manager server 
Select a Configuration Manager server when the configuration file contains 
more than one Configuration Manager server. When you start Nodal 
Provisioning and multiple Configuration Manager servers exist, the Select 
Server dialog box opens automatically. This dialog box displays a list of 
servers from which you can make a selection.

Procedure steps
1 In the Select Server dialog box, select the desired configuration manager 

sever from the list of servers.

2 Click OK.

The Nodal Provisioning - Device Selection dialog box opens and 
displays a list of managed devices. 

3 To select and connect to a Passport device, see the section “Connecting 
to a Passport device” (page 51).

If you have selected a device that is in provisioning mode, an error dialog 
box opens stating that the selected device is in provisioning mode. You 
are provided with the option of selecting a new device.
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Connecting to a Passport device

This section describes procedures that you need to perform to connect to a 
Passport device. For more information, see the following sections:

• “Overview” (page 51)

• “Selecting a Passport device” (page 52)

• “Authenticating to a Passport device” (page 55)

• “Selecting the access mode and view mode” (page 57)

• “Selecting a CDL version” (page 61)

Overview
After you start Nodal Provisioning, you need to complete the following 
sequence of tasks before the Nodal Provisioning window opens and you can 
provision a Passport device:

• “Selecting a Passport device” (page 52)

• “Authenticating to a Passport device” (page 55)

• “Selecting the access mode and view mode” (page 57)

In addition, you may need to select a Command Data Language (CDL) 
version if the model files are not available. See “Selecting a CDL version” 
(page 61).
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Selecting a Passport device
Use this procedure to select the Passport device from a list of available 
devices. You can specify or select a device directly, or if your network 
contains a large number of devices, you can expand the dialog box to specify 
criteria to search on all or a subset of the Passport devices in the network.

Note: The last device to appear in the Device Name field before you click 
OK is the selected device. Any prior selections are overwritten.

Prerequisites
This procedure requires the following conditions:

• you have started Nodal Provisioning for the first time, or you have 
selected File -> New Device. 

• if the configuration file contains more than one configuration manager 
server, you have selected a Configuration Manager

Procedure
1 In the Nodal Provisioning - Device Selection dialog, complete one of 

the following steps:

• From the Device Name drop down list of devices, select a device. 
The Device Name field is populated with the selected device. Click 
OK.

• Enter the device name directly into the Device Name field. As you 
type the name, the list entry that matches, or partially matches, the 
input is highlighted. Select a device and click OK. 
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• Click Search to expand the Nodal Provisioning - Device Selection 
dialog box to display the Additional search capability panel. 
Proceed to step 2.

2 Specify the search criteria:

• Device Name specifies the device or device name search pattern for 
retrieval. This field supports wild-card matching.

• Max Num to Retrieve limits the number of devices that your retrieve 
to the number that you enter in this field. The default value is 100.

3 Click Search to initiate the search for the device, or devices, based on the 
specified search criteria.

The Search Results panel is populated with the devices that meet the 
search criteria.

4 In Search Results panel, select a device.

The Device Name field is populated with the name of the selected device.

5  Click OK.
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An authentication dialog box opens. Proceed to “Authenticating to a 
Passport device” (page 55).
241-6001-610   14.3RSUP   



Chapter 3 Connecting to a Passport device   55
Authenticating to a Passport device
Use this procedure and an authentication dialog box to authenticate to the 
selected Passport device with a valid user ID and password. 

Prerequisites
This procedure requires the following conditions:

• Nodal Provisioning is started

•  if the configuration file contains more than one configuration manager 
server, you have selected a configuration manager

• you have selected a device, either for the first time, or by clicking File -
> New Device in the Nodal Provisioning window. 

Procedure
Note:  If you have already authenticated, the Username and Password 
fields are populated with a user name and password. You may need to 
change this information, or you can proceed directly to step 3.

1 In the Username field, type a valid user ID.

2 In the Password field, type a valid password.

3 Click OK.

If the authentication is successful, the authentication dialog box closes. If 
the Open View dialog box opens, proceed to “Selecting the access mode 
and view mode” (page 57).

If the authentication fails, an error dialog box opens with a message 
describing the authentication problem.
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4 The error dialog box gives you the following options:

• New Device opens the Device Selection dialog box. See “Selecting 
a Passport device” (page 52).

• New Password returns you to the authentication dialog box. Return 
to step 1. 

• Cancel closes the error dialog box and returns you to the Preside 
MDM window.
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Selecting the access mode and view mode
Use the Open View dialog box and this procedure to change the access mode 
and Passport view settings.

The Open View dialog opens under the following circumstances:

• automatically, at start-up, after you successfully authenticate to a 
Passport device

• automatically when you select File -> Open View 

• when you select File -> New Device, and the Always Prompt to Open 
View when opening a new device is selected in the User Preferences 
dialog for the Open View dialog box. See “Setting User Preferences for 
uploading the service data view” (page 208).

If default user preferences have already been preset for the Open View, and 
these preferences have been saved in the file MagellanNMS/
NPUserPreferences.cfg, the Open View dialog opens with these preferences.

If the MagellanNMS/NPUserPreferences.cfg file does not exist, Nodal 
Provisioning creates the file using the default values, and the Open View 
dialog opens with the default settings. 

Once you change the default settings or the preset settings, your selections are 
valid for the duration of the provisioning session.

For information on setting user preferences, see the section “Nodal 
Provisioning user preferences” (page 205).
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Figure 3
Open View dialog

Procedure
1 In the Access Mode panel, select one of the following modes:

• Read and Write lets you modify the service data. 

• ReadOnly lets you view the provisioning data corresponding to the 
current operation of the node. You cannot perform any service data 
modifications while in this mode.

2 In the View Mode panel, upload one of the following service data views:

• Committed uploads the committed service data view.

• Current uploads the current service data view.

The access mode panel 
lets you specify whether 
or not you can modify 
the service data.

The View Mode panel 
lets you specify which 
service data view to 
upload. If you select 
Other you need to select 
a keyed, dated or user 
specified view.

The Other Options 
panel lets you turn 
automatic preloading on 
or off, select the option 
to propagate log files, 
and specify a location to 
store the log files.
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• Edit uploads the edit service data view. Service data does not 
preload if you specify Edit mode.

When a committed view is modified, but not saved, these 
modifications are displayed as a read only file the next time the 
committed view is opened in Edit mode.

• Other uploads the service data view according to a key, a date, or a 
user specified view name. 

3 Optionally, in the Other Options panel, if you wish to turn off automatic 
preloading, deselect Preload View.

If you select..., then type the following information in the 
adjacent field.

Keyed A valid key in the format <key>nnn, where <key> 
starts with a number or letter, can contain numbers, 
letters, or underscores for subsequent characters. 
The key cannot exceed 6 characters. If <key> 
contains only numbers, then its length must be at 
least three characters. The service data view that 
matches the pattern and has the highest index is 
found, and the next view in the sequence is created

Dated today, or the date in the format <yymmdd>, where yy 
is the year, mm is the month and dd is the day. See 
“Date Convention” (page 31) for more information on 
the date format. When you enter a date, the service 
data view with the highest two digit index (nn) is 
found. When an exact match does not exist, the most 
recent service data view, relative to the date is used. 
That is, the dated service data view with the latest 
date earlier than the given date is opened. When you 
enter today, the view with today’s date, or the view 
closest to today’s date, is opened.

User Specified A view name, or click Browse and select a user 
specified view from the list of views provided in the file 
browser dialog. Nodal Provisioning uploads the 
service data view according to a user-specified view 
name.
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Note:  Preload View is selected by default. This option enables automatic 
preloading of the Passport service data view whenever users start a 
provisioning session. This option provides few advantages when the view 
contains only a few components, or if you need to access only a small 
number of them.

When preloading is turned off, Nodal Provisioning needs to send requests 
to upload the service data view from the Passport. It takes time to process 
these requests, especially when the view contains many components and 
users need to access many of them.

The Preload View option is ignored when you set the open view mode 
preference to Edit. This is because the Passport provisioning stack needs 
to retrieve data from the Passport editing view located on the Passport 
device.

4 Optionally, if you wish to create a log file of the changes made to the 
Passport service data during a provisioning session, select Propagation 
Logging To.

Propagation log files are stored in the /opt/MagellanNMS/data/ANP 
directory.

If you select Propagation Logging To and type a file name in the /opt/
MagellanNMS/data/ANP/ field, this log file name displays in the status bar 
of the Nodal Provisioning window.

5 Click Ok to accept the access mode and view mode selections and close 
the dialog. The Nodal Provisioning window opens.

Click Cancel If you want to close the dialog without applying the changes.

If the Passport indicates that the previous current view needs to be 
restored, an Open View Warning dialog box opens. Click Close View. To 
restore the previous current view, see “Resolving a restorePossible error 
condition” (page 190).

If the Passport indicates that the journal log file could not be saved, an 
warning dialog box opens. Click Close View. See “Resolving a 
journalDisabledReason error condition” (page 191).

To proceed with this view, click Continue. If you proceed with this view 
and activate the view, the previous view is destroyed.
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Selecting a CDL version

Purpose
Use this procedure to select a Command Data Language (CDL) software 
version. When you select a device, the device version is automatically 
discovered and the model files are retrieved. However if the model files are 
unavailable, a Version Selection dialog box opens.

Version Selection dialog box
For an illustration of the Version Selection dialog, see the figure “Version 
Selection dialog” (page 61).

Figure 4
Version Selection dialog

The Version Selection dialog box warns you that the correct CDL version was 
not found, provides the option to accept the default CDL version, or to select 
another version, and advises of the potential error conditions that may result 
from choosing the wrong version.

Procedure
1 Accept the suggested CDL version, or select a desired CDL version from 

the drop down list of available CDL versions.

2 To select the CDL version, click OK.

 To cancel the operation, click Cancel.
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Component hierarchy view

The following sections describes the Nodal Provisioning window in 
component hierarchy view: 

• “Nodal Provisioning window in component hierarchy view” (page 63)

• “Menu bar” (page 67)

• “File menu” (page 67)

• “View menu” (page 68)

• “Selected menu” (page 69)

• “Options menu” (page 72)

• “External Tools menu” (page 72)

• “Help menu” (page 73)

• “Tool bar” (page 74)

• “View area” (page 74)

• “Service template palette” (page 76)

• “Status bar” (page 78)

• “Component hierarchy view pop-up menus” (page 78)

Nodal Provisioning window in component hierarchy view
When you start Nodal Provisioning, the Nodal Provisioning window opens in 
component hierarchy view.
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For information on starting Nodal Provisioning, see“Starting Nodal 
Provisioning” (page 39). 

For Passport devices, you must have selected a device and authenticated 
before the Nodal Provisioning window opens. For related procedures, see 
“Connecting to a Passport device” (page 51).

While in component hierarchy view, you can change the view to shelf view at 
any time. You can also change the user preferences so that you start Nodal 
Provisioning in shelf view. For additional information on setting user 
preferences for the main window display, see“Nodal Provisioning user 
preferences” (page 205).

Component hierarchy view provides a hierarchical representation of the 
components of a device. The Nodal Provisioning window contains a 
component hierarchy and a service template palette. Based on the hierarchy 
model for the device and the Command Data Language (CDL) software 
version, the component hierarchy is populated to the first level of 
subcomponents and the service palette is populated with service creation 
templates. 

When you make changes in component hierarchy view, the changes are 
propagated to the shelf view. Alternately, changes to the shelf view are 
propagated to the component hierarchy view. For example, if you add a port 
to the component hierarchy in the component hierarchy view, then you will 
see the new port on the corresponding logical processor (LP) in shelf view.

You can only provision one device at a time. If you want to provision more 
than one device you must start another instance of Nodal Provisioning.

For additional information see the following sections:

• For a description of the parts of the Nodal Provisioning window in 
component hierarchy view, see the following sections:

— “Menu bar” (page 67)

— “Tool bar” (page 74)

— “View area” (page 74) 

— “Service template palette” (page 76)
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— “Status bar” (page 78)

• For information on navigating in component hierarchy view, see 
“Navigating component hierarchy and shelf view” (page 111).

• For information on the forms to create and edit components, see 
“Component forms” (page 103).

• For information on the forms to edit services, see “Service edit form” 
(page 108).

• For information on the forms to create services, see “Service template 
form” (page 106).

• For provisioning procedures, see “Nodal Provisioning procedures” 
(page 135)

• For post-provisioning procedures, see “Post-provisioning procedures” 
(page 197).

• For information on the Nodal Provisioning Template Editor, and 
procedures to create service templates, see “Nodal Provisioning 
Template Editor” (page 219).

• For procedures to set user preferences for the Nodal Provisioning 
window, and for opening and saving the view, see “Nodal Provisioning 
user preferences” (page 205).

• For information on creating custom reports, see “Report Generator” 
(page 323).

• For information on viewing real time log messages produced by Nodal 
Provisioning processes, see “Nodal Provisioning Log Viewer” 
(page 373).

For an illustration of the main window with component hierarchy view, see 
the figure “Main window in component hierarchy view” (page 66).
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Figure 5
Main window in component hierarchy view
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Menu bar
The menu bar has the following menus:

• “File menu” (page 67)

• “View menu” (page 68)

• “Selected menu” (page 69)

• “Options menu” (page 72)

• “External Tools menu” (page 72)

• “Help menu” (page 73)

File menu
The table “File menu commands” (page 67) describes the menu commands.

Note: The Check View, Open View, and Save View menu commands are 
only available for Passport devices.

Table 1
File menu commands

Command Description Related information

New Device Opens a confirmation dialog box. Clicking Yes 
exits the current device and opens the Device 
Selection dialog box which lets you select a new 
device.

“Selecting a Passport 
device” (page 52)

Open View Opens the Open View dialog box so that you can 
select a new view file. The dialog box displays 
either the default values which are set in through 
the user preferences, or if none are set, the 
default user preferences.

If you made changes to a view file but did not 
save these, the changes you made will be 
displayed in read only access mode the next 
time you open the view file in Edit mode. If you 
do not want to view or use these changes, you 
must use the Open View command.

“Selecting the access mode 
and view mode” (page 57)

 (Sheet 1 of 2)
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View menu
The table “View menu commands” (page 69) describes the menu commands.

Check View Opens a confirmation dialog box to confirm the 
check view operation, and advising you that the 
check may take a few minutes. Clicking Yes 
proceeds with a check of the currently open 
view. A Check View dialog box opens specifying 
whether or not problems were found. If problems 
are found, they are listed in the dialog box.

“Checking the view during a 
provisioning session” 
(page 181)

Close View Closes the current view. The component 
hierarchy in the main window becomes 
unpopulated.

“Closing the current view” 
(page 112)

Save/Activate 
View

Opens the Save/Activate View dialog box so that 
you can save the active configuration.

“Saving the view for 
Passport devices” 
(page 198)

Exit Closes all windows and the provisioning session.

When a view is edited, and the changes are not 
saved before you exit, the modifications are kept 
and can be displayed in read only access mode 
the next time you open the view in Edit mode.

Table 1  (continued)
File menu commands

Command Description Related information
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Selected menu
The Selected menu provides the commands for component level provisioning 
as shown in the table “Selected menu commands” (page 70). The Selected 
menu commands are common to most components that you select in the 
component hierarchy. However, they are enabled only when they are valid for 
the component that you have selected in the component hierarchy. For 
example, at the node level, only Add, Copy and Paste menu commands are 
available.

The same commands are available from a selected component’s pop-up 
menu. For additional information on the pop-up menu, see “Component 
hierarchy view pop-up menu” (page 75)

When you select a folder in the component hierarchy, that is, a components 
that exceeds the maximum instances that can be displayed (shown visually as 
(x of y)), only the Search and Hide Children commands are available.

Table 2
View menu commands

Command Description Related information

History Opens the History of Changes dialog box. This 
dialog box displays a record of user actions and 
changes that have occurred to the view while the 
Nodal Provisioning is active.

“Viewing and saving a 
record of changes made 
during a provisioning 
session” (page 194)

Shelf Selects or deselects the shelf view. “Switching between 
component hierarchy and 
shelf view” (page 113)

Toolbar Shows or hides the tool bar. “Showing and hiding the 
toolbar” (page 114)

Statusbar Shows or hides the status bar. “Status bar” (page 78)

“Showing and hiding the 
status bar” (page 115)

Reload 
Templates

Populates Nodal Provisioning with all the 
templates. If you have created and saved a 
template, clicking Reload Templates adds the 
new template to the service template palette.

“Updating the service 
template palette in Nodal 
Provisioning” (page 318)
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 The table “Selected menu commands” (page 70) describes the menu 
commands.

Table 3
Selected menu commands

Command Description Related information

Search Opens the Search dialog box which lets you 
search for component instances or a subset of 
component instances. This command is 
available only for components with too many 
instances to display as show by the (x of y) next 
to the component.

“Searching for a component 
in a large instance set” 
(page 120)

Hide Children Hides all the component instances in the 
selected folder. This command is available only 
for components with too many instances to 
display as shown by the (x of y) next to the 
component.

“Hiding all component 
instances in a folder” 
(page 123)

Add Opens the Add Component dialog box which 
displays a list of subcomponents that you can 
select and add to the selected component. Once 
you have selected a component and clicked OK, 
a component form opens with the attributes that 
you can provision.

“Adding a single component 
instance” (page 138)

Edit Opens the component edit form for the selected 
component so that you can edit component 
attributes. The form contains all the editable 
attributes for the selected component.

“Editing a component 
instance” (page 148)

Delete Deletes the selected component and all its 
subcomponents.

“Deleting a component” 
(page 153)

Partial Semantic 
Check

Performs a limited check for semantic errors 
under the selected component. A Check View 
dialog box opens to indicate whether or not 
problems were found. If problems are found, 
they are listed in the dialog box.

“Performing a partial 
semantic check” (page 182)

 (Sheet 1 of 3)
241-6001-610   14.3RSUP   



Chapter 4 Component hierarchy view   71
Apply Service 
Template

Provides a submenu of services that you can 
apply to the selected component. The submenus 
vary with the component that you select.

Selecting a service from the submenu provides a 
list of valid templates When you select a 
template from the list, a service template form 
opens.

“Service template form” 
(page 106)

“Creating a service” 
(page 168)

Hide Hides the selected component in the parent 
folder. This command is only available if the 
parent is a folder.

“Hiding a component 
instance in a folder” 
(page 122)

Cut Opens the cut component dialog box. This dialog 
box displays the selected component and all of 
its subcomponents. You select the component or 
subcomponents that you want to cut.

The Cut command is enabled only if the target 
component of the cut action is a valid target. For 
example, the cut command is not enabled when 
you select the root component.

Copy Opens the copy component dialog box. This 
dialog box displays the selected component and 
all of its subcomponents. You select the 
component or subcomponents that you want to 
copy.

The Copy command is enabled only if the target 
component of the copy action is a valid target. 
For example, the copy command is not enabled 
when you select the root component.

“Cutting, copying and 
pasting components” 
(page 155)

Table 3  (continued)
Selected menu commands

Command Description Related information
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Options menu
The Options menu contains the commands for opening the User Preferences 
dialog box to set and save preferences for subsequent provisioning sessions. 

 The table “Options menu commands” (page 72) describes the User 
Preferences command.

External Tools menu
The External Tools menu provides launch points for the Nodal Provisioning 
Template Editor and the service provisioning tools. The table “External Tools 
menu commands” (page 73) describes the menu commands.

Paste Opens a paste dialog box. This command lets 
you paste copied components and their 
subcomponents into the target component. The 
Paste command is enabled only if the target 
component of the paste action is a valid target.

“Cutting, copying and 
pasting components” 
(page 155)

Generate Report Opens the Report Generator tool which allows 
you to create custom reports on component 
data.

“Report Generator” 
(page 323)

Table 4
Options menu commands

Command Description Related information

User Preferences Opens the User Preferences dialog box. This 
dialog box lets you specify preferences for an 
access mode, a view mode, and the Nodal 
Provisioning window. 

See “Nodal Provisioning 
user preferences” 
(page 205)

Table 3  (continued)
Selected menu commands

Command Description Related information
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Help menu
The Help menu provides access to online documentation for the Nodal 
Provisioning tool. The table “Help menu commands” (page 74) describes the 
menu commands.

Table 5
External Tools menu commands

Command Description Related information

Nodal 
Provisioning 
Template Editor

Provides a launch point for the Nodal 
Provisioning Template Editor.

“Nodal Provisioning 
Template Editor” 
(page 219).

Service 
Provisioning -> 
ATM

Provides a launch point for the ATM service 
provisioning tool.

For procedures to use the 
ATM service provisioning 
tool, see 241-6001-600 
Preside MDM Service 
Provisioning for ATM User 
Guide

Service 
Provisioning -> 
CES SVC

Provides a launch point for the CES SVC service 
provisioning tool.

For procedures to use the 
CES SVC service 
provisioning tool, see 
241-6001-602 Preside 
MDM Service Provisioning 
for CES SVC User Guide

Service 
Provisioning -> 
Frame Relay

Provides a launch point for the Frame Relay 
service provisioning tool.

For procedures to use the 
Frame Relay service 
provisioning tool, see 
241-6001-603 Preside 
MDM Service Provisioning 
for Frame Relay User Guide

Service 
Provisioning -> IP 
VPN Global 
Update

Provides a launch point for the IP VPN Global 
Update service provisioning tool.

For procedures to use the IP 
VPN Global Update service 
provisioning tool, see 
241-6001-601 Preside 
MDM Service Provisioning 
for IP VPN Global Update 
User Guide
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Tool bar
The tool bar contains the following icons:

• The exit icon closes the Nodal Provisioning window.

• The shelf view icon lets you toggle between component hierarchy and 
shelf view.

• The reload all service templates icon populates the Nodal Provisioning 
window with all the templates. If you have created and saved a new 
template, clicking the reload all service templates icon adds the new 
template to the service template palette.

• The search icon opens the Search dialog box when in component view 
only. For information on searching for components, see “Searching for a 
component in a large instance set” (page 120).

View area
In component hierarchy view, the Nodal Provisioning window displays the 
component hierarchy for the connected device. The component hierarchy 
displays all the device components that can be provisioned. A scroll bar lets 
you navigate the component hierarchy. 

At the start-up of a device provisioning session, the component hierarchy is 
populated to display the first level components and services under the root. 
The root is a device specific identifier. For example, the Passport root 
identifier is EM/<node name>, where <node name> is the name of the device 
to which you are connected.

Table 6
Help menu commands

Command Description Related information

Help on Help Describes how to use help. “Help options” (page 32)

Help on Window Accesses the online documentation for the 
Nodal Provisioning window.

“Accessing Help on the 
main window” (page 34)

About Nodal 
Provisioning

Opens a screen that displays the Nodal 
Provisioning version information.
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The component hierarchy is constructed from information represented in the 
hierarchy model, and instance information retrieved from the server. The 
hierarchy model determines which type of instances can go under the parent. 
For components with many instances, the components appear as folders in the 
component hierarchy and only the folder is shown at start-up. A folder refers 
to any component in the component hierarchy that has children under it. 
Components that have children are identified by a plus (+) sign to the left of 
the folder. Instances are retrieved by expanding the folder. When you expand 
the folder, the plus sign changes to a minus (-) sign. For the procedure to 
expand a folder, see “Expanding a component” (page 118). 

For large devices, the number of instances may exceed a predefined 
configurable threshold. Expanding the parent folder does not fetch all the 
instances and add them to the component hierarchy. In these situations, a 
visual indicator appears to the right of the folder to show you that the number 
of instances are too many to display. The format of the information is (x of y), 
where x is the maximum instances set through the configuration file and y is 
the total number of instances. 

For example, if the maximum number of instances is 20, and there is a 
total of 35 instances, you see (20 of 35) to the right of the folder.

The component hierarchy view may also display a network-wide icon to the 
left of the component name. This icon indicates global data. Components that 
have a scope attribute of “network” are considered global data by Nodal 
Provisioning. Use caution when deleting components marked as having 
global data since these components have network wide implications.

For components with many instances, Nodal Provisioning provides a search 
capability to search for component instances or a subset of component 
instances. For information on the search capability, see “Searching for a 
component in a large instance set” (page 120).

Component hierarchy view pop-up menu
Components in the component hierarchy view have a pop-up menu that 
corresponds to the menu options in the Selected menu. You can access the 
pop-up menu by positioning the mouse pointer over the component in the 
hierarchy and then click the right mouse button. For a description of the pop-
up menu commands, see the section “Selected menu” (page 69).
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Service template palette
The service template palette appears on the right side of the Nodal 
Provisioning window. The service template palette contains the service 
creation templates that apply to the selected device. These templates let you 
specify pre-determined configurations with default values and custom 
creation forms. 

Only the templates that apply to the software version of the connected device 
appear in the palette.

A service template palette simplifies the creation of a service by requesting 
only a limited amount of critical component data for the service.

The service template palette is organized into tabbed panes. Each pane 
contains service templates for a related group of services. The Nodal 
Provisioning window contains the following tabbed panes: 

• ATM

• FRS

• FrAtm

• MPLS-Infrastructure

• MPLS-Services

• PT-AA1

• VPN

• WUA-AA1

For a description of the templates found under each of the tabbed panes, see 
241-6001-611 Preside MDM Nodal and Service Provisioning Reference 
Guide.

When you click on a tabbed pane, icons representing the service templates for 
the selected service are displayed in the service template palette. If you right 
click on a template, a pop-up menu appears with two options:

• Launch opens a service template form. This command is enabled only 
when you select a valid dropsite in the component hierarchy.
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• Description opens a window with a description of the service template. 
This description corresponds to the description of the template that is 
entered into the Nodal Provisioning Template Editor Description section. 
The description also identifies the prerequisites and dropsites for the 
template.

You can provision the selected service by applying a service template in one 
of the following ways:

• dragging a template icon and dropping it on a valid dropsite. 

• selecting a valid dropsite in the component hierarchy, right clicking on a 
template icon in the service palette, then selecting Launch from the pop-
up menu.

• using the Apply Service Template command in the Selected menu, or 
component pop-up menu.

Applying a template from the palette to a valid drop point initiates the 
provisioning of a service using a service template form. The form lets you 
enter the necessary provisioning information. 

The dropsite component is specified as either a link or parent. A link 
component is one in which the component is taken to be the value of the 
specified component attribute in the template. Link drop components may 
also specify components higher in the hierarchy from the main drop 
component as valid dropsites. A template can be dropped on a component that 
contains a valid dropsite. In this case, you are provided a menu of available 
subcomponents beneath the chosen component. A parent component is taken 
to be the parent of a specified component in the template.

When an attempt to create a service fails, a dialog box opens with an error 
message and a list of components that were created before the error occurred. 
You need to resolve the error condition and return to the service creation 
procedure. See “Creating a service” (page 168) and “Repairing service 
creation errors overview” (page 183).

You can delete a component using the service creation error dialog box. 
However, you cannot reverse any modifications that you have made to 
component attributes. 
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Status bar
The status bar appears at the bottom of the Nodal Provisioning window, and 
shows the following information:

• connection status

• shelf type of the Passport you are connected to. For example, 
“fabricBasedShelf” indicates the Passport 15000 family and 
“busBasedShelf indicates the Passport 7000 family.

• CDL software version of the device you are connected to

• Edit or ReadOnly depending on the selection that you made when 
opening the view.

• view name. When you modify the working view, an “*” appears next to 
the View name in the status bar. If you have enabled the propagation 
logging option in the User Preferences dialog box, and specified a log file 
name, you can display the log file name by right clicking on the view 
name and selecting Log File Name.

• name of the device to which you are connected

Component hierarchy view pop-up menus 
Components in the component hierarchy view have a pop-up menu that 
corresponds to the menu options in the Selected menu. You can access pop-
up menus by right-clicking on a selected component. Only valid options are 
available from the pop-up menu. For a description of the pop-up menu 
commands, see “Selected menu” (page 69).
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Shelf view

The following sections describe the Nodal Provisioning window in shelf 
view:

• “Nodal Provisioning window in shelf view” (page 80)

• “Menu bar” (page 85)

• “File menu” (page 85)

• “View menu” (page 86)

• “Selected menu” (page 87)

• “Options menu” (page 90)

• “External Tools menu” (page 91)

• “Help menu” (page 92)

• “Tool bar” (page 93)

• “Shelf panel” (page 93)

• “Sparing panel” (page 93)

• “Logical shelf panel” (page 93)

• “Shelf Details panel” (page 95)

• “Service template palette” (page 97)

• “Status bar” (page 99)

• “Shelf view pop-up menus” (page 99)
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Nodal Provisioning window in shelf view 
When you start Nodal Provisioning, the Nodal Provisioning window opens in 
component hierarchy view. See“Starting Nodal Provisioning” (page 39). 

For Passport devices, you must have selected a device and authenticated 
before the main window opens. See “Connecting to a Passport device” 
(page 51).

While you are in component hierarchy view, you can change the view to shelf 
view at any time.

You can also change the user preferences so that you start Nodal Provisioning 
in shelf view. To set user preferences, see “Nodal Provisioning user 
preferences” (page 205).

The shelf view displays the following elements:

• a physical representation of the shelf and its cards

• a logical representation of the device

• card sparing through the logical processors (LPs)

The lower section of the shelf view window, contains the Shelf Details panel. 
This panel contains two areas:

• Components drill down panel
The Components drill down panel displays the component hierarchy for 
the component that you have selected in the shelf view panel.

• Services drill down panel
The Services drill down panel displays the component hierarchy, 
including subcomponents, for the services that are configured for the 
component that you have selected in the shelf view panel.

To maximize the shelf view real estate, both the Components and Services 
drill down panels can be detached from the shelf view panel. For the 
procedure to detach the drill down panels, see “Detaching and reattaching the 
component and service hierarchies” (page 125).
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Shelf view provides the same capabilities as component hierarchy view. The 
capabilities offered through the Selected menu, and the popup menus in the 
component hierarchy view are available for all graphical and hierarchical 
representations of components in the shelf view. You can also access the 
subcomponents of all graphical and hierarchical representations of 
components.

When you make changes to the shelf view, the changes are propagated to the 
component hierarchy view. Alternately, changes to the component hierarchy 
view are propagated to the shelf view. For example, if you add a port in shelf 
view, and then switch to component hierarchy view, you will see the new port 
on the corresponding logical processor (LP).

You can only provision one device at a time with a nodal provisioning session. 
If you want to provision more than one device you must start another instance 
of Nodal Provisioning.

To enable you to view and provision ports, channels, and the service 
interfaces associated with them, shelf view provides the following additional 
functionality, which is not available in component hierarchy view:

• display, graphically, all ports on a logical processor (LP), whether or not 
they are provisioned

• identify the service interfaces for a selected unchannelized port or 
channel to let you view and provision the service components and their 
subcomponents

• provide access to all provisionable subcomponents of the components 
graphically displayed to let you view and provision the subcomponents

 As in component hierarchy view, shelf view contains a service template 
palette on the right side of the Nodal Provisioning window. The service 
template palette contains the service creation templates. Shelf view lets you 
apply service templates to components in the following areas:

• the graphical representation of the shelf

• the component trees in the Shelf Details panel
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You can also resize the window and the shelf view is unaffected. However, in 
shelf view, the graphical representations of the logical processors and their 
ports, and the EM root component are the only available dropsites for 
templates from the service template palette. Therefore, the template must 
contain a dropsite which specifies a logical processor or one of its port types. 
When you apply a template from the palette that has port dropsites, a service 
template form opens with the correct port. 

You can also apply templates to the hierarchical representations of 
components in the Shelf Details drill down panels.

In shelf view, you can access the root component (EM) by left-clicking in the 
area to the left of the logical shelf panel. The Components and Services areas 
of the Shelf Details panel are populated.

For additional information, see the following sections:

• For a description of the parts of the Nodal Provisioning window in shelf 
view, see the following sections:

— “Menu bar” (page 85)

— “Tool bar” (page 93)

— “Shelf panel” (page 93)

— “Sparing panel” (page 93)

— “Logical shelf panel” (page 93)

— “Shelf Details panel” (page 95)

— “Shelf view pop-up menus” (page 99)

• For navigation in shelf view, see “Navigating component hierarchy and 
shelf view” (page 111).

• For information on the forms that you use to create and edit components, 
see “Component forms” (page 103).

• For information on the forms that you use to edit services, see “Service 
edit form” (page 108).

• For information on the forms that you use to create services, see “Service 
template form” (page 106).
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• For provisioning procedures, see “Nodal Provisioning procedures” 
(page 135).

• For post-provisioning procedures, see “Post-provisioning procedures” 
(page 197).

• For information on the Nodal Provisioning Template Editor, and 
procedures to create service templates, see “Nodal Provisioning 
Template Editor” (page 219).

• For procedures to set user preferences for the Nodal Provisioning 
window, and for opening and saving the view, see “Nodal Provisioning 
user preferences” (page 205).

• For information on creating custom reports, see “Report Generator” 
(page 323).

• For information on viewing real time log messages produced by Nodal 
Provisioning processes, see “Nodal Provisioning Log Viewer” 
(page 373).

For an illustration of the main window in shelf view, see “Main window in 
shelf view” (page 84).
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Figure 6
Main window in shelf view
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Menu bar
The menu bar has the following menus:

• “File menu” (page 85)

• “View menu” (page 86)

• “Selected menu” (page 87)

• “Options menu” (page 90)

• “External Tools menu” (page 91)

• “Help menu” (page 92)

File menu
The table “File menu commands” (page 85) describes the menu commands.

Note: The Check View, Open View, and Save View File menu commands 
are only available for Passport devices.

Table 7
File menu commands

Menu command Description of menu command Related information

New Device Opens a confirmation dialog box. Clicking Yes 
exits the current device and opens the Device 
Selection dialog box which lets you select a new 
device.

“Selecting a Passport 
device” (page 52)

Open View Opens the Open View dialog box so that you can 
select a new view file. The dialog box displays 
either the default values which are set in through 
the user preferences, or if none are set, the 
default user preferences.

If you made changes to a view file but did not 
save these, the changes you made will be 
displayed in read only access mode the next 
time you open the view file in Edit mode. If you 
do not want to view or use these changes, you 
must use the Open View command.

“Selecting the access mode 
and view mode” (page 57)

 (Sheet 1 of 2)
Preside MDM Nodal Provisioning User Guide   14.3RSUP



86   Chapter 5 Shelf view
View menu
The table “View menu commands” (page 87) describes the menu commands.

Check View Opens a confirmation dialog box to confirm the 
check view operation, and advising you that the 
check may take a few minutes. Clicking Yes 
proceeds with a check of the currently open 
view. If the view does not pass the check, an 
error dialog box opens stating that the view did 
not pass the check.

“Checking the view during a 
provisioning session” 
(page 181)

Close View Closes the current view. The component 
hierarchy in the Nodal Provisioning window 
becomes unpopulated.

“Closing the current view” 
(page 112)

Save/Activate 
View

Opens the Save/Activate View dialog box so that 
you can save the active configuration.

“Saving the view for 
Passport devices” 
(page 198)

Exit Closes all windows and the provisioning session.

When a view is edited, and the changes are not 
saved before you exit, the modifications are kept 
and can be displayed in read only access mode 
the next time you open the view in Edit mode.

Table 7  (continued)
File menu commands

Menu command Description of menu command Related information
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Selected menu
With some exceptions, the Selected menu provides the commands displayed 
in “Selected menu commands” (page 88). The menu commands are enabled 
only when they are valid for the component that you have selected in the shelf 
view or drill down panels. 

The same commands are available from a selected component’s pop-up 
menu. For additional information on the pop-up menu, see “Shelf view pop-
up menus” (page 99).

When you select a folder in the component hierarchy, that has too many 
instances to display, as shown visually as (x of y), the Search and Hide 
Children menu commands are enabled. They are otherwise disabled.

Table 8
View menu commands

Menu command Description Related information

History Opens the History of Changes dialog box. This 
dialog box displays, and lets you save a record 
of user actions and changes that have occurred 
to the view while Nodal Provisioning is active.

“Viewing and saving a 
record of changes made 
during a provisioning 
session” (page 194)

Shelf Selects or deselects the shelf view. “Switching between 
component hierarchy and 
shelf view” (page 113)

Toolbar Shows or hides the tool bar. “Tool bar” (page 93)

“Showing and hiding the 
toolbar” (page 114)

Statusbar Shows or hides the status bar. “Status bar” (page 99)

“Showing and hiding the 
status bar” (page 115)

Reload 
Templates

Populates Nodal Provisioning with all the 
templates. If you have created and saved a 
template, clicking Reload Templates adds the 
new template to the service template palette.

“Updating the service 
template palette in Nodal 
Provisioning” (page 318)
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Selected menu for unconfigured Logical Processors
The Selected menu commands for unconfigured Logical Processors are:

• Add opens a component creation form on the new LP component. When 
you select OK, you create the new LP.

• Paste pastes a copied LP to provision this LP.

Selected menu for unconfigured ports
The Selected menu commands for unconfigured ports are:

• Add opens a component creation form if the port only supports a single 
port type. If the port supports more than a single port type, an Add 
Component dialog opens from which you can select a port type. Only the 
port types supported by this port are displayed in the Add Component 
dialog. Selecting a port type from the Add Component dialog, and 
clicking OK opens a component creation form. You can modify the 
attributes in the component creation form and then click OK to create the 
new port.

• Paste pastes a copied port to provision this port.

Table 9
Selected menu commands

Menu command Description of menu command Related procedure or 
information

Search Opens the a search dialog box which lets you 
search for component instances or a subset of 
component instances. The Search command is 
available only for components with too many 
instances to display as show by the (x of y) next 
to the component.

“Searching for a component 
in a large instance set” 
(page 120)

Hide Children Hides all the component instances in the 
selected folder. The Hide Children command is 
available only for components with too many 
instances to display as shown by the (x of y) next 
to the component.

“Hiding all component 
instances in a folder” 
(page 123)
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Add Opens the Add Component dialog box which 
displays a list of subcomponents that you can 
select and add to the selected component. Once 
you have selected a component and clicked OK, 
a component form opens with the attributes that 
you can provision.

“Adding a single component 
instance” (page 138)

Edit Opens the component edit form for the selected 
component so that you can edit component 
attributes. The form contains all the editable 
attributes for the selected component.

“Editing a component 
instance” (page 148)

Delete Deletes the selected component and all its 
subcomponents.

“Deleting a component” 
(page 153)

Partial Semantic 
Check

Performs a limited check for semantic errors 
under the selected component. A Check View 
dialog box opens to indicate whether or not 
problems were found. If problems are found, 
they are listed in the dialog box.

“Performing a partial 
semantic check” (page 182)

Apply Service 
Template

Provides a submenu of services that can be 
applied to the selected component. The 
submenus vary with the component that you 
select.

Selecting a service from the submenu provides a 
list of valid templates When you select a 
template from the list, a service template form 
opens.

“Creating a service” 
(page 168)

“Service template form” 
(page 106)

Hide  Hides the selected component in the parent 
folder. The Hide menu item is available if the 
parent is a folder.

“Hiding a component 
instance in a folder” 
(page 122)

Table 9  (continued)
Selected menu commands

Menu command Description of menu command Related procedure or 
information
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Options menu
The Options menu contains the command for opening the User Preferences 
dialog box. 

 The table “Options menu command” (page 91) describes the Options menu 
command.

Copy Opens a copy component dialog box. This dialog 
box displays the selected component and all of 
its subcomponents. The copy dialog lets you 
select the subcomponents that you want to copy. 

The copy command is enabled only if the target 
component of the copy action is a valid target. 
For example, the copy command is not enabled 
when you select the root component.

“Cutting, copying and 
pasting components” 
(page 155)

Paste Opens a paste dialog box. The Paste command 
lets you paste copied components and their 
subcomponents into the target component. The 
paste command is enabled only if the target 
component of the paste action is a valid target.

“Cutting, copying and 
pasting components” 
(page 155)

Generate Report Opens the Report Generator tool which allows 
you to create custom reports on component 
data.

“Report Generator” 
(page 323)

Table 9  (continued)
Selected menu commands

Menu command Description of menu command Related procedure or 
information
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External Tools menu
The External Tools menu provides launch points for the Nodal Provisioning 
Template Editor and the service provisioning tools. The table “External Tools 
menu commands” (page 91) describes the menu commands.

Table 10
Options menu command

Menu command Description of menu command Related procedure or 
information

User Preferences Opens the User Preferences dialog box. This 
dialog box lets you specify preferences for an 
access mode, a view mode, and other service 
data options. 

“Nodal Provisioning user 
preferences” (page 205)

Table 11
External Tools menu commands

Menu command Description of menu command Related procedure or 
information

Nodal 
Provisioning 
Template Editor

Provides a launch point for the Nodal 
Provisioning Template Editor.

“Nodal Provisioning 
Template Editor menu bar” 
(page 225)

Service 
Provisioning -> 
ATM

Provides a launch point for the ATM service 
provisioning tool.

For procedures to use the 
ATM service provisioning 
tool, see 241-6001-600 
Preside MDM Service 
Provisioning for ATM User 
Guide.

Service 
Provisioning -> 
CES SVC

Provides a launch point for the CES SVC service 
provisioning tool.

For procedures to use the 
CES SVC service 
provisioning tool, see 
241-6001-602 Preside 
MDM Service Provisioning 
for CES SVC User Guide.
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Help menu
The Help menu provides access to online documentation for Nodal 
Provisioning. The table “Help menu commands” (page 92) describes the 
menu commands.

Service 
Provisioning -> 
Frame Relay

Provides a launch point for the Frame Relay 
service provisioning tool.

For procedures to use the 
Frame Relay service 
provisioning tool, see 
241-6001-603 Preside 
MDM Service Provisioning 
for Frame Relay User Guide.

Service 
Provisioning -> IP 
VPN Global 
Update

Provides a launch point for the IP VPN Global 
Update service provisioning tool.

For procedures to use the IP 
VPN Global Update service 
provisioning tool, see 
241-6001-601 Preside 
MDM Service Provisioning 
for IP VPN Global Update 
User Guide.

Table 12
Help menu commands

Menu command Description of menu command Related procedure or 
information

Help on Help Describes how to use help. “Help options” (page 32)

Help on Window Opens the on-line documentation for the Nodal 
Provisioning window.

“Accessing Help on the 
main window” (page 34)

About Nodal 
Provisioning

Opens a screen that displays the Nodal 
Provisioning version information.

Table 11  (continued)
External Tools menu commands

Menu command Description of menu command Related procedure or 
information
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Tool bar
The tool bar contains the following icons:

• The exit icon closes the Nodal Provisioning main window.

• The shelf view icon lets you switch between component hierarchy and 
shelf view.

• the reload all service templates icon populates the shelf view main 
window with all the templates. If you have created and saved a new 
template, clicking the reload all service template icon adds the new 
template to the service template palette.

• The search icon is disabled in shelf view. 

Shelf panel
The topmost panel is called the shelf panel. It provides the physical 
representation of the shelf and its cards. The card type is shown on each card. 

Sparing panel
The sparing panel is found between the shelf panel and logical shelf panel. It 
shows the card sparing through the logical processors (LPs). When a logical 
processor is configured with a main card and a spare card, and you select a 
logical processor, the shelf view sparing panel shows lines drawn to those 
main and spare cards.

You can select cards and LPs. When you select an LP, a link is drawn to the 
master card and spare card. You can distinguish between the main card and 
spare card for LPs as follows:

• the main card is identified by a black line

• the spare card is identified by a gray line

Logical shelf panel
The logical shelf panel appears below the sparing panel. It provides a logical 
representation of the device. It displays the logical processors and their ports. 
Ports can be provisioned. For additional information, see the following 
sections:

• “Graphical port display” (page 94)
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• “Graphical port provisioning” (page 94)

Graphical port display
When a logical processor has been configured with a main or spare card, all 
of its ports are shown on the logical processor in the shelf view, whether or 
not they are configured.

Note: Ports that cannot be provisioned are not displayed on the logical 
processors.

The graphical port display depends on the /opt/Nortel/ANP/lib/
NDCardTypes.ad data file to determine how many ports are on each card type. 
If the NDCardTypes data file cannot be read, an error dialog opens when the 
shelf view is first shown. This error dialog informs you that the system cannot 
read the specified file /opt/MagellanNMS/lib/app-defaults/C/
NDCardTypes.ad.

When this error occurs, the shelf view only displays ports that have been 
provisioned on the logical processors.

The following are the key features of the graphical port display:

• tool tips to identify the port type
The port type for each configured and unconfigured port is shown in a 
tool tip. The tool tip appears when you rest the mouse pointer on the port.

• configured and unconfigured ports are visually distinguished
Configured ports are visually distinguished from unconfigured ports by a 
raised border and their port identifier is displayed. Unconfigured ports 
are shown with a sunken border and their port identifier is not displayed.

• scroll bars to enable you to pan up and down the screen
If there are more ports on the logical processor than can be displayed on 
the screen at once, scroll bars are enabled at the bottom of the logical 
processor through which you can pan the ports up and down.

Graphical port provisioning
You can provision ports from their graphical display in the logical shelf panel.
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For provisioned ports, the Selected and component popup menu are the same 
as are available in the component hierarchy view and in the Selected menu.

• Add adds a subcomponent (for example, channel) to the port

• Edit edits the provisioned port data.

• Apply Service Template applies a service template to the port.

• Copy makes a copy of the port and its subcomponents.

• Paste pastes the last copied component as a child of the port, if it is a 
valid type.

• Generate Report generates a report of the provisioned port data.

For unprovisioned ports, the Selected, and component popup menus contain 
the following options, which are used to create the port:

• Add opens the Add Component dialog box if the port supports more than 
a single port type. The Component Names list in the Add Component 
dialog box only displays the port types that are supported by the selected 
port. When you select the new port from the list of available port 
components, a port creation form opens for that supported port type. This 
is the same form shown when the port is added to the LP from the 
component hierarchy view.

• Paste pastes the last copied component as a child of the port, if it is a 
valid type.

Shelf Details panel
The Shelf Details panel contains two sections:

• “Components drill down panel” (page 95)

• “Service drill down panel” (page 96)

Components drill down panel
The components drill down panel appears below the logical shelf panel and 
to the left half of the Shelf Details panel. When you select a component in the 
shelf view, the selected component is mirrored as a component hierarchy in 
the component drill down panel for the following components

• shelf
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• card

• logical processor

• ports

You can also select the root component (EM) by left-clicking to the left of the 
logical shelf panel. The components drill down panel is populated with the 
full component hierarchy, corresponding to the component hierarchy in 
component hierarchy view. For a description of the component hierarchy, see 
“View area” (page 74).

When the mouse pointer rests on a port or channel in the component drill 
down panel, to which a service component is linked, the name and identifier 
of the service component is displayed in a tool tip.

You can detach the component drill down panel from the main window, and 
display it as a separate window. This lets you maximize the shelf view real 
estate. When you collapse the detached portion, it reattaches to the main 
window. For the procedure to detach the drill down panels, see “Detaching 
and reattaching the component and service hierarchies” (page 125).

Component provisioning in the component drill down panel
The following provisioning functionality is available in the component drill 
down panel:

• the Selected and pop-up menus for components are the same as for the 
component hierarchy view

• you can apply service templates to all components shown in the 
component drill down panel

Service drill down panel
The service drill down panel is found below the logical shelf panel, and to the 
right half of the Shelf Details panel. When you select a component in the 
component drill down panel, the service drill down panel displays any service 
that is configured for the selected component, or any of its subcomponents. 
The service drill down panel displays a component hierarchy, that includes 
subcomponents, for each configured service.
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When you rest the mouse pointer on the top-level service component, the 
name and identifier of the port or channel to which it is linked is displayed as 
a tool tip.

The service drill down panel can be detached, along with the component drill 
down panel, from the main window and displayed as a separate window to 
maximize the shelf view real estate. When you collapse the detached window, 
it reattaches to the main window. For the procedure to detach the drill down 
panels, see “Detaching and reattaching the component and service 
hierarchies” (page 125).

Component provisioning in the service drill down panel
The following provisioning functionality is available in the service drill down 
panel:

• the Selected and popup menus for components are the same as for the 
component hierarchy view

• you can apply service templates to all components shown in the service 
drill down panel

Service template palette
The service template palette appears on the right side of the main window. 
The service template palette contains the service creation templates that apply 
to the selected device. The templates let you specify pre-determined 
configurations with default values and custom creation dialog boxes. 

Only the templates that apply to the software version of the connected device 
appear in the service palette.

A service template palette simplifies the creation of a service by requesting 
only a limited amount of critical component data for the service.

The service palette is organized into tabbed panes. Each pane contains service 
templates for a related group of services. The Nodal Provisioning window 
contains the following tabbed panes: 

• ATM

• FRS

• FrAtm
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• MPLS-Infrastructure

• MPLS-Services

• PT-AA1

• VPN

• WUA-AA1

When you click on a tab, icons representing the service templates for the 
selected service are displayed in the service template palette. If you right-
click on a template, a pop-up menu appears with two command options:

• Launch opens a service template form. This command is enabled only 
when you select a valid dropsite in the component hierarchy.

• Description opens a window with a description of the service template. 
This description corresponds to the description of the template that is 
entered into the Description section found in the Nodal Provisioning 
Template Editor. 

You can provision the selected service by applying a service template in one 
of the following ways:

• dragging a template icon and dropping it on a valid dropsite. 

• selecting a valid dropsite in the component hierarchy, right clicking on a 
template icon in the service palette, then selecting Launch from the pop-
up menu. This is the preferred method for remote log in.

• Using the Apply Service Template command in the Selected menu, or 
component pop-up menu.

Applying a template from the palette onto a valid drop point initiates the 
provisioning of a service using a service template form. The form lets you 
enter the necessary provisioning information. 

The dropsite component is specified as either a link or parent. A link 
component is one in which the component is taken to be the value of the 
specified component attribute in the template. Link drop components may 
also specify components higher in the hierarchy from the main drop 
component as valid dropsites. A template can be dropped on a component that 
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contains a valid dropsite. In this case, you are provided a menu of available 
subcomponents beneath the chosen component. A parent component is taken 
to be the parent of a specified component in the template.

When an attempt to create a service fails, a dialog opens with an error 
message and a list of components that were created before the error occurred. 
You need to resolve the error condition and return to the service creation 
procedure. See “Creating a service” (page 168) and “Repairing service 
creation errors overview” (page 183).

 You can delete a component using the service creation error dialog. However, 
you cannot reverse any modifications that you have made to component 
attributes. 

Status bar
The status bar appears at the bottom of the shelf view main window, and 
shows the following information:

• connection status

• shelf type of the Passport you are connected to. For example, 
“fabricBasedShelf” indicates the Passport 15000 family and 
“busBasedShelf indicates the Passport 7000 family.

• The CDL software version of the device you are connected to

• Edit or ReadOnly appears, depending on the selection that you made 
when opening the view.

• view name. When you modify the working view, an “*” appears next to 
the View name in the status bar. If you have enabled the propagation 
logging option in the User Preferences dialog, and specified a log file 
name, you can display the log file name by right clicking on the view 
name and selecting Log File Name.

• name of the device to which you are connected.

Shelf view pop-up menus 
Components in the shelf view and the component and service drill down 
panels have a pop-up menu that corresponds to the menu options in the 
Selected menu. You can access pop-up menus by right-clicking on a selected 
component in the component hierarchy in the component or shelf drill down 
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panel, in the Shelf panel, or in the Logical shelf panel. For a description of the 
pop-up menu commands, for components other than unconfigured LPs and 
ports, see the section “Selected menu” (page 87).
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Nodal Provisioning forms

For a description of the Nodal Provisioning forms, see the following sections

• “Overview of Nodal Provisioning forms” (page 101)

• “Component forms” (page 103)

• “Service forms” (page 105)

Overview of Nodal Provisioning forms
 Nodal Provisioning provides forms to add and edit components. The 
following are the available component forms and their purpose:

• “Component creation form” (page 103) lets you create a single 
component instance, or multiple instances of the same component.

• “Component edit form” (page 104) lets you edit a single component 
instance.

Nodal Provisioning provides forms to add and edit services. The following 
are the available service forms and their purpose:

• “Service edit form” (page 108) lets you edit a service that corresponds to 
a component in the component hierarchy.

• “Service template form” (page 106) lets you add a single service, or 
multiple instances of the same service.

Also see the following sections:

• “Attribute fields for Nodal Provisioning forms” (page 102) 

• “Navigating Nodal Provisioning forms” (page 102)
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Attribute fields for Nodal Provisioning forms
The fields available on the Nodal Provisioning forms are specific to the 
component that you select. In component forms, each field represents an 
attribute for the selected component. In service forms, each tab corresponds 
to a component. When you select a tab, the form displays the attributes for the 
selected component. 

You may find one or more of the following aids to help you select ranges and 
values:

• drop-down menu identifying valid ranges and default values.

• tool tips

• attribute help

For other attributes, you can enter values in a text field.

Navigating Nodal Provisioning forms 
The Nodal Provisioning tool is designed to use the OK button as the default 
button whenever you hit the Enter key, and the focus is not on OK, Multiple, 
Cancel or Help. To trigger the Add or Remove buttons, you can move the 
focus to these buttons and hit the space bar.

Instead of using the mouse, you can use the tab key to navigate within a table 
and between tables and other fields in the nodal provisioning forms. The Tab 
key functions in the following way:

• Tab
Tab moves the focus to the next cell in the table.

• Shift + Tab 
Shift + Tab moves the focus to the previous cell in the table.

• Ctrl + Tab
Ctrl + Tab moves the focus to the next widget outside of the table.

• Ctrl + Shift + Tab
Ctrl + Shift + Tab moves the focus to the previous widget outside of the 
table.
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Component forms
See the following sections for further information about component forms 
and how to use them:

• “Component creation form” (page 103)

• “Component edit form” (page 104)

• “Adding a single component instance” (page 138)

• “Editing a component instance” (page 148)

• “Creating multiple instances of a component” (page 175)

Component creation form
A component creation form is dynamically generated when you select a 
component from the Add Component dialog box to add to a selected 
component in the component hierarchy. The component creation form 
displays the provisionable attributes that you can modify for the selected 
component.

A component creation form lets you add a single component instance, or 
multiple component instances.

The component creation form has the following command buttons:

• OK creates one component instance.

• Cancel closes the form without saving the changes. Data that you have 
entered is discarded.

• Help accesses the on-line documentation for the component form.

• Multiple Creations opens the Multiple Creations dialog box. This 
dialog box lets you specify how you want to create multiple instances of 
the component. For information on creating multiple component 
instances, see “Creating multiple instances of a component or service” 
(page 173).

For an example of a component creation form, see the figure “Example of a 
component creation form” (page 104). This example shows the component 
creation form that opens when you add a DS1 to Lp/1 for EM/Atlanta.
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Figure 7
Example of a component creation form

Component edit form
A component edit form opens when you select a component in the component 
hierarchy and then select the Edit command from the component’s Selected 
menu or pop-up menu. The component edit form lets you edit the 
provisionable attributes for the selected component.

The component edit form has the following command buttons:

• OK modifies the component, validates the form and saves the current 
data onto the device. For Passport devices, the data is saved in the editing 
view. The component form closes after the component is saved 
successfully.

• Apply validates the form and saves the current service data. The form 
remains open after the component has been successfully saved. If an 
error occurs during validation or saving, a warning dialog opens and the 
form remains open.
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• Cancel closes the form without saving the changes. Data that you have 
entered is discarded.

• Help accesses the on-line help for the component form.

For an example of a component edit form, see the figure “Example of a 
component edit form” (page 105). This edit form opens when you edit the 
DS1/1 component that you created with the component creation form 
described in “Component forms” (page 103).

Figure 8
Example of a component edit form

Service forms
See the following sections for further information about service forms and 
how to use them:

• “Service template form” (page 106)

• “Service edit form” (page 108)
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• “Creating a service” (page 168)

• “Editing a service” (page 170)

• “Creating multiple instances of a service” (page 177)

Service template form
You use the service template form to create a service. The service template 
form allows you to enter provisioning information for the components that 
make up the service. 

A service template form lets you apply a single service instance, or multiple 
instances of the same service from one form.

You can apply a service template by using one of the following methods:

• Drag and drop a service template icon from the service palette to a valid 
drop site on the component hierarchy.

• Select a valid drop site in the component hierarchy, right click on a 
template icon in the service palette, and then select Launch from the 
pop-up menu.

• Select a drop site in the component hierarchy, right-click and from the 
pop-up menu, select Apply Service Template.

A service template form does not open if the service template is dropped on 
an invalid drop site.

The figure “Example of a service template form” (page 107), shows the 
service template form to create a virtual connection (Vcc) under the selected 
ATM Interface. This service template also lets you provision the traffic 
management parameters.
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Figure 9
Example of a service template form

The service template form has the following command buttons:

• OK validates and saves the current data onto the device, creating one 
instance of the service.

• Multiple Creations opens the Multiple Creations form which lets you 
create multiple instances of the service. For the procedure to create 
multiple services, see “Creating multiple instances of a component or 
service” (page 173).

• Cancel closes the service template form without saving the changes. 

• Help accesses the on-line help for the form.

See the following sections for additional information:

• For information on creating services, see “Creating a service” (page 168)
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•  For information on the service template forms for specific services, see 
241-6001-611 Preside MDM Nodal and Service Provisioning Reference 
Guide.

Service edit form
The service edit form lets you edit a service that corresponds to a component 
in the component hierarchy. 

A service edit form opens when you select Edit from the Selected or pop-up 
menu for a selected service component.

Note: Selecting Add from the pop-up menu does not invoke the service 
form. It lets you add a subcomponent to the service component (for 
example, DLCI to a FRUNI).

Service edit forms display the attributes of the one or more components that 
make up the service. Each component is represented by a separate tab. When 
you select a tab, the attributes for the selected component are displayed.

The figure “Example of a Service edit form” (page 109) shows the service 
edit form for an AtmIf/10 on EM/Atlanta.
241-6001-610   14.3RSUP   



Chapter 6 Nodal Provisioning forms   109
Figure 10
Example of a Service edit form

The service form has the following command buttons:

• OK validates and saves the current data onto the device. The form closes 
after the service is saved successfully.

• Apply validates and saves the current data. The form remains open after 
the service is saved successfully.

• Cancel closes the service editor form without saving. 

• Help displays the on-line help for the form.

For information on using the service form, see “Editing a service” (page 170).
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Chapter 7
Navigating component hierarchy and shelf 
view 

This section provides procedures for navigating the Nodal Provisioning 
window and the component hierarchy and shelf view. It contains the 
following sections:

• “Nodal Provisioning window navigation” (page 111)

• “Navigating the component hierarchy” (page 117)

• “Navigating the shelf view” (page 124)

Nodal Provisioning window navigation
See the following sections for general procedures for navigating the main 
window:

• “Closing the current view” (page 112)

• “Switching between component hierarchy and shelf view” (page 113)

• “Showing and hiding the toolbar” (page 114)

• “Showing and hiding the status bar” (page 115)

• “Detaching and reattaching the template palette” (page 116)
Preside MDM Nodal Provisioning User Guide   14.3RSUP



112   Chapter 7 Navigating component hierarchy and shelf view
Closing the current view
Use this procedure to close the current service data view at any time after you 
have opened a view in Nodal Provisioning.

Procedure
1 In the Nodal Provisioning window menu bar, select File -> Close View.

If you have made changes, you are prompted to save your changes 

2 Save your changes and click OK.

The component hierarchy in the main window is unpopulated. You can 
select a new view.
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Switching between component hierarchy and shelf view
Use this procedure to switch between component hierarchy and shelf view 
while using Nodal Provisioning.

Procedure
1 To switch to shelf view from component hierarchy view, in the menu bar of 

the Nodal Provisioning window, select View -> Shelf.

To switch to component hierarchy view from shelf view, in the menu bar of 
the Nodal Provisioning window, select View and then deselect Shelf.
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Showing and hiding the toolbar
Use this procedure to display or hide the toolbar in the Nodal Provisioning 
window.

Procedure
1 To switch from displaying the toolbar to hiding the toolbar, in the menu bar 

of the Nodal Provisioning window, deselect View -> Toolbar.

To switch from hiding the toolbar to displaying the toolbar, in the menu bar 
of the Nodal Provisioning window, select View -> Toolbar.
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Showing and hiding the status bar
Use this procedure to display or hide the status bar in the Nodal Provisioning 
window.

Procedure
1 To switch from displaying the status bar to hiding the status bar, in the 

menu bar of the Nodal Provisioning window, deselect View -> 
Statusbar.

To switch from hiding the toolbar to displaying the toolbar, in the menu bar 
of the Nodal Provisioning window, select View -> Statusbar.
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Detaching and reattaching the template palette
Use this procedure to detach the template palette from the Nodal Provisioning 
window in shelf view and component hierarchy view, and reattach it.

Procedure
1 Place your mouse cursor next to the title of the template palette - 

Templates. When the transparent hand appears, left-click. While holding 
down the left mouse button, drag the template palette away from the 
Nodal Provisioning window.

The template palette now appears as a separate window in the shelf view 
window.

2 Close the detached palette window to reattach the template palette.
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Navigating the component hierarchy
The following procedures apply to the component hierarchy in the component 
hierarchy view or the component hierarchy in the components drill down 
panel in the shelf view.

• “Expanding a component” (page 118)

• “Compressing a component” (page 119)

• “Searching for a component in a large instance set” (page 120)

• “Hiding a component instance in a folder” (page 122)

• “Hiding all component instances in a folder” (page 123)

• “Detaching and reattaching the component and service hierarchies” 
(page 125)
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Expanding a component
Use this procedure to expand a component hierarchy in the component 
hierarchy view or the component hierarchy in the components drill down 
panel in the shelf view display the next level of subcomponents below the 
selected component. 

Procedure
1 In the component hierarchy, find the component or subcomponent that 

you want to expand.

A plus sign (+) appears to the left of the compressed component icon to 
indicate that the component is compressed.

2 Click the plus sign or double-click on the folder.

The selected component expands to the next level of subcomponent.
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Compressing a component
Use this procedure to compress a component in the component hierarchy in 
the component hierarchy view or in the components drill down panel in shelf 
view. This procedure hides the next level of displayed sub-components of the 
selected component. 

Procedure
1 In the component hierarchy, find the component that you want to 

compress.

A minus sign (-) appears to the left of the component to indicate that the 
component is expanded.

2 Click the minus sign.

The selected component in the component hierarchy compresses to the 
next level of sub-component.
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Searching for a component in a large instance set
Use this procedure to search for a specific component instance, or a subset of 
instances, for large components. 

This procedure is necessary when the number of component instances 
exceeds a pre-defined threshold size, as shown visually in the component 
hierarchy in both shelf view and component hierarchy view by (x of y). When 
you expand the parent folder, Nodal Provisioning does not automatically 
fetch all the instances and add them to the component hierarchy.

Search dialog
 You use a search dialog box to search for a component in a large instance set. 
The search dialog box also provides the ability to add or replace one or more 
component instances from the search list in the search dialog box to the 
component hierarchy in either component hierarchy or shelf view. 

 The results of a search are displayed to the right of the folder. For example, 
if a search finds 53 instances to add to the tree, the folder displays (53 of 
15748).

Procedure
1 Select a folder whose component instances exceed the defined threshold 

size, as shown by the visual indicator (x of y) to the right of the folder.

2 Complete one of the following steps:

• Select Search from the Selected menu.

• Right-click and select Search from the pop-up menu.

• Click the search icon in the tool bar.
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The Search dialog box opens.

3 Enter the criteria for the search in the search criteria field.

The search pattern may contain the wild card (*).

4 Click Search to initiate the search for the components that match the 
specified search criteria.

Components that meet the specified criteria appear in the search results 
list. 

5 From the list, select one or more components.

6 To add the selected components to the component hierarchy, click Add to 
Tree.

To replace component(s) in the tree, click Replace in Tree

To remove a component, right-click and select Remove from the pop-up 
menu.

To close the Search dialog box, click Close.

 The results of the search are displayed to the right of the folder. 

Search criteria 
field

Search results list

Command buttons
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Hiding a component instance in a folder
Use this procedure to hide a single component instance in a folder in the 
component hierarchy of the component hierarchy view or in the components 
drill down panel in the shelf view. The Hide command is only enabled for a 
folder and is disabled for other items in the component hierarchy.

Procedure
1 In the component hierarchy in the Nodal Provisioning window, select the 

folder containing the child component that you want to hide, and expand it.

2 Select the component instance that you want to hide.

3  From the Selected menu or the component’s pop-up menu, select Hide.

The selected component is hidden in the parent folder.
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Hiding all component instances in a folder
Use this procedure to hide all component instances in a folder in the 
component hierarchy in component hierarchy view, or in the component drill 
down panel of shelf view. The Hide Children command is only enabled for a 
folder and is disabled for other items in the component hierarchy.

Procedure
1 In the component hierarchy in the Nodal Provisioning window, select the 

folder whose component instances you want to hide.

2  From the Selected menu or the component’s pop-up menu, select Hide 
Children.

All components are hidden in the parent folder.
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Navigating the shelf view
The following procedures apply only to shelf view. For shelf view navigation 
procedures, see the following sections:

• “Detaching and reattaching the component and service hierarchies” 
(page 125)

• “Viewing the root component” (page 126)

• “Viewing shelves” (page 127)

• “Viewing cards” (page 128)

• “Viewing configured logical processors” (page 129)

• “Viewing unconfigured logical processors” (page 130)

• “Viewing configured ports” (page 131)

• “Viewing unconfigured ports” (page 132)

• “Viewing configured channels” (page 133)

• “Viewing provisioned services” (page 134)
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Detaching and reattaching the component and service 
hierarchies

Use this procedure to detach the component and service hierarchies from the 
Nodal Provisioning window in shelf view.

Procedure
1 Place your mouse cursor next to the Shelf Details title. When the 

transparent hand appears, left-click. While holding down the left mouse 
button, drag the panel away from the Nodal Provisioning window.

The selected panel now appears as a separate window.

2 Close the detached window to reattach the component and service drill 
down panels.
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Viewing the root component
Use this procedure to view the EM component. In shelf view the EM root 
component (the device) is graphically displayed to the left of the logical 
processors. 

Procedure
1 Left click in the area to the left of the graphical representation of the logical 

processor component.

This action populates the component drill down panel showing the 
component hierarchy rooted at the selected EM root.
241-6001-610   14.3RSUP   



Chapter 7 Navigating component hierarchy and shelf view   127
Viewing shelves 
Use this procedure to view the shelf component. The shelf component is 
graphically displayed to the left of the cards in shelf view. 

Procedure
1 Select the area to the left of the graphical representation of the card 

components.

This action populates the component drill down panel with the component 
hierarchy rooted at the selected shelf.
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Viewing cards
Use this procedure to view the card components. All cards are graphically 
displayed in the shelf panel. 

Procedure
1 Select a graphical representation of the card.

This action populates the component drill down panel with the 
component hierarchy rooted at the selected card.
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Viewing configured logical processors 
Use this procedure to view the logical processors. Configured logical 
processors (LPs) are shown graphically in the logical shelf view panel. 

Procedure
1 In the logical shelf view panel, select a configured logical processor that 

has been assigned a main card, and/or spare card, or select an LP from 
the component hierarchy. 

This action has the following results:

• The connectivity between the selected logical processor and the 
main and/or spare card is shown graphically.

• The component drill down panel is populated with the component 
hierarchy whose top level elements are the service components that 
are linked to the selected rooted logical processor and any of its 
subcomponents.

• All ports, configured and unconfigured, are visible on the LP.
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Viewing unconfigured logical processors
Use this procedure to view unconfigured logical processors in shelf view.

Unconfigured logical processors are visually distinguished from configured 
logical processors. Unconfigured logical processors are dark grey and contain 
no configured or unconfigured ports. 

Procedure
1 In the logical shelf view panel, select an unconfigured logical processor.

The contents of the component and service drill down panels are cleared.
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Viewing configured ports 
Use this procedure to view configured ports in shelf view. 

Configured ports are shown graphically on logical processors, whether or not 
the logical processors have been configured with a main or spare card. 
Configured ports are visually distinguished from unconfigured ports by a 
raised border. Unconfigured ports are shown with a lowered border. If there 
are more ports on the logical processor than can be shown on the screen at 
once, scroll bars are enabled at the bottom of the logical processor through 
which you can pan up and down.

Procedure
1 Select a configured port. 

This action has the following results:

• The component drill down panel is populated with a component 
hierarchy rooted in the selected port.

• If the selected port is not channelized, the service drill down panel is 
populated with a component hierarchy rooted at any service that is 
configured on the port.

• If the selected port is channelized, the service drill down panel is 
populated with a component hierarchy for each service that is 
configured on any of its channels.
Preside MDM Nodal Provisioning User Guide   14.3RSUP



132   Chapter 7 Navigating component hierarchy and shelf view
Viewing unconfigured ports
Use this procedure to view unconfigured ports in shelf view. 

All ports are shown graphically on logical processors that have been 
configured with a main or spare card. If a logical processor has not been 
configured with a main or spare card, only the configured ports display 
graphically.

Unconfigured ports are visually distinguished from configured ports by a 
lowered border. Configured ports have raised borders and display their port 
identifier.

If there are more ports on the logical processor than can be displayed on the 
screen at once, scroll bars are enabled at the bottom of the logical processor 
through which you can pan up and down.

Procedure
1 Select an unconfigured port.

The contents of the component and service drill down panels are cleared.
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Viewing configured channels
Use this procedure to view unconfigured channels in shelf view.

Prerequisites
Channels can only be viewed on ports that have been configured.

Procedure
1 Select a graphical representation of a configured channelized port.

This action has the following results:

• The component drill down panel is populated with a component 
hierarchy rooted at the selected port. 

• The service drill down panel is populated with component hierarchies 
for each service configured on any channel of the selected port.

2 In the component drill down panel, expand the port component.

The channels that have been configured on this port are shown as 
children of the port.

3 In the component drill down panel, select a channel.

If the selected channel has a configured service, the service drill down 
panel is populated with a component hierarchy rooted at the service that 
is configured on that channel.
Preside MDM Nodal Provisioning User Guide   14.3RSUP



134   Chapter 7 Navigating component hierarchy and shelf view
Viewing provisioned services
Use this procedure to view provisioned services in Nodal Provisioning shelf 
view.

Procedure
1 Select a graphical representation of a logical processor or a configured 

port.

If a logical processor is selected, the service drill down panel is populated 
with one or more component hierarchies rooted at the service provisioned 
on ports configured on the selected logical processor.

If the port is channelized, the service drill down panel is populated with 
one or more components hierarchies rooted at the services provisioned 
on that port or on channels of that port. 

2 If the port is channelized, in the component drill down panel, expand the 
port component and select a channel.

The service drill down panel is populated with a component hierarchy 
rooted at the service provisioned on that channel, if it exists.
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Nodal Provisioning procedures

This section provides component and service provisioning procedures using 
Nodal Provisioning, as well as some generic error resolution procedures. This 
section contains the following topics:

• “Component provisioning procedures overview” (page 137)

— “Adding a single component instance” (page 138)

— “Setting a context for a component” (page 140)

— “Getting a context for a component” (page 141)

— “Finding and getting a context for a component” (page 143)

— “Adding a new LogicalProcessorType component” (page 144)

— “Adding a new LogicalProcessorType component” (page 144)

— “Editing a component instance” (page 148)

— “Editing a ScsSoftware component” (page 149)

— “Editing a LogicalProcessorType component” (page 151)

— “Deleting a component” (page 153)

— “Cutting, copying and pasting components” (page 155)

— “Creating multiple instances of a component” (page 175)

• “Cutting, copying and pasting components between shelf view and 
component hierarchy view” (page 161)

• “Shelf view provisioning procedures” (page 163)
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— “Provisioning an unprovisioned Logical Processor” (page 164)

— “Provisioning an unconfigured port” (page 165)

• “Service provisioning procedures” (page 167)

— “Creating a service” (page 168)

— “Editing a service” (page 170)

— “Deleting a service” (page 172)

— “Creating multiple instances of a service” (page 177)

— “Repairing service creation errors overview” (page 183)

• “Creating multiple instances of a component or service” (page 173)

• “Canceling the current or remaining instances during a multiple creation 
of components or services” (page 179)

• “Repairing service creation errors overview” (page 183)

• “Checking the view during a provisioning session” (page 181)

• “Performing a partial semantic check” (page 182)

• “Resolving a restorePossible error condition” (page 190)

• “Resolving a journalDisabledReason error condition” (page 191)

• “Viewing and saving a record of changes made during a provisioning 
session” (page 194)
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Component provisioning procedures overview
See the following sections for component provisioning procedures:

• “Adding a single component instance” (page 138)

• “Setting a context for a component” (page 140)

• “Getting a context for a component” (page 141)

• “Getting a context when opening a new device” (page 142)

• “Finding and getting a context for a component” (page 143)

• “Adding a new LogicalProcessorType component” (page 144)

• “Editing a component instance” (page 148)

• “Editing a ScsSoftware component” (page 149)

• “Editing a LogicalProcessorType component” (page 151)

• “Deleting a component” (page 153)

• “Cutting, copying and pasting components” (page 155)

• “Cutting, copying and pasting components between shelf view and 
component hierarchy view” (page 161)

• “Creating multiple instances of a component” (page 175)
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Adding a single component instance
Use this procedure to add a single component instance to a selected 
component in the component hierarchy. You use the Add Component dialog 
box to add a single component instance.

You can also add more than one instance of the same component. For the 
procedure to add multiple component instances, see “Creating multiple 
instances of a component or service” (page 173).

Prerequisites
This procedure requires the following conditions:

• you have started Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

Procedure steps
1 If selecting a component from the component hierarchy in component 

hierarchy view, or its hierarchical representation in the drill down panels in 
shelf view, expand the component hierarchy to the parent of the 
component you want to add. For the procedure to expand a component, 
see “Expanding a component” (page 118).

If selecting a graphical representation of a component in shelf view, 
proceed directly to step 2.

2 Select the component that you want to provision.

3 Complete one of the following steps.

• Right-click and select Add from the pop-up menu.

• In the menu bar, select the Selected menu option and then select 
Add.
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The Add Component dialog box opens. The Component Name list 
contains the components that you can add to the selected component.

4 From the Component Name list, select the component that you want to 
add.

The selected component appears in the Choose a component field. 

5 To add the component, click Ok.

Clicking Ok opens a component creation form containing the 
provisionable attributes for the component.

To cancel the operation, click Cancel.

6 In the component creation form, enter or edit the attribute values.

7 Click OK to validate the form and save the current data.

The component is added to the component hierarchy. If the component 
you add is a network-wide component, then a global icon displays to the 
left of the component name. 

If an error occurs during validation or saving, an error dialog box opens 
and the component form remains open. You can obtain additional details 
about the error condition by clicking Details.

8 Save your view. See “Post-provisioning procedures” (page 197).

selected component for 
the add component 
operation
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Setting a context for a component
Use this procedure to set the context for a selected component in the 
component hierarchy. Once a context is set for a component, this context can 
be applied to other components.

Prerequisites
This procedure requires the following conditions:

• you have started Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

Procedure steps
1 In the component hierarchy in the Nodal Provisioning window, select a 

Sw component.

2 Right click on the component then select Set Context.from the pop-up 
menu.

The Set Context Completed confirmation dialog opens.
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Getting a context for a component
Use this procedure to get the context for a selected component from another 
component in the component hierarchy. 

Prerequisites
This procedure requires the following conditions:

• you have started Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

• a context must be set for a component. See “Setting a context for a 
component” (page 140).

Procedure steps
1 In the component hierarchy in the Nodal Provisioning window, select a 

Sw component.

2 Right click on the component then select Get and Select Context.from 
the pop-up menu.

The name of the context component is highlighted.
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Getting a context when opening a new device
Use this procedure to get the context for a new device. 

Prerequisites
This procedure requires the following conditions:

• you have started Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

• a context must be set for a component. See “Setting a context for a 
component” (page 140).

Procedure steps
1 In Nodal Provisioning window, select New Device from the File menu.

2 In the Device Selection dialog, select a device that has the context 
component.

3 Check the Launch NP with Context Component checkbox.

4 Click OK.

5 Enter your userid and password.

6 In the Open View dialog, select a view that has the context component.

7 Click OK.

The name of the context component is highlighted.
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Finding and getting a context for a component
Use this procedure to get the context for a component that you have identified 
in the Find a Component dialog. 

Prerequisites
This procedure requires the following conditions:

• you have started Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

• a context must be set for a component. See “Setting a context for a 
component” (page 140).

Procedure steps
1 In the component hierarchy in the Nodal Provisioning window, select a 

component.

2 Right click on a component then select Find and select a component  
from the pop-up menu.

The Find a component dialog opens.

3 Right click on the Component Name text field and select Get Context.

The context component name displays in the Component Name text 
field.

4 Click OK.
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Adding a new LogicalProcessorType component
Use this procedure to add a new ScsLogical Processor Type (Lpt) component 
and provision the featurelist attribute.

When you add a new Lpt, Nodal Provisioning displays candidate values, 
derived from the Passport device, for the attribute “featureList”. You can 
select the values that you want to use from the list. 

Prerequisites
This procedure requires the following conditions:

• you have started Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

Procedure steps
1 In the component hierarchy in the Nodal Provisioning window, select the 

Sw component.

2 Complete one of the following steps:

• Right-click and select Add from the pop-up menu.

• In the menu bar, select the Selected menu option and then select 
Add.

•

The Add Component dialog box opens.
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3 Select the Lpt component, and click Ok.

The Sw (Create Lpt) component form opens.

The component form displays two lists for the “featureList” attribute:

• Available Features lists all the features (services) supported by the 
software loaded into the current view on the Passport device.

• Selected Features is empty when the create Lpt form opens.

The Component Name field displays the 
components that you can add to the component 
that is selected in the component hierarchy.

The Choose a component field displays the 
selected component
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4 To add a new feature to the Selected Features list, from the Available 
Features list, select a required feature value and click Add or 
alternatively, double click on the feature value in the Available Features 
list.

The item selected in the Available Features list moves to the Selected 
Features list. 

5 Repeat step 4 to add additional feature values until you have build the 
value set for featureList.

If you want to remove a feature, from the Selected Features list, select 
the feature that you want to remove and click Remove. The feature moves 
to the Available Features list.

6 In the Lpt field, enter a key value for the new Lpt component.

7 Click OK.

The values from the Selected Features list are used to set the value for 
the “featureList” attribute. The new Lpt appears under the Sw component 
in the Nodal Provisioning window.

If any of the selected features are not supported by the software loaded 
into the current view, a warning dialog box opens. The warning dialog box 
lists the features that are not supported. You are given the option to keep 
them in the feature list or to remove them from the feature list. If you 
remove them, they are lost permanently since they are not put back into 
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the Available Features list once they are removed from the Selected 
Features list. 
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Editing a component instance
Use this general procedure to change attributes for a component. For 
components that have a graphical representation in shelf view, you can select 
the component to be provisioned by its graphical representation in the shelf 
view or by its hierarchical representation in the drill down panels.

Prerequisites
This procedure requires the following conditions:

• you have started Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

Procedure steps
1 If selecting a component from the component hierarchy in component 

hierarchy view, or its hierarchical representation in shelf view, expand the 
component hierarchy to display the component that you want to edit. 

If selecting a component from the shelf view, proceed directly to step 2.

2 Select the component.

3 Complete one of the following steps:

• Right-click and select Edit from the pop-up menu, or

• In the menu bar, select the Selected menu option and then select 
Edit.

A component edit form opens, containing the component attributes that 
you can provision.

4 Make any necessary changes to the attribute values in the form.

5 To validate the changes and close the form, click OK.

To keep the form open, click Apply. The current service data is validated 
and saved.

6 Save the view. See “Saving the view for Passport devices” (page 198).
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Editing a ScsSoftware component
Use this procedure to set new values for an existing avList attribute for the 
ScsSoftware (Sw) component.

 When you edit the Sw component, Nodal Provisioning component edit form 
displays the selected and available candidate values, derived from the 
Passport device, for the avList attribute. You can modify an existing avList 
attribute by adding or removing candidate values. 

Prerequisites
This procedure requires the following conditions:

• you have started Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

Procedure steps
1 In the Nodal Provisioning window, select the Sw component.

2 Complete one of the following steps:.

• Right-click and select Edit from the pop-up menu.

• In the menu bar, select the Selected menu option and then select 
Edit.

The Edit Sw form opens and displays two lists for the avList attribute: the 
Available Versions list which shows the available avList values and the 
Selected Versions list which shows the currently selected avList values. 
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3 To add a value, select a value from the Available Versions list and click 
the Add button, or double-click on a value. This step adds this value to the 
Selected Versions list.

To remove a value, select a value in the Selected Versions list and click 
the Remove button, or double-click on a value. This step moves the value 
from the Selected Versions list to the Available Versions list.

4 Repeat step 3 for each value that you wish to add or remove from the 
avList attribute.

5 If you want to modify the ScsSoftware component and close the form after 
the data is successfully saved, click OK.

If you want the form to remain open, click Apply. The current service data 
is validated and saved.
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Editing a LogicalProcessorType component
Use this procedure to set new values for an existing featureList attribute for a 
provisioned Logical Processor Type (Lpt) component.

 When you edit the Lpt component, the Nodal Provisioning tool component 
edit form displays the selected and available candidate values, derived from 
the Passport device, for the featureList attribute. You can modify an existing 
featureList attribute by adding or removing candidate values. 

Prerequisites
This procedure requires the following conditions:

• you have started Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

Procedure steps
1 In the Nodal Provisioning window, expand the Sw component so that 

you can view its subcomponents.

2 From the component hierarchy, select the Lpt component.

3 Complete one of the following steps.

• Right-click and select Edit from the pop-up menu.

• In the menu bar, select the Selected menu option and then select 
Edit.

The edit Lpt form opens and displays two lists for the featureList attribute: 
the Selected Features list which shows the currently selected featureList 
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values, and the Available Features list which shows the available 
featureList values. 

4 To add a value, double-click on a value from the Available Features list 
or select a value and click the Add button. This step adds this value to the 
Selected Features list.

To remove a value, double-click on a value or select a value in the 
Selected Features list and click the Remove button. This step moves the 
value from the Selected Features list to the Available Features list.

5 Repeat step 4 for each value that you wish to add or remove from the 
featureList attribute.

6 I f you want to modify the The LogicalProcessorType component and 
close the form after the data is successfully saved, click OK.

 If you want the form to remain open, click Apply. The current data is 
validated and saved. 
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Deleting a component
Use this procedure to delete a component. For components that have a 
graphical representation in shelf view, you can select the component to be 
provisioned by its graphical representation in the shelf view, or its 
hierarchical representation in the drill down panels.

Prerequisites
This procedure requires the following conditions:

• you have started Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

Procedure steps
1 If selecting a component from the component hierarchy in component 

hierarchy view, or its graphical or hierarchical representation in shelf view, 
expand the component hierarchy to display the component that you want 
to delete. For the procedure to expand a component, see “Expanding a 
component” (page 118).

If selecting a component from the shelf view, proceed directly to step 2.

2 Select the component.

3 Complete one of the following steps:

• Right-click and select Delete from the pop-up menu, or

• In the menu bar, select the Selected menu option and then select 
Delete.

A confirmation dialog box opens asking you to confirm the delete.

4 Click Yes to confirm the delete.
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The component and its subcomponents are removed from the component 
hierarchy.

If there are errors, an error dialog box opens and describes the error. 
Correct the errors.

5 Save the view. See “Saving the view for Passport devices” (page 198).
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Cutting, copying and pasting components 
You can cut, copy and paste a component, and its subcomponents, within and 
between supported devices and between shelf and component hierarchy view. 
The target for the paste operation can be within the same device hierarchy or 
in a different device hierarchy. 

Therefore, you can open two nodal provisioning sessions, cut or copy a 
component from one session and paste it into the target component of the 
other session. If the paste is done between sessions, the copied information is 
stored. Because the information is stored, you can copy a component, delete 
it and then paste the copied component into a target.

The paste operation checks the paste target to make sure that it is a valid 
action for the copied component.

Note 1:  When you cut or copy and paste a component, the component 
and all of its selected subcomponents are cut or copied from the source 
component and pasted into the target component. Therefore, if you cut or 
copy a component with a large number of subcomponents, it may take 
several minutes.

Note 2:  The client for the cut and copy operations and the client for the 
paste operation must both be connected to the same Configuration 
Manager.

The cut and copy and paste functionality is accessed from the Selected menu 
in the Nodal Provisioning window menu bar or through the pop-up menu in 
component hierarchy or shelf view. For components that have a graphical 
representation in shelf view, you can select the component to be copied by 
clicking on its graphical representation in the shelf view or its hierarchical 
representation in the drill down panels and then selecting the command from 
the pop-up menu.

For the procedure to cut and copy components, see “Cutting and copying 
components” (page 156).

For the procedure to paste components, see “Pasting Components” 
(page 159).
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Cutting and copying components
Use this procedure to cut or copy a component and its subcomponents for use 
within or between devices.

You use the cut or copy dialog boxes to copy components and their 
subcomponents. The cut and copy dialog boxes open only when the 
component that you select for the cut or copy operation has subcomponents.

Prerequisites
This procedure requires the following conditions:

• you have started Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

Procedure steps
Note: The cut and copy commands are enabled in the Selected and pop-
up menus only if the cut or copy is a valid action.

1 Select the component that you want to cut or copy.

2 Complete one of the following steps:

• Right-click and select Cut or Copy from the pop-up menu or

• In the menu bar, select the Selected menu option and then select 
Cut or Copy.

A cut or copy components dialog box opens. The dialog box displays the 
selected component and its children.

3 In the dialog box, select the component or the subcomponents that you 
wish to cut or copy. 
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Example of a copy component dialog box 

Selected components are shown by a check mark to the left of the 
component. 

Selecting or deselecting the parent component automatically selects or 
deselects all its children. You can also select the individual 
subcomponents that you want to copy.

You are provided a visual indicator when not all the children are included 
in the cut or copy operation. The background color of the parent 
components up the component hierarchy change color to a light grey. This 
color change occurs in the following situations:

• when you deselect one of the children in the cut or copy components 
dialog boxes.

• when the number of children for a component exceeds a predefined 
threshold, as indicated visually to the right of the folder in the nodal 
provisioning main window, as (x of y) where x is maximum number of 
children shown and y is the total number of instances. You have to 
search for component instances and add them to the component 
hierarchy if you want them to be part of the cut or copy operation. See 
“Searching for a component in a large instance set” (page 120).

4 To proceed with the cut or copy operation, click OK.

Components selected for 
the copy operation are 

shown with a check next 
to them
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The device information for the selected components is retrieved and, if the 
paste is done between sessions, the information is stored so that it can be 
retrieved for later use when you execute the paste command. 

The status bar updates to indicate that the component was copied 
successfully. If you have selected a component with a large number of 
subcomponents, the cut or copy action may take several minutes.

To cancel the operation, click Cancel.

5 Paste the cut or copied component into the target. See “Pasting 
Components” (page 159).
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Pasting Components
The paste dialog box opens when you select the target component in which to 
paste a copied component, and then select Paste from the Selected menu, or 
click the mouse menu button and select paste from the available options. The 
target can be within the same device hierarchy or on a different device 
hierarchy. However, the source and target must be connected to the same 
Configuration Manager.

Prerequisites
This procedure requires the following conditions:

• you have started Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

• you have previously copied a component. See “Cutting and copying 
components” (page 156).

Procedure steps
Note: The paste command is enabled in the Selected and pop-up menus 
only if the paste is a valid action and the cut or copy action is complete.

1 Select the target component for the paste action.

The target component can be within and between supported devices and 
between shelf and component hierarchy view. 

2 Complete one of the following steps:

• Right-click and select Paste from the pop-up menu, or

• In the menu bar, select the Selected menu option and then select 
Paste.

A dialog box opens that lets you enter an identifier for the new component. 
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3 Enter an identifier, and click OK to initiate the paste operation.

The status bar in the Nodal Provisioning window updates to indicate 
that the component was pasted successfully. If you are pasting a 
component with a large number of subcomponents, the paste action may 
take several minutes.

The component and all of its subcomponents are created under the target 
component. The status bar updates, stating that the component was 
pasted successfully. This may take several minutes.

Note:  If an error occurs during the cut/copy and paste action, such as 
when you cut/copy a component instance from one device to another with 
incompatible model files, an error dialog box opens. The dialog box 
identifies the error, and the components that were created. For additional 
information, see “Repairing service creation errors overview” (page 183).

4 Modify the attributes for the pasted components as desired. To modify the 
attributes for the pasted component, you need to use the procedure 
described in “Editing a component instance” (page 148). 

5 Save the view. See “Post-provisioning procedures” (page 197).
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Cutting, copying and pasting components between shelf 
view and component hierarchy view

Use this procedure to cut or copy components and their subcomponents in 
shelf view and paste them in component hierarchy view. 

Note 1:  When you cut or copy and paste a component, the component 
and all of its selected subcomponents are cut or copied and pasted into 
the target component. Therefore, if you cut or copy a component with a 
large number of subcomponents, it may take several minutes.

Prerequisites
This procedure requires the following conditions:

• you have launched the Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

• the source and target are connected to the same Configuration Manager

Procedure steps
1 In the shelf view, select the component that you want to cut or copy.

2 Complete one of the following steps.

• Right-click and select Cut or Copy from the pop-up menu, or

• In the menu bar, select the Selected menu option and then select 
Cut or Copy.

A cut or copy components dialog box opens. Each dialog box displays the 
selected component and its children.

3 In the cut or copy components dialog box, select the component or the 
subcomponents that you wish to cut or copy. 

4 Click OK.

The device information for the selected components is retrieved.

The status bar updates to indicate that the component was copied 
successfully. If you have selected a component with a large number of 
subcomponents, the cut or copy action may take several minutes.
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5 Click the shelf icon in the tool bar to switch to component hierarchy view 
or deselect Shelf in the View menu.

6 In the component hierarchy view, select the target component for the 
paste action.

7 Complete one of the following steps:

• Right-click and select Paste from the pop-up menu, or

• In the menu bar, select the Selected menu option and then select 
Paste.

The Paste command is enabled only if the paste is a valid action and the 
cut or copy action is complete.

A paste dialog box opens that lets you enter an identifier for the new 
component.

8 Enter an identifier, and click OK to initiate the paste operation.

The status bar updates to indicate that the component was pasted 
successfully. If you are pasting a component with a large number of 
subcomponents, the paste action may take several minutes.

The component and all of its subcomponents are created under the target 
component. The status bar updates, stating that the component was 
pasted successfully. This may take several minutes.

Note:  If an error occurs during the cut or copy and paste action, such as 
when you cut or copy a component instance from one device to another 
with incompatible model files, an error dialog box opens. The dialog box 
identifies the error, and the components that were created. For additional 
information, see “Repairing service creation errors overview” (page 183).

9 Modify the attributes for the pasted components, as desired. See “Editing 
a component instance” (page 148). 

10 Save the view. See “Post-provisioning procedures” (page 197). 
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Shelf view provisioning procedures 
The following component level provisioning procedures can only be 
performed in shelf view:

• “Provisioning an unprovisioned Logical Processor” (page 164)

• “Provisioning an unconfigured port” (page 165)
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Provisioning an unprovisioned Logical Processor
Use this procedure to provision an unprovisioned Logical Processor (LP) in 
shelf view. The following options are available from the Selected menu or 
pop-up menu to provision an unprovisioned logical processor:

• Add a new LP

• Paste a copied LP to provision this LP

Prerequisites
This procedure requires the following conditions:

• you have launched the Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

Procedure steps
1 In the Logical Shelf panel, select the graphical representation of an 

unconfigured logical processor.

2 Complete one of the following steps:

• Right-click and select the desired command (Add or Paste) from the 
pop-up menu, or

• In the menu bar, select the Selected menu option and then select the 
desired command (Add or Paste).

If you select Add, a component edit dialog box opens on the new logical 
processor component. Selecting OK creates the new logical processor.

If you select Paste, a copied logical processor is pasted to this logical 
processor.

3 Save the view. See “Post-provisioning procedures” (page 197).
241-6001-610   14.3RSUP   



Chapter 8 Nodal Provisioning procedures   165
Provisioning an unconfigured port
Use this procedure to provision an unconfigured port in shelf view. The 
following options are available from the Selected menu or pop-up menu to 
configure an unconfigured port:

• Add a port

• Paste a copied port to this port

Prerequisites
This procedure requires the following conditions:

• you have launched the Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

Procedure steps
1 In the Logical Shelf panel, select an unconfigured port.

2 Complete one of the following steps:

• Right-click and select the desired command (Add or Paste) from the 
pop-up menu, or

• In the menu bar, select the Selected menu option and then select the 
desired command (Add or Paste).

Depending on which action you selected, the following happens:

• If you select Add, the Add Component dialog box opens with a list 
of port types that are supported by the port that is being created. 
Proceed to step 3. If only one port type is supported, the Add 
Component dialog box does not open, and the port is automatically 
selected. The component editor form opens.

• If you select Paste, the last copied component is pasted as a child of 
the port, if it is a valid type.

3 Select a port type.

A component edit dialog box opens on the new port component.

4 Edit the attributes in the dialog box, as desired.

5 Click OK.
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The new port is created.

6 Save the view. See “Post-provisioning procedures” (page 197).
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Service provisioning procedures
For the provisioning tasks that you can perform at the service level, see the 
following sections:

• “Creating a service” (page 168)

• “Editing a service” (page 170)

• “Deleting a service” (page 172)
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Creating a service 
Use this procedure to create a single instance of a service. 

If you wish to create multiple instances of a service, see the section “Creating 
multiple instances of a component or service” (page 173).

Prerequisites
This procedure requires the following conditions:

• you have launched the Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

Procedure steps
1 If selecting a component from the component hierarchy in component 

hierarchy view, or its hierarchical representation in shelf view, expand the 
component hierarchy to display the target component for the new service. 
For the procedure to expand a component, see “Expanding a component” 
(page 118).

Note:  This is either the parent component for the root component of the 
service or a component to which the root component or one of its 
subcomponents is to be linked.

2 Select the component.

3 Apply the template using one of the following methods:

• Click the tabbed pane in the service template palette to go to the 
service group. Select an template icon for the required service and 
drag and drop the template onto a valid target component, or

• Select Apply Service Template from the pop-up menu or Selected 
menu. Select the service and then select the template from the list of 
available templates, or

• Select the appropriate drop site, click on the template icon and select 
Launch from the pop-up menu.

A service template for the service opens containing the attributes that you 
must enter to create a service. For some attributes, you can access the 
range and default information by resting the mouse pointer on the 
attribute.
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4 Enter the data to provision the service.

5 In the service template, click OK.

If there are no errors, the updated component and service information is 
added to the tree and displayed when their parents are expanded. 
Proceed to Step 6.

If there is an error in the data entered into the attribute fields, an error 
dialog box opens and the service template dialog box remains open. 
Correct the error. Proceed to step 6.

If an error occurs while the service is being created, but before 
components are created, an error dialog box opens. Correct the error and 
return to step 1.

If an error occurs after some of the components in the service are created, 
a service creation error dialog box opens. Correct the error. See 
“Repairing service creation errors overview” (page 183).

6 Save the view. See “Post-provisioning procedures” (page 197).
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Editing a service
Use this procedure to edit a service if the service corresponds to a single 
component and its subcomponents in the component hierarchy. For 
components that have a graphical representation in shelf view, you can select 
the component to be provisioned by its graphical representation in the shelf 
view or its hierarchical representation in the drill down panels.

Prerequisites
This procedure requires the following conditions:

• you have launched the Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

Procedure steps
1 If selecting a component from the component hierarchy in component 

hierarchy view, or its graphical or hierarchical representation in shelf view, 
expand the component hierarchy to display the root component of the 
service. For the procedure to expand a component, see “Expanding a 
component” (page 118).

If selecting a component from the its graphical representation in shelf 
view, proceed directly to step 2.

2 Select the service component that you want to edit.

3 Complete one of the following steps:

• Right-click and select Edit Service from the pop-up menu, or

• In the menu bar, select the Selected menu option and then select 
Edit Service.

A service form opens, containing a tabbed form for each of the 
components for the service. Each form lists the attributes of one of the 
components that was created when the service was added.

4 Select the tab for the component that you want to modify.

5 Modify the component attributes.

Note:  Do not click OK until you have completed editing all the attribute 
values that you want to change.
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6 If you want to edit the attribute values on the service and close the form, 
click OK.

If an error occurs, an error dialog box opens with an error message. The 
form remains open. Correct the error and click OK.

If you want the form to remain open, click Apply. The data is validated and 
saved.

7 Save the view. “Post-provisioning procedures” (page 197).
Preside MDM Nodal Provisioning User Guide   14.3RSUP



172   Chapter 8 Nodal Provisioning procedures
Deleting a service
Use this procedure to delete a service if it has a single root component and 
there is a corresponding service model. 

Prerequisites
This procedure requires the following conditions:

• you have launched Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

Procedure steps
1 In the Nodal Provisioning window, expand the component hierarchy to 

display the root component of the service.

2 Select the component that you want to delete

3 Complete one of the following steps:

• Right-click and select Delete from the pop-up menu, or

• In the menu bar, select the Selected menu option and then select 
Delete.

The component and its subcomponents are removed from the component 
hierarchy. 
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Creating multiple instances of a component or service 
Nodal provisioning provides the ability to create multiple instances of a 
component or service. This functionality is accessed by clicking the Multiple 
Creations button on the component or service creation form to open the 
Multiple Creations dialog box. This dialog box allows you to specify how you 
want the multiple instances of the service, or component, to be created.

The Multiple Creations form provides a text field for each root level 
component so that you can enter a key value pattern for the component or 
service. The table “Valid key value patterns” (page 173) describes valid key 
value patterns. 

Alternately, you can enter the key value directly in the key field in the service 
creation or component creation form. The value that you enter in the key field 
of the service or component creation form is copied to the Multiple Creation 
form as a default pattern.

The Multiple Creations dialog box also gives you the option to display the 
dialog box for each instance. If, however, there are any attributes in the 
service or component whose value can not be pre-defined, the Display form 

Table 13
Valid key value patterns

Description  Key Value Pattern Key Values

All key values separated by a 
comma

1, 2, 3, 7, 9, a, b 1, 2, 3, 7, 8, 9, a, b

A range value 1-3, 7-9, a, b 1, 2, 3, 7, 8, 9, a b

A range value a-c, g-i, a, b, c, g, h, i

A prefix and a suffix separated by a 
colon

any:1-3, 7-9 any1, any2, any3, any7, 
any8, any9

More than one pattern separated 
by a semicolon

0.:1-3; 1.:7-9 0.1, 0.2, 0.3, 1.7, 1.8, 1.9
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for each instance check box is automatically selected and disabled. 
Consequently, for these cases, each individual component or service creation 
form is displayed, and you need to enter values for such attributes. 

If there are no attributes whose value can not be predefined, you have the 
option of selecting or deselecting the Display form for each instance check 
box. If the check box remains unselected, the Nodal Provisioning tool creates 
all services or components automatically when you click OK. If you select the 
check box, a component or service creation form opens for each instance.

You can also cancel service or component creations from the component or 
service creation form. The form provides a Cancel button which opens the 
Cancel Creation dialog box. This dialog box gives you two options:

• Cancel the current instance only which cancels the creation of the 
current service or component instance and then displays the next service 
or component

• Cancel the current and the remaining instances which cancels the 
creation of the current service or component instance, and all remaining 
instances. You return to the Nodal Provisioning window.

For relevant procedures, see the following sections:

• “Creating multiple instances of a component” (page 175)

• “Creating multiple instances of a service” (page 177)

• “Canceling the current or remaining instances during a multiple creation 
of components or services” (page 179)
241-6001-610   14.3RSUP   



Chapter 8 Nodal Provisioning procedures   175
Creating multiple instances of a component
Use this procedure to create multiple instances of the same component.

Prerequisites
This procedure requires following conditions:

• you have launched Nodal Provisioning 

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

Procedure steps
1 In the Nodal Provisioning window, select a component.

2 Complete one of the following steps.

• Right-click and select Add from the pop-up menu, or

• In the menu bar, select the Selected menu option and then select 
Add.

The Add Component dialog box opens.

3 In the Add Component dialog box, select the component that you want 
to add and click OK.

A component creation form opens.

4 Enter the required values for each attribute.

5 Click Multiple Creations.

The Multiple Creations dialog box opens.

6 In the Component Key Assignment field in the Multiple Creations 
dialog box, enter a key pattern. See “Valid key value patterns” (page 173).

7 If you want to see the Multiple Creations dialog box for each component 
instance, select the Display form for each instance check box.

If you want to create multiple components without showing each form, 
leave the Display form for each instance check box unchecked.

8 Click OK.

Nodal Provisioning analyzes the key value patterns that you have 
entered. One of the following happens:
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• If you have made a key assignment error, a key assignment error 
dialog box opens. Click OK in the error dialog box, correct the key 
range in the Multiple Creations dialog box, and click OK.

•  if there are no errors in the key pattern, and you have selected the 
Display form for each instance check box, the Multiple Creations 
dialog box closes and the first component instance creation form 
opens. The component creation form displays the first key value in 
the key field. The Multiple Creations button is disabled. Proceed to 
step 9. 

• If there are no errors in the key pattern, and you have not checked the 
Display form for each instance check box, all service instances are 
automatically created and display in the Nodal Provisioning 
window. 

• If you click Cancel in the Multiple Creations dialog box, the dialog 
box closes and you return to the dynamic component creation form.

9 Make any necessary modifications to the attribute values in the 
component creation form, if desired, and click OK.

If there are no errors in the values that you have entered, the first instance 
is created. This instance displays in the Nodal Provisioning window. The 
next component creation form opens with the next available key value 
displayed in the key field.

If an error occurs, a service creation error dialog box opens. Correct the 
error. See “Repairing service creation errors overview” (page 183).

10 Repeat step 9 to create all remaining component instances. 

The component instances appear in the Nodal Provisioning window and 
are automatically assigned key values according to the key pattern that 
you have specified in the Multiple Creations dialog box.
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Creating multiple instances of a service
Use this procedure to create multiple instances of the same service.

Prerequisites
This procedure requires the following conditions:

• you have launched Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

Procedure steps
1 In the Nodal Provisioning window, select a component to which you wish 

to apply the service.

2 Complete one of the following steps:

• Right-click and select Apply Service Template from the pop-up 
menu and from the list of valid templates, select the service template 
that you want to apply

• In the menu bar, select the Selected menu option, select Apply 
Service Template. From the list of valid templates, select the service 
template that you want to apply.

A service creation form opens.

3 In the service creation form, enter the required values for each attribute.

4 Click Multiple Creations.

The Multiple Creations dialog box opens. The Multiple Creations dialog 
box contains text fields for each first level component defined in the 
service template.

5 In the Component Key Assignment fields, enter a key pattern to each 
key pattern field. See “Valid key value patterns” (page 173).

6 If you want to see the Multiple Creations dialog box for each service 
instance, select the Display form for each instance check box.

If you want to create multiple service instances without showing each 
form, leave the Display form for each instance check box unchecked.

7 Click OK.
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Nodal Provisioning analyzes the key value patterns that you have 
entered. One of the following happens:

• If you have made a key assignment error, a key assignment error 
dialog box opens. Click OK in the error dialog box, correct the key 
range in the Multiple Creations dialog box and click OK.

•  if there are no errors in the key pattern, and you have selected the 
Display form for each instance check box, the Multiple Creations 
dialog box closes and the first service creation form opens. The 
service creation form displays the first key value to each first level 
component in the service. The Multiple Creations button is disabled. 
Proceed to step 8. 

• If there are no errors in the key pattern, and you have not checked the 
Display form for each instance check box, the Multiple Creations 
dialog box, and the service creation dialog box close. All service 
instances are automatically created and display in the Nodal 
Provisioning window. 

• If you click Cancel in the Multiple Creations dialog box, the dialog 
box closes and you return to the dynamic service creation form.

8 Make any necessary modifications to the attribute values in the service 
creation form and then click OK.

If there are no errors, the first instance is created and the next service 
creation form opens with the next available key value for each first level 
component.

If an error occurs, a service creation error dialog box opens. Correct the 
error. See “Repairing service creation errors overview” (page 183).

9 Repeat step 8 for all remaining service instances.

Key values for all remaining instances are automatically assigned 
according to the key values that you have specified.
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Canceling the current or remaining instances during a 
multiple creation of components or services

Use this procedure to cancel the creation of a single instance or all remaining 
component remaining instances during the process of creating multiple 
instances of a component or service.

 You use the Cancel Creation dialog box to cancel the current or remaining 
instances. 

Prerequisites
This procedure requires the following conditions:

• you have launched the nodal provisioning tool

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

• you are creating multiple instances of a component or service as 
described in “Creating multiple instances of a component or service” 
(page 173) and have completed the following steps:

—  entered a key pattern in the Component Key Assignment field

— selected Display form for each instance

— clicked OK in the Multiple Creations dialog box 

Procedure steps
1 In the component or service creation form, click Cancel.

The Cancel Creation dialog box opens.
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2 In the Cancel Creation dialog box, select one of the following options:

• If you wish to only cancel the current component or service creation 
instance, select Cancel the current instance only.

• If you wish to cancel the current and all remaining instances, select 
Cancel the current and the remaining instances.

3 Click OK.

If you have selected Cancel the current instance only option, the 
current component or service is not created and the next creation form 
opens.

If you have selected Cancel the current and all remaining instances 
option, no further instances of the component or service are created and 
the creation form closes.

If you click Cancel, the Cancel Creation dialog closes and you return to 
the current creation form.
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Checking the view during a provisioning session
Use this procedure at any time during a provisioning session to perform a 
check for errors on the currently open view. Any errors or warnings 
encountered during the check view operation are displayed in the Check View 
dialog box.

Prerequisites
This procedure requires the following conditions:

• you have launched Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

Procedure steps
1 In the menu bar of the Nodal Provisioning window, select File -> Check 

View.

A Check View message dialog box opens to indicate that the check view 
option may take a few minutes. You are asked to confirm that you want to 
proceed with the check.

2 Click Yes.

A Check View message dialog opens and displays any errors 
encountered during the check view operation.
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Performing a partial semantic check
Use this procedure to perform a limited check for semantic errors under a 
selected component. Any semantic errors or warnings encountered during the 
partial semantic check operation are displayed in the Check View dialog box.

Prerequisites
This procedure requires the following conditions:

• you have launched Nodal Provisioning

•  you are connected to the Passport device. See “Connecting to a Passport 
device” (page 51)

• you are in read-write mode

Procedure steps
1 Select the component that you want to check for errors.

2 From the Selected menu of the Nodal Provisioning window, select 
Partial Semantic Check, or select Partial Semantic Check from the 
selected component’s popup menu.

A Check View message dialog box opens and displays any errors 
encountered while checking the selected component, or informs you that 
no errors were found.
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Repairing service creation errors overview
 A Service Creation Errors dialog box opens if an attempt to create a service, 
using Nodal Provisioning or Embedded Nodal Provisioning, is only partially 
successful. Attribute errors may have occurred so that some, but not all, of the 
components in the service are created. 

If the error occurs during the service creation but before any components are 
created, or attributes modified, an error message opens, and clicking OK in 
the error dialog causes one of the following scenarios to occur. 

• If you are creating multiple instances of the service and you have opted 
to show the creation form for each instance, when you click OK the next 
creation form opens.

• If you are creating multiple instances of the service and you have opted 
to not show the creation form for each instance, when you click OK the 
creation form opens with a Continue button, and all remaining key values 
appear in a corresponding key field for each first level component.

You are given the following options in the Service Creation Errors dialog box 
after an error has occurred in the service creation:

• Accept allows the service to be created regardless of the error. Default 
values are used for those attributes. 

In the case of Embedded Nodal Provisioning, the task activation 
proceeds and the next provisioning action in the task is applied to the 
device.

If you are creating multiple instances of the service, and have opted to 
display the service creation form for each instance, the next remaining 
instance creation forms opens.

If you are creating multiple instances of the service, and have opted not 
to display the service creation form for each instance, the Nodal 
Provisioning tool creates the current instance as is, and creates all 
remaining instances automatically without showing each creation form. 
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• Repair brings up another dialog box which allows you to modify the 
input values to repair the error. When you click OK, the service is created 
using the modified values. 

If you are creating multiple instances of the service, and have opted to 
display the service creation form for each instance, the next remaining 
instance creation forms opens and the tool continues to process the next 
instance creation.

If you are creating multiple instances of the service, and have opted to not 
display the service creation form for each instance, the tool creates all 
remaining instances automatically after you finish repairing the instance 
that generated the error. 

• Delete All deletes the current instance and all the components created by 
the service. 

If you are creating multiple instances of the service, and have opted to 
display the service creation form for each instance, the current instance 
is not created and the next remaining instance creation form opens.

If you are creating multiple instances of the service, and have opted to not 
display the service creation form for each instance, the tool creates all 
remaining instances automatically.

• In Nodal Provisioning, Cancel cancels the current instance and brings up 
the service creation form with all remaining key values appearing on 
each first level component’s key field. You can modify the attribute or 
key values before you continue to create the remaining instances. The 
OK button in the service creation form is replaced with a Continue 
button. 

In Embedded Nodal Provisioning Cancel cancels the entire task 
activation. You are given the chance to cancel one or more of the pending 
activations using the Cancel Activations dialog and the procedure 
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“Canceling the activation of more than one provisioning task” 
(page 482). You can edit the task as required and activate it once the 
problems are fixed.

If you are creating multiple instances of the service and have opted to 
display the service creation form for each instance, when you click 
Continue the next creation form with new values is displayed.

If you are creating multiple instances of the service and have opted to not 
display the service creation form for each instance, when you click 
Continue the remaining instances are automatically created with new 
values.

For an illustration of the service creation error dialog box, see “Service 
Creation Errors dialog box” (page 186).
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Figure 11
Service Creation Errors dialog box

The Components and errors encountered during the service creation 
panel displays the errors in component hierarchy format. It shows visually the 
following:

• where in the component hierarchy tree the error occurred

• the components that have been successfully created

• the components that have been impacted by the error. 

The icons that appear in the dialog box, and what they represent are described 
in the table “Icons and what they mean” (page 187).
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The Error Messages panel shows in text format the error messages that caused 
the service creation to fail. The error messages in this panel correspond to the 
error messages shown next to the affected component or attribute in the 
components and errors encountered during service creation panel.

You can tear the error messages panel or component panel away from the 
service creation error dialog box by right clicking on the panel and pulling the 
panel away. Closing the Error Messages panel reattaches it.

Tool tip messages are available that describe component states, and provide 
additional information on components and attribute errors. For example, in 
the case of greyed out components, the tool tip indicates that the component 
is not part of the service. For attribute errors, the tool tip tells you the attribute 
value that the service creation tried to set.

For the procedure to resolve service creation error conditions, see 

• “Repairing service creation errors” (page 188)

Table 14
Icons and what they mean

Icon What it represents

A greyed out component A greyed out component represents a 
component that is not part of the service creation 
operation.

Yellow triangle A yellow triangle represents a component that 
encountered an error while setting its attributes.

Red x next to an attribute 
or component

A red x next to an attribute represents an error in 
setting the attributes. The adjacent red text 
provides additional details about the attribute 
value that it tried to set.

A red x next to a component icon represents an 
error creating the component.
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Repairing service creation errors
Use this procedure to correct service creation errors in either Nodal 
Provisioning or Embedded Nodal Provisioning.

Prerequisites
This procedure requires the following conditions:

• An error condition exits in the service creation operation.

• A Service Creation Errors dialog box has opened to display the error 
condition(s).

Procedure steps
1 In the Service Creation Errors dialog box, select one of the following 

options;

• If you wish to delete all the components that were created, select 
Delete All. 

— If you are creating multiple instances of the service, and have opted 
to display the service creation form for each instance, the current 
instance is deleted and the next remaining instance creation form 
opens. 

— If you are creating multiple instances of the service, and have opted 
to not display the service creation form for each instance, the tool 
deletes all remaining instances automatically.

• If you wish to accept the components that were created, select 
Accept.

— If you are creating multiple instances of the service, and have opted 
to display the service creation form for each instance, the next 
remaining instance creation forms opens. If another error is 
encountered, another error message opens. Return to step 1

— If you are creating multiple instances of the service, and have opted 
not to display the service creation form for each instance, the tool 
creates all remaining instances automatically. If another error is 
encountered, another error message opens. Return to step 1.

• If you wish to modify the attributes of the components that were 
created, click Repair. A dynamic dialog box opens containing the 
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components and attributes that it could not create or modify. Only 
those that can be repaired are shown. Proceed to step 2.

• If you wish to cancel the operation, click Cancel.

— If you are creating multiple instances of the service and have opted 
to display the service creation form for each instance, Cancel 
cancels the current instance and brings up the service creation form 
with all remaining key values appearing on each first level 
component’s key field. The OK button in the service creation form 
is replaced with a Continue button. when you click Continue the 
next creation form with new values is displayed.

— If you are creating multiple instances of the service and have opted 
to not display the service creation form for each instance, when you 
click Continue the remaining instances are automatically created 
with new values.

2 In the repair dialog box, repair the component attributes.

3 Click OK to complete the creation using the modified values.

If errors remain, another Service Creation Error dialog box opens 
showing only those components or attributes that have not been repaired. 
Return to step 2 to resolve the remaining errors.

If there are no further errors, you are creating multiple instances of the 
service, and you have opted to display the service creation form for each 
instance, the next remaining instance creation forms opens and the tool 
continues to process the next instance creation.

If you are creating multiple instances of the service, and have opted to not 
display the service creation form for each instance, the tool creates all 
remaining instances automatically.
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Resolving a restorePossible error condition
Use this procedure when an warning message dialog box opens that indicates 
that a previous current view needs to be restored. This error condition can 
occur in Nodal Provisioning or Embedded Nodal Provisioning.

This warning dialog box is generated when the current view has been 
journaled by the provisioning system and is different from the committed 
view. The restore prov command can be issued if display prov restorePossible 
attribute of the is set to yes on the Passport. This attribute indicates if a restore 
provisioningSystem command is possible.

When opening the view, you are warned that the restorePossible attribute is 
set. However, you can still continue to open the view.

Upon activating, at check prov, a warning is generated that subsequent 
activation will remove the previous journal log files, and you need to use the 
-force option.

Procedure steps
1 In the warning dialog box, click Close View to close the current view. 

Proceed to step 2.
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Click Continue to proceed with this view. However, any subsequent 
activation will destroy the previous “current view”.

2 Confirm that the display prov restorePossible command is set to yes.

3 If set to yes, do 

• start prov

• PROV>restore prov

This command loads and reactivates the journal files.

Resolving a journalDisabledReason error condition
Use this procedure to resolve a journal disabled condition. This error 
condition can occur in Nodal Provisioning or Embedded Nodal Provisioning.
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When this condition exists, an alarm is generated (7000037) and a warning 
dialog box opens. The warning dialog box provides you one of the following 
reasons for the error condition:

• not configured

• initial commit required. Journaling has been enabled via provisioning 
and an initial commit is required.

• file system error. The journal log save failed due to File System error or 
because the File System is locked.

• threshold exceeded. A number of journal logs has exceeded the 
maximum.

• reload activation. A reload activation has occurred and a commit has not 
yet been done

When opening the view, or after activating, you are warned that the 
journalDisabledReason attribute is set. However, you can still continue to 
open the view.

Procedure steps
1 In the Open View Warning dialog box, click Close View to close the 

current view. Proceed to step 2.

Click Continue to proceed with this view. However, any subsequent 
activation will destroy the previous “current view”.
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2 Query the attribute journalDisabledReason.

To determine if the FileSystem is locked, do display fs adminState. If the 
value is locked, then the Filesystem is locked.

3 Take the following on-switch remedial action:

If the reason is for the journalDisabledReason error is “file system error” 
then the operator should ensure that the file system is not locked. If it is 
locked, the file system should be unlocked. Otherwise the operator should 
look for the file system or disk alarms to determine the root cause of the 
failure. Once the root cause is determined and fixed, the operator should 
re-commit to clear this alarm.

For any other value of journalDisabledReason, the user should re-commit 
the current provisioning view, as this will clear the alarm.

If neither the disaster recovery nor CP equipment protection feature are 
wanted, then the operator can also clear this alarm by disabling journal 
log saving by setting the attribute Prov journaling to disabled.
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Viewing and saving a record of changes made during a 
provisioning session

Use this procedure to view and save to a file a record of the actions that you 
have taken and the changes that you have made during the provisioning 
session

Procedure steps
1 From the View menu in the Nodal Provisioning window, select History.

The History of Changes dialog box opens showing a record of the 
actions and changes that have occurred.

2 Select Save to File.

The History File dialog box opens.
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3 Select a location and specify a file name.

4 Select Save to save a new file to the specified location.

Select Update to update the contents of a directory.

Select Cancel to cancel the save operation.
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Post-provisioning procedures

This section describes post-provisioning procedures. It contains the following 
sections:

• “Saving the view for Passport devices” (page 198)

• “Activating and Committing the View for Passport devices” (page 202)
Preside MDM Nodal Provisioning User Guide   14.3RSUP



198   Chapter 9 Post-provisioning procedures
Saving the view for Passport devices
Use this procedure to save the service data view after completing a 
provisioning session on a Passport device.

You use the Save/Activate View dialog box to specify how you want to save 
the service data view after you complete the provisioning session, and to 
activate and commit the view. For the procedure to activate and commit the 
view, see “Activating and Committing the View for Passport devices” 
(page 202).

 If you have selected default user preferences for the Save/Activate View and 
saved these preferences to the file MagellanNMS/NPUserPreferences.cfg, 
Nodal Provisioning uses these preferences for subsequent provisioning 
sessions. For the procedure to set your user preferences for the Save View 
dialog box, see “Setting user preferences for saving and activating the service 
data view” (page 211).

 If you do not have write access to a home directory, as is the case with remote 
login, the Nodal Provisioning opens without user preferences and displays the 
Save/Activate View dialog box from which you can specify your preferences 
for the service data view.

If the MagellanNMS/NPUserPreferences.cfg file does not exist, Nodal 
Provisioning creates the file using the default values. 

Procedure steps
1 From the File menu in the Nodal Provisioning window, select Save/

Activate View.
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The Save/Activate View dialog box opens with the default settings, 
unless you have changed them by setting the user preferences for the 
Save/Activate View dialog box. 

2 If you wish to check the view, retain the Check View option.

The adjacent drop down list is enabled.

Note:  When journaling is enabled, you can activate the Passport device 
without saving the view. However, a complete check is required for 
activating the provisioning view.

Deselect Check View to bypass the check operation. The adjacent 
combo box is disabled.

3 Select one of the following options from the Type drop down list:
Preside MDM Nodal Provisioning User Guide   14.3RSUP



200   Chapter 9 Post-provisioning procedures
• changed performs a check of only the added or changed 
components before saving. When you select changed, the following 
command is sent to the Passport device:
String = check -changed -stoponerror prov

• complete checks the provisioning data in the edit view to ensure it is 
semantically correct. The complete check is the default setting. The 
following command is sent to the Passport device:
String = check -stoponerror prov

Since the stopOnError is specified implicitly, the Passport device will abort 
the check immediately upon finding the first error.

4 In the Save View panel, select Save and then select one of the following 
format options for saving the view from the Type drop down list:

• ascii saves the view in ASCII format.

• delta saves the view in delta format

• portable saves the view in portable format.

• portable and ascii saves the view in both portable and ascii formats

5 From the view mode drop down list, select one of the following view mode 
options to name the new provisioning view:

• If you select Keyed, type a valid key in the Key field. The key is used 
to search for service data views. The service data view that matches 
the pattern and that has the highest index is found, and the next view 
in the sequence is created. You can name a file by using one to six 
alphanumeric characters or by using a 1 digit fully numeric download 
key. A fully numeric download key cannot be less than three digits.

• If you select Dated, type today or type a date in the format yymmdd 
where yy is the year, mm is the month and dd is the day. When you 
enter a date, the service data view with the highest two digit index 
(nn) is found and the next view in the sequence is created, in the 
format <yymmdd><nn>. For example 03012901. See “Date 
Convention” (page 31) for more information on the date format. 
When you enter today, the view is saved with today’s date, in the 
format yymmd<nn>.

• If you select User Specified view mode, in the File field, enter a file 
name or click Browse to open a Select View file browser dialog box 
containing a list of user specified views. Select a view name and click 
OK.

• If you select Same as Opened View Name, the view is saved with 
the same name as the opened view but with the numeric extension 
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incremented by one. For example, you use the key NMS when 
opening a nodal provisioning session and the view NMS01.full.001 
displays in the Nodal Provisioning window. When you save and 
activate this view using the Same as Opened View Name option, the 
view is saved as NMS01.full.002.

Note:  Commit, Current, and Edit not available in the Save/Activate 
View dialog box.

6 Click OK to save the modified view, or if you wish to activate a view and 
commit a view, proceed to “Activating and Committing the View for 
Passport devices” (page 202).
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Activating and Committing the View for Passport devices
Use the Activate View and Commit View panels of the Save/Activate View 
dialog box to activate and commit the view. 

Note: In a hitless software upgrade, the noPause option is automatically 
added during the activation process. The message that is sent to the 
Passport prevents the automatic pause that typically occurs before a 
migration switchover during a software migration.

Nodal Provisioning lets you to activate the Passport without saving the view 
when journaling is enabled on the Passport device. However, a complete 
check is required to activate the provisioning view. 
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Procedure steps
1 In the Save/Activate View dialog box, select Activate to activate the 

view.

2 If you want to commit the view, select Commit. The default is unchecked.

To prevent accidental selection, a confirmation dialog box opens asking 
you to confirm the commit selection.

3 Click OK. 

The confirmation dialog closes and you return to the Save/Activate View 
dialog box.

4 To save the modified view, click OK. The Save/Activate View dialog box 
closes.

Select Commit to 
commit the 
configuration.

Select Activate to 
activate the 
configuration.
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The OK button remains disabled if your selections in this dialog box are 
invalid or incomplete.

To cancel the operation, click Cancel. The Save/Activate View dialog box 
closes without applying your provisioning changes.

If you have selected commit, a dialog box opens, asking you to confirm 
the commit. Click Yes.

You may encounter the following error conditions, and corresponding 
error dialogs, upon activation:

• A journalDisabledReason error. For the procedure to resolve a 
journal error conditions, see “Resolving a journalDisabledReason 
error condition” (page 191).

• restorePossible. For the procedure to resolve a restorePossible 
condition, see “Resolving a restorePossible error condition” 
(page 190).
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Nodal Provisioning user preferences

This section provides information and procedures on setting user preferences 
in Nodal Provisioning. This section contains the following topics:

• “User preferences overview” (page 205)

• “Setting User Preferences for uploading the service data view” 
(page 208)

• “Setting user preferences for saving and activating the service data view” 
(page 211)

• “Setting user preferences for the Nodal Provisioning window” 
(page 215)

User preferences overview
You can modify user preferences after you start Nodal Provisioning. You use 
the User Preferences dialog box to select default settings and save them to a 
file for the following items: 

• Open View dialog box

• Save/Activate View dialog box

• Nodal Provisioning window

The User Preferences dialog box lets you specify your preferences for the 
following items when you upload the service data view:

• access mode

• view mode
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• the option to preload the Passport service data view whenever a 
provisioning session begins

• the option to create a log file of the changes made to the Passport service 
data during a provisioning session

• the option to always prompt to open the view

For the procedure to set user preferences for opening a service data view, see 
“Setting User Preferences for uploading the service data view” (page 208).

The User Preferences dialog box lets you select the following preferences for 
saving the service data view:

• options for checking the view

• format for the save view

• options for activating the view

• the option to always prompt to save the view

For the procedure to set user preferences for saving the service data view, see 
“Setting user preferences for saving and activating the service data view” 
(page 211).

The User Preferences dialog box lets you select the following options for the 
Nodal Provisioning window:

• the maximum number of components to display in the component 
hierarchy 

• the look and feel of the Nodal Provisioning window

• the option to open the window in component hierarchy view or shelf view

For the procedure to set user preferences for the Nodal Provisioning window, 
see “Setting user preferences for the Nodal Provisioning window” 
(page 215). 

User preferences are stored in your home directory in an XML file, 
MagellanNMS/NPUserPreferences.cfg. 
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When you start a nodal provisioning session, Nodal Provisioning to see if the 
MagellanNMS/NPUserPreferences.cfg file exits. If the file exists Nodal 
Provisioning uses the preferences specified in this file. If the file does not 
exist, Nodal Provisioning creates the file using the default values. If you do 
not have write access to a home directory (for example, a remote log in), 
Nodal Provisioning displays the Open View and Save/Activate View dialog 
boxes from which you can specify your preferences. 

When you save the user preferences to a file, these preferences take effect in 
the next action of the current provisioning session. You are prompted to save 
the changes. If multiple provisioning sessions occur on one switch using the 
same user ID, then the NPUserPreferences.cfg file will contain the last saved 
user preferences.

You cannot modify the MagellanNMS/NPUserPreferences.cfg file using a 
text editor. You can only modify this file through the User Preferences dialog 
box. 
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Setting User Preferences for uploading the service data 
view

Use the Open View pane in the User Preferences dialog box to specify the 
following preferences:

•  how service data views will be uploaded by Nodal Provisioning. This 
includes the access and view modes.

• whether to enable the following options:

— preloading the service data view

— propagation logging

— prompting to open the view

Procedure steps
1 In the menu bar of the Nodal Provisioning window, select Options -> 

User Preferences.

The User Preferences dialog box opens. The dialog box has three 
tabbed panes -- Open View, Save/Activate View, and General. The 
dialog box opens with the Open View pane visible.
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2 In the Access Mode panel, select one of the following access mode 
options:

• Read Only restricts you to viewing service data. You cannot update 
the service data.

• Read and Write is selected by default. Read and Write lets you 
update or modify the service data.

3 In the View Mode panel, select one of the following options to specify the 
type of service data to open:

• Committed uploads the committed service data view. The 
committed view is the view Passport uses when the node restarts.

• Edit uploads the edit service data view. The edit view is the view that 
you are currently modifying. It can potentially become the next 
current view.

Select the Open 
View tab to set 
user preferences 
for the Open View 
dialog box.
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• Current uploads the current service data view. The current view is 
the configuration that is currently running on your node. 

• Other provides you with additional options for opening the view. The 
default is Keyed. You can select Keyed, Dated, or User Specified 
from the drop down list.

4 In the Other Options panel, select one of the following additional options: 

• Preload View loads the Passport service data view whenever a 
provisioning session begins. By default, the Preload View option is 
enabled. Enabling this option is advantageous if the view contains 
many components and you need to access a large number of them. 
You don’t need to enable this option if the view contains a small 
number of components, or if you need to access only a small number 
of components in a large view. If you set the view mode preference 
to Edit, the Preload View option is ignored.

• Propagation Logging To creates a log file of the changes made to 
the Passport service data during a provisioning session. The log file 
starts recording when you successfully open a view and continues 
until the view is closed. The name of the propagation log file is the 
user name concatenated with the string “_ApiLog”, for example, 
smith_ApiLog. The log file is saved in the /opt/MagellanNMS/data/
ANP directory with the specified file name. Each time a log file is 
created, a time stamp is appended to the file name so that each file 
has a unique name. You can view the log file name from the Nodal 
Provisioning window by right clicking the view name in the status bar 
and selecting Log File Name. 

• Always Prompt to Open View when opening a new device
This option determines whether the Open View dialog box with the 
user preference values displays when you select File -> New Device 
in the Nodal Provisioning window.

5 Click Save to save your user preferences.

Save saves the preferences to your home directory in the file ~/
MagellanNMS/NPUserPreferences.cfg and closes the dialog box. A 
confirmation dialog box opens indicating that the user preferences will 
take effect in the next action of the current provisioning session and 
asking if you want to save the changes. Proceed to step 6.

If you wish to cancel the operation, click Cancel. The User Preferences 
dialog box closes without saving your changes.

6 In the confirmation dialog box, click Yes to confirm the changes.
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Setting user preferences for saving and activating the 
service data view

Use the Save/Activate View panel in the User Preferences dialog box to set 
the user preferences for the Save/Activate View dialog box. You can specify 
the following preferences for saving the service data view:

• check view options

• format for saving the view

• activation and commit options

• option to always prompt to save the view

Procedure steps
1 In the menu bar of the Nodal Provisioning window, select Options -> 

User Preferences.

The User Preferences dialog box opens displaying preferences that you 
can change. The dialog box has three tabbed panes -- Open View, Save/
Activate View, and General. The dialog box opens with the Open View 
pane visible.

2 Select the Save/Activate View tab.
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3 In the Check View panel, select the type of check from the drop down list. 
By default Check View is selected when you open the User Preferences 
dialog box. The following check view options are available from the 
adjacent drop down list:

• changed only checks the changes made to the view.

• complete is the default option. When you select this option, the 
complete view is checked.

If you do not want a check of the provisioning view, you can deselect the 
Check View. 

Select the 
Save/Activate View 
tab to set user 
preferences for the 
Save/Activate View 
dialog box.
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If you wish to activate, the service data view should be completely 
checked before saving. 

4 In the Save View panel, select Save, and then select the format for the 
saved data view file. You have the following options:

• Selecting ascii saves the data view file in ASCII format.

• Selecting delta saves the data view file in delta format.

• By default the data view file is saved in portable format.

• Selecting portable and ascii saves the data view file in both portable 
and ascii formats.

5 Specify the method for naming the new service data view when a save 
occurs. You can select Keyed, Dated, User Specified, or Same as Opened 
View from the 

• Keyed. In the adjacent text field, type a key, where <key> starts with 
a number or letter, can contain numbers, letters, or underscores for 
subsequent characters. The key cannot exceed 6 characters. If 
<key> contains only numbers, then its length must be at least three 
characters. The service data view that matches the pattern and has 
the highest index is found, and the next view in the sequence is 
created.

• Dated. In the adjacent text field, type today or type a date in the 
format yymmdd where yy is the year, mm is the month, and dd is the 
day. When you enter a date, the service data view with the highest 
two digit index (nn) is found and the next view in the sequence is 
created, in the format <yymmdd><nn>. For example 03012901. See 
“Date Convention” (page 31) for more information on the date 
format. When you enter today, the view is saved with today’s date, 
in the format yymmd<nn>.

• User Specified. You need to type a view name in the adjacent field. 
Nodal Provisioning saves the service data view according to a user-
specified view name.

• Same As Opened View Name. When you select this option, the 
adjacent text field is disabled. 

6 In the Activate Option panel, select Activate to activate the view.

7 In the Commit View panel, select Commit to commit your view

There are no default settings for Activate View or Commit View.
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8 If you do not want to be prompted to save the view, in the Other Options 
panel, deselect Always Prompt to Save View.

By default, the Always Prompt to Save View is selected.

9 Click Save to save your user preferences.

Save saves the preferences to your home directory in the file ~/
MagellanNMS/NPUserPreferences.cfg and closes the dialog box. A 
confirmation dialog box opens asking you to confirm that the changes will 
apply to the next action of the current provisioning session.

Click Cancel if you wish to cancel the operation.The User Preferences 
dialog box closes without saving your changes.

10 In the confirmation dialog box, click Yes to confirm the changes.
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Setting user preferences for the Nodal Provisioning 
window

You set the user preferences for the appearance of the Nodal Provisioning 
window in the General pane of the User Preferences dialog box. You can 
select the following preferences for the Nodal Provisioning window:

• maximum number of component instances to display in the component 
hierarchy 

• view presentation

Procedure steps
1 In the menu bar of the Nodal Provisioning window, select Options -> 

User Preferences.

The User Preferences dialog box opens displaying preferences that you 
can change. The dialog box has three tabbed panes -- Open View, Save 
View, and General. The dialog box opens with the Open View pane 
visible.
Preside MDM Nodal Provisioning User Guide   14.3RSUP



216   Chapter 10 Nodal Provisioning user preferences
2 Select the General tab.

3 In the Max Instances field, specify the maximum number of component 
instances to display in the component hierarchy in the Nodal 
Provisioning window. The default value is 50.

4 In the View Presentation panel, select how you want the Nodal 
Provisioning window to display when you restart Nodal Provisioning. 
You have the following options:

• Tree is the default setting. When you select this option, the Nodal 
Provisioning window displays the component hierarchy view.

• Shelf displays the Nodal Provisioning window in shelf view.

Select the General tab to 
set user preferences for the 
Nodal Provisioning window.
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5  To save your user preferences, click Save.

Save saves the preferences to your home directory in the file ~/
MagellanNMS/NPUserPreferences.cfg and closes the dialog box. A 
dialog box opens asking you to confirm that the changes will apply in the 
next action of the current provisioning session. Proceed to step 6.

If you wish to cancel the operation, click Cancel. The User Preferences 
dialog box closes without saving your changes.

6 In the confirmation dialog box, click Yes to confirm that the changes.
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Nodal Provisioning Template Editor

For a description of the Nodal Provisioning Template Editor, and how to use 
it, see the following sections:

• “Nodal Provisioning Template Editor overview” (page 220)

• “Nodal Provisioning Template Editor window” (page 221)

• “Maximizing and minimizing panels in the Nodal Provisioning Template 
Editor window” (page 248)

• “Creating or modifying service templates task flow” (page 249)

• “Starting the Nodal Provisioning Template Editor” (page 250)

• “Opening a saved service template file” (page 254)

• “Clearing the template editor window to create a new service template 
file” (page 258)

• “Selecting a CDL version overview” (page 259)

• “Specifying a Passport software version range” (page 263)

• “Specifying template identification attributes” (page 272)

• “Component layout procedures” (page 275)

• “Adding components” (page 276)

• “Adding sub-components to a dropsite or component node” (page 281)

• “Adding Linked Components” (page 283)

• “Removing components from the Component Layout tree” (page 286)
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• “Adding or removing a dropsite” (page 287)

• “Selecting the component parent designation” (page 293)

• “Selecting the component designation” (page 295)

• “Removing links” (page 297)

• “Adding or removing attributes” (page 298)

• “Modifying attribute details” (page 299)

• “Form Layout procedures overview” (page 301)

• “Saving service template files” (page 312)

• “Exiting Nodal Provisioning Template Editor” (page 317)

• “Updating the service template palette in Nodal Provisioning” 
(page 318)

• “Version checking tool overview” (page 319)

• “Starting the version checking tool” (page 320)

Nodal Provisioning Template Editor overview
The Nodal Provisioning Template Editor is a graphical user interface for 
creating and modifying service templates. The template editor lets you do the 
following tasks:

• create service templates that have multiple top level or root components, 
such as two AtmIfs 

• create multiple same type components, such as multiple Channels on a 
single port

• specify a valid CDL Passport software version range or ranges in the 
template so that only the templates applicable to the software version of 
the connected device display in the Nodal Provisioning window. 

• display a dynamically created view-only service creation form that can 
always be visible while creating the template, and which shows how the 
template will appear in the Nodal Provisioning. When the preview is 
displayed, any changes that you make to the template are immediately 
shown in the preview form.
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• ensure template security by setting file permissions through the UNIX 
file system. If a file is set as read-only, the Template Editor will not 
overwrite it.

• provide support for data sharing, allowing the value of one field to be 
used as the value for a dependent field.

• update the template listing directly from Nodal Provisioning 

When you save a service template, the files are stored in the following 
location:

/opt/MagellanNMS/cfg/ANP/<deviceType>/Service/
<category>/<templatefile name>.st

Nortel Networks provides service templates with the Preside Multiservice 
Data Manager (MDM). These templates are read-only so they cannot be 
modified. The directory has read/write privileges so users can save these 
templates with a new name.

Nodal Provisioning also provides a version checking tool. This is an off-line 
tool that identifies inconsistencies between the following items, when the 
Passport software version is upgraded:

• service templates and component models

• service models and the hierarchy model

For information on using the version checking tool, see the following 
sections:

• “Starting the version checking tool” (page 320)

• “Sample outputs” (page 320)

Nodal Provisioning Template Editor window
You can create new service templates, or modify existing service templates, 
using the Nodal Provisioning Template Editor window. When you start the 
template editor for the first time, the fields in the window are empty, and by 
default the status bar shows the CDL version as unselected and the Valid CDL 
versions as All. 
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Before you can create a template, you need to select a CDL version. See 
“Selecting a CDL version overview” (page 259).

For an illustration of the Nodal Provisioning Template Editor window to 
create a new service template at start-up, see “Template Editor at startup” 
(page 222).

Figure 12
Template Editor at startup
241-6001-610   14.3RSUP   



Chapter 11 Nodal Provisioning Template Editor   223
When you load a service template file, the template editor populates the fields 
in the Nodal Provisioning Template Editor window with the information 
contained in the selected service template (.st) file.

The status bar shows the selected CDL version and the Valid CDL version 
range or ranges.

For an illustration of the template editor window after you have loaded a 
service template file, see “Nodal Provisioning Template Editor after loading 
a service template file” (page 224). This example shows the main window 
after the file atmIf.st is loaded from the location /opt/MagellanNMS/cfg/
ANP/EM/Service/ATM. The selected component has its details shown in the 
Component Details section.
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Figure 13
Nodal Provisioning Template Editor after loading a service template file

The Nodal Provisioning Template Editor window contains the following 
items:

• “Nodal Provisioning Template Editor menu bar” (page 225)

• “Template Identification panel” (page 229)

• “Template Details panel” (page 230)
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• “Status bar” (page 247)

Nodal Provisioning Template Editor menu bar
The template editor menu bar gives you access to the high-level functions for 
the template editor. The following menus are found in the menu bar:

• “File menu” (page 225)

• “Edit menu” (page 226)

• “View menu” (page 229)

• “Help Menu” (page 229)

File menu
See the table “File menu commands” (page 225) for a description of the menu 
commands.

Table 15
File menu commands

Command Description Additional Information

New Clears the template editor window so 
you can create a new service template. 

“Selecting a CDL version overview” 
(page 259)

Open Opens a Open file browser to select a 
service template (.st) file. By default, the 
dialog box opens to the Service 
directory.When you select a file, the 
template editor window is populated 
with the information contained in the 
selected service template file. If this is 
the first template that you have opened 
after launching the template editor, and 
it does not have a CDL version specified 
within it, you must select a CDL version 
before the main window populates.

“Opening a saved service template 
file” (page 254)

“Selecting a CDL version overview” 
(page 259)

 (Sheet 1 of 2)
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Edit menu
The content of the Edit menu depends on whether you have selected the 
Component layout tab or the Form Layout tab. The Edit menu options are also 
available from the pop-up menu for the selected item.

See the following tables:

• “Edit menu commands for the Component Layout tab” (page 227). 
These commands let you build the structure of the service template.

• “Edit menu commands for the Form Layout tab” (page 228). These 
commands determine the layout of the service template.

Save Generates the eXtensible Markup 
Language (XML) file for a service 
template file. If you have not previously 
saved the file, a Save dialog box opens 
so you can select a location and specify 
a file name to save to.

“Saving a service template file after 
you have modified it” (page 316)

Save As Opens a Save dialog box so you can 
select a location and specify a file name 
to save to, and then generates the XML 
file for the service template file. 

“Saving a service template file for 
the first time” (page 313)

Change CDL 
Version

Opens the Choose CDL Version dialog 
box so you can select a CDL version on 
which to base the service template.

“Selecting a CDL version overview” 
(page 259)

Set Valid CDL 
Versions

Opens the Set Valid CDL Versions 
dialog box so you can specify the CDL 
versions applicable to the connected 
Passport device.

“Specifying a Passport software 
version range” (page 263)

Exit Closes the template editor. If you have 
not yet saved your file, you are 
prompted to save.

“Exiting Nodal Provisioning 
Template Editor” (page 317)

Table 15  (continued)
File menu commands

Command Description Additional Information
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Table 16
Edit menu commands for the Component Layout tab

Command Description Additional Information

Add Component Opens a dialog box containing a list of 
components that you can add to the 
device.

“Adding components” (page 276)

Add Sub-
component

Opens a list that displays the possible 
components that you can add to a 
selected subcomponent that can have 
sub-components. This command is 
disabled if you have not yet created 
components.

“Adding sub-components to a 
dropsite or component node” 
(page 281)

Add Linked 
Component 

Opens the Add Linked Component 
dialog box which lets you add a linked 
component. This command is enabled 
only if the currently selected component 
can have links.

“Adding Linked Components” 
(page 283)

Remove 
Component

Removes a selected component, and its 
links and subcomponents. In the form 
layout, if the group and tab have been 
generated automatically, and they are 
empty, they are removed. If there are 
multiple groups, only the empty groups 
are removed.

“Removing components from the 
Component Layout tree” (page 286)

Remove Link Removes a link from the currently 
selected component. This command 
does not remove the component that it 
is linked to.

“Removing links” (page 297)
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Table 17
Edit menu commands for the Form Layout tab

Command Description Additional information

Add Tab Adds a tab to the layout tree in the 
Template Details panel. 

“Renaming tabs or groups” 
(page 303)

“Adding tabs to the form layout tree” 
(page 304)

Add Group Adds a group to a selected tab on the 
display layout tree in the template 
details panel. The Add Group command 
is enabled only when a tab is selected.

“Adding Groups to the form layout 
tree” (page 306)

Delete Tab Deletes a selected tab from the display 
layout tree. The Delete Tab command is 
enabled only when you select an empty 
tab.

“Deleting tabs from the form layout 
tree” (page 305)

Delete Group Deletes a selected Group from the 
display layout tree. The Delete Group 
command is enabled only when you 
select an empty Group.

“Deleting Groups from the form 
layout tree” (page 308)

Show 
Component

Turns on the display for the key and 
attributes of a hidden component and 
displays it in the form preview, and when 
you use the template in Nodal 
Provisioning. Shown components 
appear normal in the Form Layout tree.

“Showing components in the form 
layout tree” (page 310)

Hide Component Turns off the display for the key and 
attributes of a component and stops it 
from displaying in the form preview, and 
when you use the template in Nodal 
Provisioning. The hidden component is 
greyed out in the Form Layout tree.

The Hide Component command is 
enabled only for components whose key 
does not need to be filled in at run-time.

“Hiding a component in the form 
layout tree” (page 309)
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View menu
See the table “View menu command” (page 229) for a description of the 
Preview command. 

Help Menu
The table “Help menu commands” (page 229) describes the Help menu 
commands.

Template Identification panel
The Template Identification panel provides text fields to enter general 
identifying information for the service template. 

Table 18
View menu command

Command Description Additional Information

Preview Opens a preview of the service template 
form so that you can see how the 
service template looks in real time, that 
is, as you are creating it in the Nodal 
Provisioning Template Editor window. 
The preview form cannot be edited. 

Table 19
Help menu commands

Command Description Additional Information

Help on Help Opens a help window that describes the 
on-line help.

“Help options” (page 32)

Help on Window Opens the online documentation 
describing the Nodal Provisioning 
Template Editor window.

“Help options” (page 32)

About Template 
Editor

Opens a dialog box containing the name 
of the tool
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The Template Identification panel contains the following fields:

• The Title field identifies the service template. The name that you type in 
this field appears in the service template palette in the Nodal 
Provisioning window.You can select the content of this field and edit it. 
You cannot save a template with no title.

Note: It is recommended that you create a unique title for each template 
within the same category. The title and the template icon are the only 
items that distinguishes between templates in the Nodal Provisioning 
tool.

• The Author field lets you enter the author of the template.You can select 
the content of this field and edit it. 

You cannot save a template with “Nortel Networks” as the author, nor can 
you save a template with no author. If the template is created by Nortel 
Networks, the Author field displays “Nortel Networks”. If you edit the 
template, you need to save it under a new name since you cannot 
overwrite a Nortel Networks template. 

• You can enter a textual explanation or details about the service template 
in the Description field. Completing this field is optional. You can edit 
the contents of this field. 

• The Icon field lets you choose an icon image that represents the service 
template. This icon appears in the service template palette in the Nodal 
Provisioning window. You can also click Browse... to select an icon from 
the icon browser dialog box. 

For related procedures, see the following sections:

• “Specifying template identification attributes for a new template” 
(page 273)

• “Modifying template identification attributes of an existing service 
template (.st) file” (page 274)

Template Details panel
The Template Details panel contains the following tabs with their 
corresponding details:

• “Component Layout tab” (page 231)
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• “Form Layout tab” (page 234)

Component Layout tab
The Component Layout tab displays the component layout tree and the 
Component Details panel.

• Component layout tree shows the following

— the components that are created on the device by the template when 
it is applied

— the dropsite where this template can be dropped

— the relationship between the components in the component layout 
tree.

• Component Details panel contains the details about the component that 
you have selected in the component layout tree. You use this panel to 
change the instance value for each component and select the component 
attributes that you want to include in the service template

When you open the Nodal Provisioning Template Editor window, the 
Component Details panel is blank. 

See the figure “Template Details for the Component Layout tab” (page 232).
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Figure 14
Template Details for the Component Layout tab

The content of the Details panel varies with the type of dropsite that you select 
in the component layout tree:

• parent 

• link

• component
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The Parent Dropsite, Link Dropsite, and Component Dropsite Details panel 
have the following command buttons:

• Add moves a selected component from the Available list to the Included 
in Template or Chosen list.

• Add All moves all the selected components from the Available list to the 
Included in Template or Chosen list.

• Remove moves the selected component or components from the 
Included in Template or Chosen list to the Available list.

• Remove All moves all the components from the Included in Template or 
Chosen list to the Available list

See the following tables for additional information the details panel for each 
of the dropsite types:

• for a parent dropsite, see “Details panel for a parent dropsite” (page 233)

• for a link dropsite, see “Details panel for a link dropsite” (page 234)

• for a component dropsite, see “Details panel for a component dropsite” 
(page 234)

Table 20
Details panel for a parent dropsite

Title of Details 
panel

Details panel content Description

Dropsite Details Child component(s) field The name of the component created under the 
dropsite component

Available Dropsites list A list of available components that can be parents

Chosen Dropsites list A list of components that have been added from the 
Available Dropsites combo box. These are the 
components that the template can be dropped on 
when using the Nodal Provisioning tool.
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Form Layout tab
The Form Layout tab lets you select the layout of the service creation form. 
The contents of the Form Layout tab correspond directly to the appearance of 
the service creation form.

The Form Layout tab displays the following items:

• the tab and group layout of the service template. Each top level 
component has its own tab and group. Each subcomponent has its own 
group under the parent tab.

Table 21
Details panel for a link dropsite

Title of Details 
panel

Details panel content Description

Dropsite Details Linked Component(s) 
field

The name of the component(s) that are linked to the 
dropsite component

Available Dropsites list A list of available components that can be linked to 
the selected link component.

Chosen Dropsites list A list of components that have been added from the 
Available Dropsites combo box. These are the 
components that the template can be dropped on 
when using the Nodal Provisioning tool.

Table 22
Details panel for a component dropsite

Title of the 
Details panel

Details panel content Description

Component 
Details

Component A drop down list of components in the component 
layout tree. The selected component appears by 
default. The details are for the component selected 
from the list.

Available Attributes list A list of available attributes for the selected 
component

Included in Template list A list of attributes that are in this template
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— A tab is a collection of groups that you define. The collection is 
shown on the service template as a tab. You can specify the name of 
the tab.

— A group is a collection of components that you define. The 
collection is shown on the service template as a bordered panel. You 
can specify a name for the panel.

• the details about an item that you have selected in the form layout tree. 
The form Details panel lets you change the instance value for each 
component and select the component attributes that you want to include 
in the service template

When you open the Template Editor main window the Template Details 
panel is blank. 

For an illustration of the Form Layout tab when the AtmInterface template is 
loaded, see “Form Layout tab and its relationship to the service creation 
form” (page 236). 
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Figure 15
Form Layout tab and its relationship to the service creation form
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See the following tables for additional information the details panel when you 
select the following item in the Form Layout tree:

• “Details panel for a tab” (page 237)

• “Details panel for a Group” (page 239)

• “Details panel for a Component” (page 241)

• “Details panel for an Attribute” (page 244)

See the figure “Tab Details” (page 238) for an illustration of the Tab Details 
panel.

Table 23
Details panel for a tab

Title of Details 
panel

Details panel content Description

Tab Details Tab Name An editable field in which you can enter a name for 
the Tab.

Location

• Position

A combo box containing a list of valid positions for 
the tab. The current position of the tab in the form 
layout tree is shown. You can change the position of 
the tab by selecting another position from the combo 
box.
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Figure 16
Tab Details
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See the figure “Group Details” (page 240) for an illustration of the Group 
Details panel.

Table 24
Details panel for a Group

Title of Details 
panel

Details panel content Description

Group Details Group Name An editable field in which you can enter a name for 
the Group.

Location

• Tab

• Position

The Tab combo box provides a list of valid tabs to 
which you can move the Group. The current Tab 
position for the Group in the form layout tree is 
shown. 

The Position combo box lets you move a Group’s 
position in the Tab by selecting a position number 
from the combo box.
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Figure 17
Group Details
241-6001-610   14.3RSUP   



Chapter 11 Nodal Provisioning Template Editor   241
Table 25
Details panel for a Component

Title of details 
panel

Details panel content Description

Component 
Details

Name You can select from a drop down list of components 
in the component layout tree. The selected 
component appears by default. The details are for 
the component selected from the list.

Instance Value A drop down list of available naming schemes for the 
selected component. 

• none - is displayed for components that do not 
need an instance value. You cannot edit this 
instance value. By default, the Show check box is 
deselected. You can select it to display the value 
to the user.

• predefined - is displayed as the instance value for 
components that have a predefined instance 
value. The value is displayed in the 
accompanying value field. You cannot edit this 
instance value. By default, the Show check box is 
deselected. You can select it to display the value 
to the user.

• auto named - the Nodal Provisioning tool 
suggests an instance value data for the 
component. The user of this template can change 
the suggestion when using this template. 
Autonaming is only supported for numerical 
instance value data.

• user entered - you must provide the instance 
value data. If only one instance of the component 
can exist, then this is the instance used.

• user selected - you must select from a list of 
existing instances of this component.

• gets value from - you must select from a list of 
items with the same data type component or 
attribute

 (Sheet 1 of 2)
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See the figure “Component Details for AtmIf” (page 243) for an illustration 
of the Component Details panel.

Show check box A check box that allows you to show or hide the key 
value from the user of this template

Attributes Included in 
template list

A list of available attributes included in the template

Displayed in Form list A list of attributes displayed in the service creation 
form

Command buttons:

• Add

• Add All

• Remove

• Remove All

Add moves a selected attribute from the Included in 
Template lists and adds it to the Displayed in Form 
list.

Add All moves all the attributes from Included in 
Template list to Displayed in Form list.

Remove moves the selected attribute from the 
Displayed in Form list to the Included in Template 
list.

Remove All moves all the attributes from the 
Displayed in Form list to the Included in Template 
list.

Location:

• Tab

• Group

• Position

The Tab combo box lets you select a new tab 
location for the component from a drop down list. The 
current position shows by default.

The Group combo box lets you select a new group 
location for the component from the drop down list. 
The current position shows by default.

The Position combo box lets you change the position 
of the component in the group.

Table 25  (continued)
Details panel for a Component

Title of details 
panel

Details panel content Description

 (Sheet 2 of 2)
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Figure 18
Component Details for AtmIf
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Table 26
Details panel for an Attribute

Title of details 
panel

Details panel content Description

Details for Attribute combo box A list of available attributes.The name of the attribute 
selected in the form layout tree appears by default.

Label An editable field that shows the label that appears on 
the service creation form for this attribute.

Value: The value is set to default unless otherwise 
specified. The options are:

• override - overrides the default value

• default - the value that is provided by the Nodal 
Provisioning tool

• gets value from - gets any item with the same data 
type

• user selected - lets the user of this template select 
a value from a list of instances

Initial Value A field where you can set the original value of two 
attributes that share the same value. This is only 
enabled when the value type is “gets value from”.

Display in Form check 
box

If Display in Form is checked, the new label is 
displayed in the service creation form.

Deselecting Display in Form prevents an attribute 
from appearing in the service creation form.

 (Sheet 1 of 2)
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Mandatory check box The Mandatory check box is enabled when Display 
in Form is checked. If selected, this attribute is 
mandatory and must be filled in by the user before a 
service creation will be valid.

Editable check box The Editable check box is enabled when Display in 
Form is checked. If selected, this attribute’s values 
can be edited.

Table 26 (continued)
Details panel for an Attribute

Title of details 
panel

Details panel content Description

 (Sheet 2 of 2)
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Figure 19
Attribute Details
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Status bar
The status bar at the bottom of the Nodal Provisioning Template Editor 
window shows the following items:

• CDL Version shows the selected CDL version. When you open the 
Nodal Provisioning Template Editor for the first time, the CDL version 
is unselected.

• Valid CDL versions shows the valid CDL version range or ranges. 
When you open the Nodal Provisioning Template Editor for the first 
time, the Valid CDL Versions is All.
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Maximizing and minimizing panels in the Nodal 
Provisioning Template Editor window

Use this procedure to maximize or minimize the Template Identification, 
Template Details, and Details For panels in the Nodal Provisioning Template 
Editor window:

Procedure steps
1 Click on the arrow found to the left of the panel title (Template 

Identification, Template Details, or Details for).

The panel expands, or minimizes.
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Creating or modifying service templates task flow
Use the following sequence of procedures to create or modify a service 
template:

• “Starting the Nodal Provisioning Template Editor” (page 250)

• If you are modifying a service template, see “Opening a saved service 
template file” (page 254)

• If you are creating a new service template, see “Clearing the template 
editor window to create a new service template file” (page 258)

• “Selecting a CDL version overview” (page 259)

•  Specify a valid Passport Software Command Data Language (CDL) 
version range or ranges for a service template “Specifying a Passport 
software version range” (page 263)

• Identify the template. See, “Specifying template identification attributes” 
(page 272)

• Add components, see“Adding components” (page 276)

• Adding or modifying links. See, “Adding Linked Components” 
(page 283)

• To Specify a parent or link dropsite for the first component that you add. 
See, “Adding or removing a dropsite” (page 287)

• For all attributes in the component, modify attribute details. See, 
“Modifying attribute details” (page 299)

• Arrange the tabs and groups of the Form Layout tab. See, “Form Layout 
procedures overview” (page 301)

• “Saving service template files” (page 312)

Note: When editing a text field in Nodal Provisioning Template Editor, 
the changes may not take effect until you hit enter.
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Starting the Nodal Provisioning Template Editor 
Use one of the following procedures to open the Nodal Provisioning Template 
Editor:

• “Starting the Nodal Provisioning Template Editor from the Preside 
MDM window” (page 251)

• “Starting the Nodal Provisioning Template Editor from the Nodal 
Provisioning window” (page 252)

• “Starting the Nodal Provisioning Template Editor from a command line” 
(page 253)
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Starting the Nodal Provisioning Template Editor from the 
Preside MDM window

Use this procedure to start the Nodal Provisioning Template Editor from the 
Preside Multiservice Data Manager (MDM) window.

Procedure steps
1 In the Preside MDM window, select System -> Administration -> Nodal 

Provisioning Template Editor.

The Nodal Provisioning Template Editor window opens. The fields in 
the window are empty.

If you are opening the template editor for the first time, you need to select 
a Command Data Language (CDL) before you can create a new service 
template. See “Selecting a CDL version overview” (page 259).
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Starting the Nodal Provisioning Template Editor from the 
Nodal Provisioning window

Use this procedure to start the Nodal Provisioning Template Editor from the 
Nodal Provisioning window.

Procedure steps
1 In the Preside MDM window, select Configuration -> Passport Devices 

-> Nodal Provisioning.

The Device Selection dialog box opens.

2 From the drop down list, select a Passport device.

The Authentication dialog box opens.

3 In the Username and Password fields of the Authentication dialog box, 
enter a user name and password.

The Nodal Provisioning window opens.

4 Select External Tools -> Nodal Provisioning Template Editor.

The Nodal Provisioning Template Editor window opens. The fields in 
the window are empty.

If you are opening the template editor for the first time, you need to select 
a Command Data Language (CDL) before you can create a new service 
template. See “Selecting a CDL version overview” (page 259).
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Starting the Nodal Provisioning Template Editor from a 
command line 

Use this procedure to start the Nodal Provisioning Template Editor from a 
command line.

Procedure steps
1 Open an xterm on the configuration server workstation and type the 

following command:

/opt/MagellanNMS/bin/anpste &

The Nodal Provisioning Template Editor window opens. The fields in 
the window are empty.

If you are opening the template editor for the first time, you need to select 
a Command Data Language (CDL) before you can create a new service 
template. See “Selecting a CDL version overview” (page 259).

To modify a service template, proceed to “Opening a saved service 
template file” (page 254).
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Opening a saved service template file
Use this procedure to open a saved template file. When you open a saved 
template file, you do not need to select a CDL version, since templates created 
by the template editor are saved with a version.

Service template files are stored in /opt/MagellanNMS/ cfg/ANP/<device 
type>/Service/<category>. A service template file has the extension .st.

Procedure steps
1 In the template editor main window, select File -> Open.

A file browser Open dialog box opens to the service directory.

Note:  If you have permissions, you can add folders, remove folders, 
rename folders, and remove files from the Open dialog box. Permissions 
are based on the userid of the account from where the template editor 
was launched.
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2 Select the folder that contains the service template file that you want to 
edit and click Open.
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The file browser displays the service templates (.st) files in the selected 
folder.

3 From the list of service template files, select the file that you want to open 
and click Open

If you have selected a service template file with a CDL version specified 
in it, the template editor window is populated with the information 
contained in the selected service template file. You can proceed to modify 
the template. See the section “Creating or modifying service templates 
task flow” (page 249).

If you select a template that does not have a CDL version specified in it, 
the Choose CDL Version dialog box opens. Proceed to choose a CDL 
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version. See the procedure, “Selecting a CDL version overview” 
(page 259).
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Clearing the template editor window to create a new service 
template file

Use this procedure to clear the Nodal Provisioning Template Editor window 
so that you can create a new service template.

Procedure steps
1 If you are not starting with a cleared Nodal Provisioning Template 

Editor window, select File -> New.

If there are unsaved changes in the current template, a dialog box opens 
to indicate that the current template has been modified. You are prompted 
to save your changes. After you save the file, or choose not to save the 
changes, the information in the main window is cleared.

2 If the template already has a CDL version associated with it, you can 
proceed to create the template with the existing CDL version. 

If you wish to base the template on a new CDL version, proceed to 
“Changing the CDL version of a service template” (page 261).

If you wish to specify valid Passport software version ranges, proceed to 
“Specifying a Passport software version range” (page 263).
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Selecting a CDL version overview
Use the Choose CDL Version dialog box to select a Command Data Language 
(CDL) on which to base a service template. 

If you are opening the Nodal Provisioning template editor for the first time, 
you must select a CDL version before you can create the new service 
template. The Nodal Provisioning Template Editor uses the CDL version to 
find the version of the hierarchy model required, the components attributes, 
and their defaults.

The Choose CDL Version dialog box also opens in the following 
circumstances:

• you select File -> Open and select an service template file that has no 
version specified in it to modify.

• you select Edit ->Add Component to add the first component to the 
service template and you have not yet selected a CDL version.

• you select File -> Change CDL Version to select a CDL version on 
which to base a new service provisioning template, or to change the CDL 
version of the template that you are currently working on.

By default, the most current CDL version available is selected and appears in 
the CDL version field.

The procedure to select the device Command Data Language (CDL) version 
of a template depends on whether you are starting with a cleared template, or 
if you want to change the CDL version of an existing template. For the 
relevant procedures, see the following sections:

• “Selecting the CDL version for a new service template” (page 260)

• “Changing the CDL version of a service template” (page 261)
Preside MDM Nodal Provisioning User Guide   14.3RSUP



260   Chapter 11 Nodal Provisioning Template Editor
Selecting the CDL version for a new service template
Use this procedure to select the Command Data Language (CDL) version for 
a new service template. 

Procedure steps
If you have already loaded a service template file, and you want to select a 
CDL version on which to base a new template, you first need to clear the 
template editor. If the Nodal Provisioning Template Editor window has not 
been cleared, go to “Clearing the template editor window to create a new 
service template file” (page 258) dialog box.

1 Select File -> Change CDL version.

The Choose CDL Version dialog box opens.

2 In the Choose CDL Version dialog box, accept the default CDL version, 
or from the drop down list of available versions, select the CDL version 
that you want to change to.

By default, the most current and available CDL version is selected and 
appears in the CDL version field.

3 Click OK.

The left side of the status bar of the Nodal Provisioning Template Editor 
window contains the CDL Version that you selected. This version remains 
until you load a different template that specifies a version or you select 
File -> Change CDL Version again.
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Changing the CDL version of a service template
Use this procedure to change the Command Data Language (CDL) version of 
your template. You can change the CDL version immediately upon opening 
the service template file, or you can change the CDL version at any time while 
you are modifying a service template. You can open a saved template file 
without first changing the CDL version since templates created by the 
template editor are saved with a version.

Procedure steps
You use the Choose CDL Version dialog box to select a new CDL version.

1 In the menu bar, select File -> Change CDL version.

The Choose CDL Version dialog box opens.

2 Select the CDL version that you want to change to from the drop down list 
of available versions.

By default, the most current and available CDL version is selected and 
appears in the CDL version field.

3 Click OK.

The template editor checks the template’s attributes and components 
against the new version.

If all the components and attributes are available, and have the same 
ranges of values, the template editor changes the version of the template 
and the new CDL version appears in the status bar at the bottom of the 
Nodal Provisioning Template Editor window. The template is reloaded 
with the new CDL version so any attributes and components that do not 
exist in the new CDL version are no longer available to change or to add 
to the template.
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If one or more of the components or attributes do not exist in the new CDL 
version, or has a different range of values, an error dialog box opens. 
Proceed to step 4.

4 Select Show Details.

The error dialog box displays which items are not consistent with the 
newly chosen CDL version and the template remains unchanged.

5 If you want to make the template consistent with the new CDL version, 
leave the error dialog box open, and proceed to step 6.

If you do not want to make the template consistent with the new CDL 
version, close the error dialog box and continue to edit the template.

6 Make the changes to the template to make it consistent with the new CDL 
version.

7 Select File -> Change CDL Version.

If the template is now consistent with the CDL version, the error dialog box 
closes. The template’s CDL version is updated and the template is re-
loaded with the new version.

If the template is still not consistent with the newly chosen CDL, the error 
dialog box updates with the new reasons why this template is not 
consistent with the CDL version. Return to step 6, or close the error dialog 
box and continue to edit the template without changing the CDL version.
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Specifying a Passport software version range 
You use the Set Valid CDL Versions dialog box to specify the valid Passport 
Software Command Data Language (CDL) version range or ranges for a 
service template. 

When you specify a software version range or ranges, the template can only 
be used to provision Passport devices whose software version is included 
within the specified range or ranges. Nodal Provisioning filters out all 
templates that do not apply to the Passport software version of the connected 
device. The Nodal Provisioning window displays only those templates that 
apply to the Passport software version or versions of the connected Passport 
device.

You can specify the Passport software version at any time after you launch the 
Nodal Provisioning Template Editor, either to create a new service template, 
or to modify an existing service template.

The Set Valid CDL Versions dialog box opens with the default setting of All 
CDL Versions and displays a single empty row in the range selection table.

You are provided two options for selecting a CDL version range or ranges:

• All CDL Versions lets you create a template that applies to all Passport 
CDL software versions.

• Specify CDL range(s) lets you create a template which applies to specific 
Passport CDL software versions.

For an illustration of the Set CDL Range dialog box, see the figure “Set Valid 
CDL Versions dialog box for creating a new service template” (page 264).
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Figure 20
Set Valid CDL Versions dialog box for creating a new service template

When you open an existing service template file, and then select Set Valid 
CDL Versions, the template editor will read from the service template file to 
find the list of previously selected software ranges that apply to the template. 
One of the following occurs:

• If any Passport software version applies to the template, then the software 
range selection table is list is empty. The All CDL Versions option is 
selected, and the range area, Add Range button and Remove Range 
button are disabled. The template file is not tagged with a device version 
tag.

• If specific Passport software versions apply to the template, then the 
software range selection table is populated with the list of valid software 
versions. The CDL range table displays the From and To columns of 

software 
range 
selection table

command 
buttons
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combo boxes that display the lower and upper limit pairs of a CDL 
version range. When a combo box is expanded, it shows the list of all 
available Passport software versions. For example,

— The From column may appear as follows: <“ “, All later versions”, 
CA*, CB*, CC*..., BA*, BB*, ..., FMR*, UWM*, ...> 

— The To column may appear as follows: <“ “, All previous versions”, 
CA*, CB*, CC*..., BA*, BB*, ..., FMR*, UWM*, ...>

where: 

“All later versions” means all Passport software versions which 
succeed the version specified in the From columns.

“All previous versions” means all Passport software versions which 
precede the version specified in the To column.

<matchingString>* means all Passport software versions which start 
with the <matchingString> 

The Specify CDL range(s) option is selected and the Add Range and 
Remove Range buttons are enabled.

See “Examples of CDL ranges” (page 267) for examples of valid CDL 
ranges.

• If no Passport software version was specified in the template, as is the 
case with the older templates, the Set Valid CDL Versions dialog box 
defaults to All CDL Versions. The template file is not tagged with a 
device version tag.

When you click OK in the Set Valid CDL Versions dialog box the following 
occurs:

• Template editor initiates a comparison of the ranges selected in the To 
(upper range) and From (lower range) columns to confirm that the upper 
range is always greater than or equal to the lower range.
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• Another check is performed if you have already set the CDL version and 
this base version has the same software version as either the upper or 
lower range. The template editor checks to ensure that the base CDL 
version is equal to or greater than the lower limit and equal to or less than 
the upper limit.

• The template is tagged with a device version tag. 

• The range or ranges are saved in the service template XML file in the 
following format:

deviceVersion=”<lower1>-<upper1>, <lower2>-
<upper2>,...,<lowerN>-<upperN>”

where:

lowerN, upperN can be “All later versions”, “All previous versions” (*) 
or any Passport software version (for example, CA*, BA*). The upperN 
limit must be greater or equal to the lowerN limit.

• If a range is unacceptable, an error dialog box opens and the Set Valid 
CDL Versions dialog box remains open. See “Error messages” 
(page 268) for additional information on the conditions that create error 
messages and the error messages that are generated.

For additional information, see the following sections:

• “Examples of Passport CDL software version ranges” (page 266)

• “Error messages” (page 267)

• “Specifying the Passport software version range or ranges for a new 
service template” (page 269)

• “Specifying template identification attributes for a new template” 
(page 273)

Examples of Passport CDL software version ranges
The table “Examples of CDL ranges” (page 267) provides examples of valid 
Passport CDL software version ranges.
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Error messages
The table “Error messages” (page 268) describes possible error messages 
when specifying version ranges in the Set Valid CDL Versions dialog box.

Table 27
Examples of CDL ranges

In Set CDL 
Range Dialog 
box

From

In Set CDL 
Range Dialog 
box

To

In XML file
<lower>-<upper>

Explanation

All previous 
versions

CD* *-CD* applies to all CDL versions which are 
released earlier and include release 
CD<version><developmentNumber>
<cycleNumber><debugNumber>

CD* All later versions CD*-* applies to all CDL versions which are 
released from CDL version 
CD<version><developmentNumber><
cycleNumber><debugNumber> and 
later

CD* CE* CD*-CE* applies to all CDL versions which are 
released from CDL version 
CD<version><developmentNumber>
<cycleNumber><debugNumber> to 
CE<version><developmentNumber><
cycleNumber><debugNumber>

CD* CD* CD*-CD* applies to the exact CDL version which 
starts with CD
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Procedures for setting the Passport software version range or 
ranges

Use the following procedures to specify the Passport software version range 
for a new service template. You can specify the Passport software version at 
any time after you launch the Nodal Provisioning Template Editor. For 
relevant procedures, see the following sections:

• “Specifying the Passport software version range or ranges for a new 
service template” (page 269)

• “Changing the software version range or ranges of a service template” 
(page 270)

Table 28
Error messages

Error condition Error message Solution

The version in the To column is not 
greater than or equal to the version 
in the from column.

The version in the To column 
must be greater than or equal 
to the version in the From 
column.

Enter a valid version 
range in the selected 
row.

The CDL software version specified 
in the From column and the To 
column do not belong to the same 
software solution.

Range must specify the same 
software solution.

Enter a valid version 
range in the selected 
row.

The base version of the template is 
outside of the selected valid CDL 
versions.

The base version <version> is 
outside the valid CDL versions 
range at the selected row.

Select Yes to save the 
selected valid versions.
Select No to not save 
the selected valid 
versions.
Select Cancel to cancel 
all selected valid 
versions.

One of the selected valid CDL 
versions is already included in other 
valid CDL versions.

There exists an other version 
range which includes this 
selected range.

Enter a valid version 
range in the selected 
row.
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Specifying the Passport software version range or ranges for 
a new service template

Use this procedure to select the valid Command Description Language (CDL) 
software version range or ranges for a Passport device.

Procedure steps
1 From the File menu, select Set Valid CDL Versions.

The Set Valid CDL Versions dialog box opens and displays a single 
empty row. By default, the All CDL Versions option is selected, and the 
Add Range and Remove Range buttons are disabled.

2 If you wish the template to apply to all Passport CDL software versions, 
click OK to save the valid CDL versions. The template file is not tagged 
with a device version tag.

If you wish to create a template which applies to specific Passport CDL 
software versions, select the Specify CDL range(s) option and proceed 
to step 3. The rows in the software range selection table, and the Add 
Range and Remove Range buttons are enabled

3 Click in the From column, and select the lower limit or starting point for 
your range from the dropdown list of available versions in wildcard format. 
See “Examples of CDL ranges” (page 267).

You can also type a new valid software version range in the From cells of 
the new row.

4 Click in the To column to select the upper limit, or endpoint for your range 
from the dropdown list of available ranges. you can also type a new valid 
software version range in the To cells of the new row.

If no additional ranges are required, proceed to step 7.

5 If additional ranges are required, click Add Range. A new row is added to 
the software range selection table, with the initial selected value as an 
empty string. You can set another range by specifying the lower and upper 
limits.

To remove a selected row from the software range selection table, click 
Remove Range. The software range selection table has one less 
element.

6 Repeat steps 3 to 5 until you have specified all the required ranges.

7 Click OK.

The template file is tagged with a device version tag.
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Changing the software version range or ranges of a service 
template

Use this procedure to change the Passport Command Description Language 
(CDL) software version range or ranges of a service template.

Procedure steps
1 From the File menu, select Set Valid CDL Versions.

The Set Valid CDL Versions dialog box opens. The template editor reads 
the service template file to find the list of software ranges that apply to the 
template. One of the following scenarios occurs:

• If any Passport software version applies to the template, the dialog 
box opens with an empty range selection table, the All CDL Versions 
option selected, and the Add Range and Remove Range buttons 
are disabled.

• if a specific Passport software version or versions apply to the 
template, the software range selection table is populated with the list 
of valid software versions. The Specify CDL range(s) option is 
selected and the Add Range and Remove Range buttons are 
enabled.

• if no Passport software version was specified in the template, as in 
older service templates, the Set Valid CDL Versions dialog box 
defaults to All CDL Versions.

2 To create a service template that applies to specific Passport CDL 
software versions, select the Specify CDL range(s) option.

The rows in the software version range selection table are enabled. Add 
Range and Remove Range are enabled.

3 Click in the From column, and select the lower limit or starting point for 
your range from the dropdown list of available versions in wildcard format. 
See “Examples of CDL ranges” (page 267).

You can also type a new valid software version range in the From cells of 
the new row.

4 Click in the To column to select the upper limit, or endpoint for your range 
from the dropdown list of available ranges. you can also type a new valid 
software version range in the To cells of the new row.

If no additional ranges are required, proceed to step 7.

5 If additional ranges are required, click Add Range. A new row is added to 
the software range selection table, with the initial selected value as an 
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empty string. You can set another range by specifying the lower and upper 
limits.

To remove a selected row from the software range selection table, click 
Remove Range. The software range selection table has one less 
element.

6 Repeat steps 3 to 5 until you have specified all the required ranges.

7 Click OK.

The template editor initiates a comparison of the ranges selected in the 
To (upper range) and From (lower range) columns to ensure that the base 
CDL version is equal to or greater than the lower limit and equal to or less 
than the upper limit. If these conditions are met, the range or ranges are 
saved and the Set CDL Range dialog box closes.

Another check is performed if you have already set the CD

The template file is tagged with a device version tag.
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Specifying template identification attributes 
The Template Identification panel provides fields to enter general information 
to identify the template. The template identification attributes can be edited. 
See the following sections for additional information:

• “Specifying template identification attributes for a new template” 
(page 273)

• “Modifying template identification attributes of an existing service 
template (.st) file” (page 274)
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Specifying template identification attributes for a new 
template

Use this procedure to provide identifying information about the service 
template. 

Prerequisites
This procedure requires that you have opened the Nodal Provisioning 
Template Editor to create a new template.

Procedure steps
1 In the Title field, type a name to identify the service template. This field is 

mandatory.

You should create a unique title for each template within the same service 
category. The title that you enter in the Title field is the title that appears 
for the template in the service template palette of the Nodal Provisioning 
window.

2 In the Author field, type the name of the author of the service template. 
This field is mandatory.

If the template is created by Nortel Networks, this field displays “Nortel 
Networks”. 

3 Optionally, provide a description of the service template by completing 
one of the following steps”

• directly in the Description field, type an explanation or details about 
the service template

• click Edit... to open a larger editing window. This window is empty. 
Type an explanation or details about the service template in this 
window and click Close.

4 Click Browse... .

An icon chooser window opens containing icon images.

5 Select an icon image that represents the service template and click OK.

This icon images appears to the left of the service template title in the 
Nodal Provisioning window.
Preside MDM Nodal Provisioning User Guide   14.3RSUP



274   Chapter 11 Nodal Provisioning Template Editor
Modifying template identification attributes of an existing 
service template (.st) file

Use this procedure to make changes to the following attribute fields in the 
template identification panel of the Nodal Provisioning Template Editor 
window after you open a service template (.st) file:

• title

• author

• icon

• description

Procedure steps
1 In the Nodal Provisioning Template Editor window, make one or more 

of the following modifications:

• If you are modifying the Title or Author fields, highlight the contents 
of the field that you want to modify and make the changes directly in 
the fields. If the template was created by Nortel Networks, the Author 
field contains “Nortel Networks”. 

• If you are modifying the contents of the Description field, select Edit 
to the right of the Description field to open a larger Edit Description 
window. When you open a service template file, this window opens 
with a the same information as contained in the Description field in 
Make your changes and click Close to close the window.

• If you are modifying the icon, select Browse to open an icon browser 
window and select the icon that you want to use.

2 From the File menu, select Save to save the changes. See “Saving 
service template files” (page 312).

You cannot overwrite a template created by Nortel Networks. You need to 
save your changes under a new name.
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Component layout procedures 
See the following for procedures relating to the component layout tree.

• “Adding components” (page 276)

• “Adding sub-components to a dropsite or component node” (page 281)

• “Adding Linked Components” (page 283)

• “Removing components from the Component Layout tree” (page 286)

• “Adding or removing a dropsite” (page 287)

• “Selecting the component parent designation” (page 293)

• “Selecting the component designation” (page 295)

• “Removing links” (page 297)

• “Specifying template identification attributes” (page 272)
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Adding components
Use the Add Component dialog box to select a component or subcomponent 
to add to the template.

When you add the first component, it can take one of two possible forms:

• top-level component

• non top-level component

See the following procedures:

• “Adding the first top-level component (direct sub-component of EM)” 
(page 277)

• “Adding the first non-top level component (not a direct sub-component 
of EM)” (page 279)

• “Adding additional components to EM” (page 280)
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Adding the first top-level component (direct sub-component 
of EM)

Use this procedure to create a direct subcomponent under the root component, 
EM.

Procedure steps
1 From the Edit menu in the Nodal Provisioning Template Editor, select 

Add Component.

If you have not yet selected the CDL version for the template being 
created, the Choose CDL Version dialog box opens. Proceed to step 2 
to select the CDL Version.

If you have already selected a CDL version, the Add Component dialog 
box opens. Proceed to step 3.

2 In the Choose CDL Version dialog box, select the CDL version for the 
template being created and click Ok.

The Add Component dialog box opens. When you add the first 
component to the template, the Component Name list contains every 
component that you can add to the Passport device. 
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3 Select the component that you want to add by typing the component 
name in the Choose a component field. 

As you type the name, the corresponding component is highlighted in the 
Component Name list.

4 Click Ok.

If the component has only one dropsite, has no link attributes, and is a 
direct sub-component of EM, the component and all its required sub-
components are automatically added to the component layout tree. To 
display this, the tool places a dropsite node, represented by a dropsite 
icon, at the root of the tree. The component is played as the first branch 
in the component layout tree.

If you wish to cancel the operation, click Cancel. You return to the Nodal 
Provisioning Template Editor window.
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Adding the first non-top level component (not a direct sub-
component of EM)

Use this procedure to add a non-top level component. 

Procedure steps
1 From the Edit menu in the Nodal Provisioning Template Editor window, 

select Add Component.

If you have not yet selected the CDL version for the template being 
created, the Choose CDL Version dialog box opens. Proceed to step 2.

If you have already selected a CDL version, the Add Component dialog 
box opens. Proceed to step 3.

2 In the Choose CDL Version dialog box, select the CDL version for the 
template being created, and click Ok.

The Add Component dialog box opens containing a list of all the 
component that can be created on the device.

3 Choose the component that you want to add by typing the component 
name in the Choose a component field. 

As you type the name, the corresponding component is highlighted in the 
Component Name list.

4 Click Ok.

If the component is not a direct sub-component of EM, and the 
component has no link attributes, the Select Dropsite dialog box opens. 
You need to select a parent dropsite. See “Adding a parent dropsite” 
(page 289).

If the component is not a direct sub-component of EM, and the 
component has link attributes, the Select Dropsite dialog box opens. You 
need to select either a link or parent dropsite. See “Adding or removing a 
dropsite” (page 287).
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Adding additional components to EM
Use this procedure to add additional component to the root, EM.

Procedure steps
1 From the Edit menu in the Nodal Provisioning Template Editor window, 

select Add Component.

The Add Component dialog box opens containing a list of components 
that you can add.

2 Choose the component that you want to add by typing the component 
name in the Choose a component field. 

As you type the name, the corresponding component is highlighted in the 
Component Name list.

3 Click Ok.

If you are adding a new component at the root level of the template, and 
the component is a direct subcomponent of EM, the Component 
Designation dialog box opens. For additional information, see “Selecting 
the component designation” (page 295).

If the component requires a parent, the Component Parent Designation 
dialog box opens. See “Selecting the component parent designation” 
(page 293).
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Adding sub-components to a dropsite or component node
Use this procedure to add a sub-component to a dropsite or component node.

The Add Sub-component command is enabled only when you select a 
component that can have sub-components or parent-type dropsite node.

You use the Add Component dialog box to add a sub-component to a dropsite. 
You can only add a sub-component to a dropsite that is a parent-type dropsite.

Procedure steps
1 In the Nodal Provisioning Template Editor window, select the 

Component Layout tab.

2 In the component layout tree, select the component or dropsite to which 
you want to add a sub-component.

3 Complete one of the following steps:

• In the Nodal Provisioning Template Editor window, select Edit -> 
Add Sub-component, or 

• right click and select Add Sub-component.
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The Add Component dialog box opens and displays a list of sub-
components that can be added to the selected component.

4 Choose the sub-component that you want to add by typing the sub-
component’s name in the Choose a component field. 

As you type the name, the corresponding sub-component is highlighted 
in the Component Name list.

5  Click OK

The component and all of its required sub-components are added to the 
component layout tree. 
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Adding Linked Components
Use this procedure to add a linked component to a dropsite component, or to 
another component in the component layout tree.

The Add Linked Component command is only enabled if it is a valid action 
for the selected component.

You use the Add Linked Component dialog box to add a linked component.

Note 1:  The value of the link attribute between two components can be 
added in either the Component Layout or Form Layout tab, but not in 
both.

Note 2:  For any component that can serve as the linked destination of 
multiple components, the links must be added at the source components.

Procedure steps
1 In the template editor main window, select the Component Layout tab.

2 In the component layout tree, select the component to which you want to 
add a linked component.

3 Complete one of the following steps:

• In the Nodal Provisioning Template Editor window, select Edit -> 
Add Linked Component, or 

• Right-click on the component and select Add Linked Component 
from the pop-up menu.
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The Add Linked Component dialog box opens.

 In the From panel, the Component field is populated with the component 
that is selected in the component layout tree. If no component is selected, 
the first component from the tree that has a link attribute is selected.

The Attribute list lets you select the link attribute to which to link the new 
linked component.

4 If you want to link to an attribute other than the one shown in the Attribute 
list, from the drop down list, select the link attribute that you want the new 
component to link to.

5 In the To panel, select one of the following options:

• New Component if you want to link the currently selected 
component and attribute (or dropsite) to a new component.
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• Existing Component if you want to link the currently selected 
component and attribute to a component that already exists in the 
template.

6 In the Choose Component panel, select the linked component that you 
want to link to by typing the linked component’s name in the Choose a 
component field or choose a component under Component Name list.

As you type the name, the corresponding linked component’s name is 
highlighted in the Component Name list. The Component Names list 
contains the names of all the components that can link to the selected 
component or attribute.

7  Click OK.

If you have selected the New Component option, and the component is 
found directly under EM, the component is added to the component layout 
tree.

 If the linked component is not a root-level component, that is, it needs a 
parent, the Component Parent Designation dialog box opens. You will 
need to resolve the parent path for it. See “Selecting the component 
parent designation” (page 293).

If you have selected the Existing Component option, the selected 
component is linked to a component that already exists in the template.

If you wish to cancel the operation, click Cancel to close the Add Linked 
Component dialog box and return to the Nodal Provisioning Template 
Editor window.
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Removing components from the Component Layout tree
Use this procedure to remove top level components, linked components, or 
sub-components from the component layout tree.

Procedure steps
1 In the Nodal Provisioning Template Editor window, click on the 

Component Layout tab. 

2 Navigate the Component Layout tree to the item you want to remove and 
select it.

3 Select one of the following steps:

• right-click and select Remove Component from the pop-up menu.

• in the menu bar of the Nodal Provisioning Template Editor window, 
select Edit -> Remove Component.

The selected item and all its sub-components are removed from the 
component layout tree. In the case of a linked item, only the link is deleted. 
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Adding or removing a dropsite 
A dropsite is the component location where the service template can be 
dropped in the component hierarchy in the Nodal Provisioning window.When 
a component is not a direct sub-component of EM, you need to pick a 
dropsite.

Only one dropsite node is allowed for the template because the template must 
be connected to a single component from the template. However, a dropsite 
node can contain several components because it is possible to drop the 
template in several places. 

There are two types of dropsites:

— link dropsite
A link dropsite is a component that has a link attribute. When a 
template is dropped on a link dropsite component, its link attributes 
are connected to the corresponding link attributes for the linked 
components in the template.A link-type dropsite is needed if you are 
adding a component that is to be linked to an existing component. 
The existing component is the location where the template is 
dropped when using Nodal Provisioning. The new component is 
created with its necessary parents, and is then linked to the existing 
component. The link is bi-directional. That is, both components 
know which component their link attribute is connected to. 

— parent dropsite
A parent dropsite is a component that will become the parent of one 
or more components in the template. A parent-type dropsite is need 
if you are adding a component that is to be created as a sub-
component of a component that already exists on the device. 

When a template is dropped on an existing parent component, the 
components in the template are created as subcomponents to the 
parent component.

You can select a dropsite by using the Select Dropsite dialog box. The Select 
Dropsite dialog box opens when you select Add Component from the Edit 
menu, and you need to create a dropsite for the new component. 
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For an illustration of the Select Dropsite after you add the AtmIf 
(Atminterfarce), see the figure “Select Dropsite dialog box with Parent 
dropsite type selected” (page 288).

Figure 21
Select Dropsite dialog box with Parent dropsite type selected

You select the dropsite by using the Select Dropsite dialog box. Depending 
on the component, the Parent, or both Parent and Link dropsite options are 
enabled.

• If the component has link attributes, both the link and parent dropsite 
options are enabled.

• If the component has no link attributes only the Parent dropsite option is 
enabled.
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Adding a parent dropsite
Use this procedure to add a parent-type dropsite. A parent drop-site is needed 
if you are adding a component that is to be created as a sub-component of a 
component that already exists on the device. The existing component is where 
this template is applied when using Nodal Provisioning. 

Prerequisites
This procedure requires that the following conditions exist. 

• You have added a component and that component needs a dropsite.

• The Select Dropsite dialog box is open.

Procedure steps
1 To select the parent-type dropsite, In the Dropsite Type area, of the 

Select Dropsite dialog box, select the Parent option.

The fields in the Link Attribute pane are disabled. The Available 
Dropsites list is populated with all the components that can be parents of 
the component that you are currently adding.

2 In the Available Dropsites list, highlight one or more of the components 
in the list. The list contains all the components that can be parents of the 
component that you are currently adding.

Note:  Only select more that one parent dropsite if they all can have the 
same type of sub-component.

3 Select Add to move the selected components from the Available 
Dropsites list to the Chosen Dropsites list.

If you want to add all the available dropsites from the Available Dropsites 
list to the Chosen Dropsites list, click Add All.

If you want to remove one or more components from the Chosen 
Dropsites list to the Available Dropsites list, select the component(s) 
and click Remove.

If you want to remove all the components in the Chosen Dropsites list to 
the Available Dropsites list, click Remove All.

The components in the Chosen Dropsites list are the components that 
the templates can be dropped on when using Nodal Provisioning.

4 Click OK.
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The Select Dropsite dialog box closes and you return to the Nodal 
Provisioning Template Editor window. A dropsite node is added to the 
component layout tree as the root node. The dropsite component is 
distinguished by a “drop” icon to distinguish it as a dropsite node. A 
component node representing the new component is added to the 
component layout under the dropsite node.
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Adding a link dropsite
Use this procedure to add a link-type dropsite. A link-type dropsite is needed 
if you are adding a component that is to be linked to an existing component. 

Procedure steps
1 In the Dropsite Type area, of the Select Dropsite dialog box, select the 

Link option.

The fields in the Link Attribute pane are enabled. The Link Attribute 
Name list is populated with every component that has a link attribute. 

2 In the Choose a link attribute field, type the name of a link attribute.

As you type, the link attribute that most closely matches what you have 
typed is highlighted in the Link Attribute Name list. The Link Attribute 
Name list contains every link attribute that can link to the component that 
you are currently adding. 

3 Click Select to select the link attributed that is highlighted in the Link 
Attribute Name list.

4 In the Available Dropsites list, highlight one or more of the components 
in the list. The list contains all the components that can be parents of the 
component that you are currently adding.

Note:  Only select more that one parent dropsite if they all can have the 
same type of sub-component.

5 Select Add to move the selected components from the Available 
Dropsites list to the Chosen Dropsites list.

If you want to add all the available dropsites from the Available Dropsites 
list to the Chosen Dropsites list, click Add All.

If you want to remove one or more components from the Chosen 
Dropsites list to the Available Dropsites list, select the component(s) 
and click Remove.

If you want to remove all the components in the Chosen Dropsites list to 
the Available Dropsites list, click Remove All.

The components in the Chosen Dropsites list are the components that 
the templates can be dropped on when using Nodal Provisioning.

6 Click OK

The link dropsite node is added to the Component Layout tab as the root 
node. It is labeled with a drop icon to distinguish it a dropsite node. 
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Removing a dropsite
Use this procedure to remove a dropsite from the template.

Procedure steps
1 In the Nodal Provisioning Template Editor window, in the component 

layout tree, click on the dropsite node. 

The heading at the lower part of the Component Layout tab is labelled 
Dropsite Details.

If the dropsite is a parent-type dropsite, the list of parents for the top level 
component will appear in either the Available Dropsites or Chosen 
Dropsites list.

If the dropsite is a link-type dropsite, the list of components that have a 
link attribute that can link to the top-level component is in the Available 
Dropsites list

2 From the Chosen Dropsites list, select the dropsite or dropsites that you 
want to remove.

3 Click Remove.

4 Save the template.

When you reopen the template, the selected dropsite is removed from the 
component layout tree.
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Selecting the component parent designation 
Use this procedure to create a parent component immediately, or to find the 
parent component at runtime when you add a linked component or a 
component that is not a sub-component of the root EM.

Component Parent Designation dialog box
The Component Parent Designation dialog box opens when you add a 
component that is not a sub-component of the root, EM or if you add a linked 
component. 

For an illustration of the Component Parent Designation dialog box, see the 
figure “Component Parent Designation dialog box” (page 293).

Figure 22
Component Parent Designation dialog box

Procedure steps
1 In the Component Parent Designation dialog box, select one of the 

following options:

• To create a parent for a new component, select the Create Parent 
Now option. The adjacent parent field is enabled. You can select from 
a list of one or more paths of parents up to EM. 

• To search for available parents on the device at runtime, select the 
Find Parent at Runtime option. The adjacent field is enabled and 
contains a dropdown list of one or more search strings of parents up 
to EM. Select the search string to the component that is to be a 
parent of the component that is created by the template. This search 
string is applied to existing components on the device at runtime.
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• To search for this component of this type on the device at runtime, 
select the Find Component at Runtime option. The adjacent field is 
enabled and contains a drop down list of one or more search strings 
of this component and its possible parents up to EM. Select the 
search string to the type of component that you want to search for at 
runtime. This search string is applied to existing components on the 
device at runtime.

2 Click Ok.

If you selected the Create Parent Now option and the parent path, Ok 
creates the selected parent components as branches in the component 
layout tree.

If you selected the Find Parent at Runtime option and the search string 
of parents, an instance list node is added as the root node, and is 
identified as an instance icon. The component is added as a branch from 
the Instance List node in the component layout tree. You can have more 
than one instance list per template. 

If you selected the Find Component at Runtime option, the component 
is not created by the template but is added as an instance list. An instance 
list node is added to the template to represent the type of component that 
you want to search for at runtime. It is identified by an instance icon. 
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Selecting the component designation
Use this procedure to find the component designation immediately or at 
runtime when you add a new component to the root.

Component Designation dialog box
The Component Designation dialog box opens when you add a new 
component at the root level of the template. That is, the new component is a 
direct subcomponent of EM. The Component Designation dialog box gives 
you the choice to create the component, or to find it at runtime.

For an illustration of the Component Designation dialog box, see the figure 
“Component Designation dialog box with Create Component selected” 
(page 295).

Figure 23
Component Designation dialog box with Create Component selected

Procedure steps
1 In the Component Designation dialog box, select one of the following 

options:

• To create the new component, select the Create Component 
option. 
The adjacent field contains only the component that you are adding, 
in other words, the component that you selected in the Add 
Component dialog box when adding a component. See “Adding 
components” (page 276). You do not have to choose anything in this 
field.

• To search for the component on the device at runtime, select the 
Find Component at Runtime option. The component is not created 
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by this template but is added as an instance list. The adjacent field is 
enabled. It contains the search string of the component you are 
adding. You do not need to choose anything in this field.

2 Click Ok.

If you selected Create Component option, Ok creates the selected 
component.

If you selected the Find Component at Runtime option, an instance list 
node is added to the template that represents the type of component that 
you want to search for at runtime. The search string is applied to existing 
components on the switch at runtime.

To cancel the operation, select Cancel. You return to the Nodal 
Provisioning Template Editor window.

To access the on-line documentation, click Help.
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Removing links
Use this procedure to remove a link from a currently selected component. 

Procedure steps
1 In the Nodal Provisioning Template Editor window, click on the 

Component Layout tab. 

2 In the component layout tree, navigate to the linked component that you 
want to remove and select it.

3 Complete one of the following steps:

• click the mouse menu button and select Remove Link from the pop-
up menu

• in the menu bar of the template editor window, select Edit -> Remove 
Link.

The selected link is removed. The components remain.
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Adding or removing attributes
Use this procedure to add to or remove attributes from a selected component 
in the component layout tree.

Procedure steps
1 In the Nodal Provisioning Template Editor window, click on the 

Component Layout tab. 

2 Complete one of the following steps:

• in the component layout tree navigate to the component whose 
attributes you want to add to or remove and select it

• in the Component Details section, select the component from the 
Components drop down list.

3 To add an attribute, select the attribute in the Available attributes list and 
click Add to move the attribute to the Included in Template list.

To remove an attribute, select the attribute in the Included in Template 
list and click Remove to move the attribute to the Available attributes list.

4 Save the template. See the section “Saving service template files” 
(page 312).
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Modifying attribute details

Purpose
Use this procedure to modify the attributes of the service template.

Procedure
1 In the Nodal Provisioning Template Editor window, click on the Form 

Layout tab. 

2 Select the attribute that you want to modify from the form layout tree:

• Display in Form value,
To modify the Display in Form value, select Display in Form check 
box.

If Display in Form is not checked, you will not see the attribute displayed 
in the service template form. Display in Form is normally left unchecked 
only if there is an override value for a specific attribute.

• Value field
To modify the value, either select the desired value from the list that 
appears when you select Value, or edit the selection to be the value 
that you want. You have the following choices:
-override
-default
-gets value from
-user selected
When you change Value, it is the override value for the Attribute.

• Label field
To modify the Label, enter a new value in the Label field. Verify that 
the Display in Form check box is checked. This ensures that the new 
label is seen in the service creation form.

• Initial Value
To modify the Initial Value, change the selected value in the widget 
that appears if this field is enabled.

• Mandatory check box
To modify the Mandatory check box, click on it. A checked box 
means that this attribute is mandatory and must be filled in before a 
service creation form is valid. If left unchecked, the service creation 
form allows users to proceed without filling in a value for this attribute.
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• Editable check box
To modify the Editable check box, click on it. A checked box means 
that this attribute’s values can be edited. Mandatory is ignored if 
Editable is unchecked.

3 Save the changes. See the section “Saving service template files” 
(page 312).
241-6001-610   14.3RSUP   



Chapter 11 Nodal Provisioning Template Editor   301
Form Layout procedures overview
The following procedures apply to the form layout tab in the Nodal 
Provisioning Template Editor window. You can add and remove tabs and 
groups, and show and hide components from the form layout tree.

A tab is a collection of groups that you define. The collection is shown on the 
service template as a tab with a name that you specify.

A group is a collection of components that you define. The collection is 
shown on the service template as a bordered panel. You can specify a title for 
the panel.

See the following sections for additional information:

• “Reorganizing tabs or groups” (page 302)

• “Renaming tabs or groups” (page 303)

• “Adding tabs to the form layout tree” (page 304)

• “Deleting tabs from the form layout tree” (page 305)

• “Adding Groups to the form layout tree” (page 306)

• “Deleting Groups from the form layout tree” (page 308)

• “Hiding a component in the form layout tree” (page 309)

• “Removing a component from the form layout tree” (page 311)

• “Showing components in the form layout tree” (page 310)
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Reorganizing tabs or groups

Purpose
Use this procedure to move a tab or group on the Form Layout tree.

Procedure
1 In the Form Layout tree, select the Tab or Group that you want to move.

The area below the tree shows the name of the selected tab or group and 
its details.

2 To move a tab or group to a new location in the form, use the drop down 
lists in the Location section of the Details area.

To move a tab, in the Location section, select a new position from the 
available positions listed in the drop down list. The tab moves to the 
selected position.

You can move a selected group to a new tab location and a new position. 
Select the desired tab location from the Tab drop down list. Select the 
desired position under the Tab from the Position drop down list.
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Renaming tabs or groups

Purpose
Use this procedure to edit the name of a tab or group.

Procedure
1 In the Form Layout tree, select the Tab or Group that you want to 

rename.

If you select a tab, the name of the tab appears in the Tab Name field of 
the Details area.

If you select a group, the name of the group appears in the Group Name 
field of the Details area.

2 Edit the name in the text field.

The new tab or group name appears in the Form Layout tree.
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Adding tabs to the form layout tree

Purpose
Use this procedure to add a new tab to the form layout tree.

Procedure
1 Select the Form Layout tab.

2 Complete one of the following steps:

• click the mouse menu button on Main Dialog Window node in the 
Form Layout tree and select Add tab from the pop-up menu

• In the menu bar, select Edit -> Add tab.

The new tab appears as the last tab in the form layout tree. It has the 
default name of Tab<n>. You can edit the default name to any new string.
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Deleting tabs from the form layout tree

Purpose
Use this procedure to delete a tab from the form layout tree.

Procedure
1 Select the Form Layout tab.

2 In the Form Layout tab, select the tab that you want to remove from the 
form layout tree.

Note:  You can not remove tabs that have subcomponents.

3 Complete one of the following steps:

• click the mouse menu button on the tab and select Delete Tab from 
the pop-up menu, or 

• In the menu bar, select Edit -> Delete Tab 

The tab is deleted from the form layout tree.
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Adding Groups to the form layout tree

Purpose
Use this procedure to add a Group to a tab in the form layout tree.

A Group shows a grouping of components that should be displayed together 
under a tab in the service creation form. A Group can only be added to tabs 
in the form layout tree.

Procedure
1 Select the Form Layout tab.

2 Select the tab to which you want to add a group.

3 Complete one of the following steps:

• click the mouse menu button and select Add Group from the pop-up 
menu, or

• from the menu bar, select Edit -> Add Group.

The new group appears as the last group in the tab. It has the default 
name of Group<n>. You can edit the default name to any new string.
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The figure below shows the addition of a new Group1. The Group Details 
panel shows the newly added Group1.
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Deleting Groups from the form layout tree

Purpose
Use this procedure to remove a group from a tab in the form layout tree.

Procedure
1 Select the Form Layout tab.

2 Select the group that you want to delete.

Note:  .You can not delete a group that has sub-components. The Delete 
Group menu item is disabled.

3 Complete one of the following steps:

• right-click and select Delete Group from the pop-up menu, or

• from the menu bar, select Edit -> Delete Group.

The selected group is removed from the form layout tree.
241-6001-610   14.3RSUP   



Chapter 11 Nodal Provisioning Template Editor   309
Hiding a component in the form layout tree

Purpose
Use this procedure to hide a selected component in the form layout tree.

Note: The Hide Component menu item is disabled for components 
whose key needs to be filled in at run-time.

Procedure
1 Select the Form Layout tab.

2 In the form layout tree, navigate to the component that you want to hide 
and select it.

3 Complete one of the following steps:

• right-click and select Hide Component from the pop-up menu

• from the menu bar, select Edit -> Hide Component

The component is greyed out in the form layout tree. The value of key 
display and attribute display are set to false for each of the component’s 
attributes and the instance value will not display. However, the component 
will still be in the template, and any values that were set for its attributes 
are applied when the component is created.
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Showing components in the form layout tree

Purpose
Use this procedure to display hidden components in the form layout tree.

Procedure
1 Select the Form Layout tab.

2 Select the hidden component that you want to display.

3 Complete one of the following steps:

• in the menu bar, select Edit -> Show Component, or 

• right-click on the hidden component and select Show Component 
from the pop-up menu.

The selected component becomes visible in the form layout tree. Display 
in form is set to true for each of the component’s attributes that has a non-
default value and the instance value is displayed.
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Removing a component from the form layout tree
To remove a component from the form layout tree, you need to remove it from 
the component layout tree. When you remove a component from the 
component layout tree, the change is reflected in the form layout tree. 
Removing a component has the following impact on the groups and tabs in 
the form layout tree:

• if the tab and groups have been automatically generated, and if the group 
is empty, the tab and group are removed

• if the tab and groups have been automatically generated, and if the tab 
contains multiple groups, only the empty groups are removed

• if you have created the tab, or changed the name of the automatically 
created tab, the tab and groups are not removed

For the procedure to remove a component from the Component layout tree, 
see “Removing components from the Component Layout tree” (page 286). 
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Saving service template files 
The Save dialog box opens when you select Save As to save a service 
template file for the first time, or if you select Save and you have not yet saved 
the file. The Save dialog box lets you add folders, remove folders, and rename 
folders. You can also remove and rename files. You can only remove and 
rename files and folders if you have file permissions. These permissions are 
based on the userid of the account from where the editor was launched.

For additional information on saving service template files, see the following 
sections:

• “Saving a service template file for the first time” (page 313)

• “Saving a service template file after you have modified it” (page 316)
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Saving a service template file for the first time

Purpose
Use this procedure after you create a new service template file and you are 
saving it for the first time.

Note 1:  You can write to /opt/MagellanNMS/cfg/... but you cannot 
overwrite the files that have been installed by Nortel Networks.

Note 2:  You cannot save a template with a name that is the same as the 
typeId of any component.

Procedure
1 In the menu bar of the Nodal Provisioning Template Editor window, 

select File -> Save As.

A Save file browser dialog box opens. The dialog box opens to the service 
directory and category subdirectory.

Note:  If you have permissions, you can add folders, remove folders, 
rename folders, and remove files from the Save dialog box. Permissions 
are based on the userid of the account from where the template editor 
was launched.
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If you have not completed all the fields in the Template Identification 
panel, an error dialog box opens indicating the missing template 
identification details. Click OK and enter the missing information and click 
Save As again.

2 Do one of the following:

• To replace or rename an existing file, select the service category 
folder and select the file that you want. You can only replace or 
rename files for which you have write permissions.

• To save a new template file in an existing service category folder, 
select the service category folder that you want, and in the File Name 
field, enter a new file name.

• To save a new template file in a new folder, click the new folder icon, 
enter a name for the new folder, and in the File Name field, enter a 
new file name.

3 In the Save dialog box, select Save.
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The Save action generates a service template file in xml formal in the 
selected directory and with the specified name. If you try to save another 
file with the same name, a warning dialog box opens explaining that the 
action is not allowed and why it is not allowed.
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Saving a service template file after you have modified it

Purpose
Use this procedure to save a service template after you have already saved the 
service template file at least once.

Note: You can write to /opt/MagellanNMS/cfg/... but you cannot 
overwrite the files that have been installed by Nortel Networks.

Procedure
1 In the Nodal Provisioning Template Editor window, edit the contents.

2 In the menu bar of the template editor window, select File -> Save.

If you are modifying a.st file that was shipped by Nortel Networks with the 
product, or if it is a read-only file, you will be warned that you cannot 
overwrite the file. You can then select Edit -> Save As to save the file with 
a new name.

If you try to save the file with a typeId as a name, a dialog box opens that 
explains that this action is not allowed and why.

If the file is not read-only, clicking Save generates a service template file 
in XML format with the same filename that was used to open the file.
241-6001-610   14.3RSUP   



Chapter 11 Nodal Provisioning Template Editor   317
Exiting Nodal Provisioning Template Editor
1 From the File menu, select Exit.

The Nodal Provisioning Template Editor window closes. 

If you have not yet saved your changes, you are prompted to save your 
changes. See “Saving service template files” (page 312).
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Updating the service template palette in Nodal Provisioning 

Purpose
Use this procedure to update the template palette in the Nodal Provisioning 
window to include any newly created or edited templates. 

Procedure
1 Complete one of the following steps:

• In the menu bar of the Nodal Provisioning window, select View -> 
Reload Templates, or 

• In the toolbar of the Nodal Provisioning window, click the reload 
template icon.
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Version checking tool overview
The version checking tool is an off-line tool that identifies inconsistencies 
between the following, when the Passport software version is upgraded:

• service templates and component models

• service models and the hierarchy model

You should run the service template version checking tool any time that the 
version of the Passport software is changed since changes made in the new 
version may affect the current service model or templates.

The tool compares existing service model and template files with the 
hierarchy model and component model files. It reports when a service model 
or template refers to the following:

• removed attributes

• removed components

• obsoleted components

• obsoleted attributes.

When the tool finds inconsistencies, it outputs a line that specifies which files 
are affected. If no inconsistencies are found, the output line states that all files 
are ok.
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Starting the version checking tool

Purpose
Use this procedure to start the version checking tool to identify 
inconsistencies between service templates and component models and 
service models and hierarchy models when a Passport software version is 
upgraded.

Procedure
1 Type the following command line.

/opt/MagellanNMS/bin/anpstcheck [-h] [-st | -fst 
<service template filename>] -version <passport 
version> 

The tool outputs any inconsistencies that it has found between versions.

Command line options
-h is the option to display command usage.

-st is the option to check all service templates.

-fst <service template filename> is the option to only check a 
particular service template. The file name must include the path and 
extension.

-version <passport version> is the version of the Passport switch to 
check against.

Sample outputs
The following sections provide examples of the tool’s outputs when it finds 
the following:

• all files are consistent

• an error is found in the service template

• an error is found in the service model
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Version checking tool output when all files are consistent

All service model and template files are consistent 
with the hierarchy and component model files.

Version checking tool output when an error is found in the 
service template

An error was found in <filename>: Value of <attribute 
name> on component <component name> is not valid in 
this version of the Passport software.

Version checking tool output when an error is found in the 
service model

An error was found in <file name>: hierarchy involving 
component <component name>.

Default query output

<service model 1>
<service template 1>
<service template 2>

<service model 2>
no dependencies
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Report Generator 

For information on the Report Generator tool, see the following sections

• “Overview” (page 323)

• “Report Generator window” (page 324)

• “Filtering dialog boxes” (page 333)

• “Using the Report Generator tool” (page 337)

• “Manipulating component data overview” (page 343)

• “Creating and saving service data reports” (page 354)

• “Creating a component data report on a subset of component data” 
(page 356)

• “Retrieving saved Report Generator files” (page 358)

• “Example” (page 360)

• “Saving the report template” (page 368)

• “Loading a report template” (page 369)

• “Copying component data reports to a text editor” (page 370)

• “Exiting the Report Generator” (page 371)

Overview
Use the Report Generator to create, compare, and save custom reports on 
component data. Report Generator lets you do the following tasks:

• reorganize the component data 
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• filter the component data to create a report on a subset of the data

• export the data in a desired format

• save the data and filters to a file

You can use these reports to record changes to components and services and 
to compare the component data of services. 

Report Generator window
The Component Data panel of the Report Generator window is populated 
with a copy of the component that you selected in the hierarchy tree in the 
Nodal Provisioning main window, and includes the children that are visible 
in the expanded component hierarchy at the time the Report Generator is 
launched. The corresponding component data is displayed in the Component 
Data panel.

You can choose what data will display in the Component Data panel through 
your selections in the Component Selection panel.You can select and deselect 
components in the Component Selection panel. The tool retrieves the data for 
the selected components and displays the data in the Component Data panel. 
See the section “Manipulating component data overview” (page 343).

You can filter the component data to create a report on a subset of component 
data. See the sections “Filtering dialog boxes” (page 333) and “Creating a 
component data report on a subset of component data” (page 356).

You can save Report Generator files. You can retrieve the saved file using a 
text editor or spreadsheet. The saved file appears with the title at the head, 
followed by column headers, and the column data. The column data is 
separated by tabs with carriage returns separating the rows. See the section 
“Retrieving saved Report Generator files” (page 358)

You can also save report templates. These templates are saved with the 
extension .rtp. 

For an illustration of the relationship between the expanded component 
hierarchy in the Nodal Provisioning tool main window and the data contained 
in the Report Generator window, see“Report Generator window in relation to 
the selected component in the Nodal Provisioning window” (page 325).
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Figure 24
Report Generator window in relation to the selected component in the Nodal Provisioning 
window

Selected component in the 
Nodal Provisioning window

Data corresponding to the selected 
component and its visible children
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For a description of the parts of the Report Generator window, see the 
following sections:

• “Menu bar” (page 326)

• “Tool bar” (page 331)

• “Title field” (page 332)

• “Component Selection panel” (page 332)

• “Component Data panel” (page 332)

• “Status bar” (page 333)

For related procedures, see “Using the Report Generator tool” (page 337).

Menu bar
 See the following sections for information on the menu bar options:

• “File menu” (page 326)

• “Edit menu” (page 327)

• “View menu” (page 328)

• “Tools menu” (page 329)

• “Selected menu” (page 329)

• “Help menu” (page 331)

File menu
The table “File menu commands” (page 327) describes the commands.
241-6001-610   14.3RSUP   



Chapter 12 Report Generator   327
Edit menu
The table “Edit menu commands” (page 328) describes the menu commands.

Table 29
File menu commands

Menu command Description of menu command Related information

Save Overwrites the current saved file. If this is the first 
time that you have saved the file, the Save 
Report dialog box opens.

“Creating and saving 
service data reports” 
(page 354)

Save As Opens the Save Report dialog box to save a new 
file. Specify a location and filename. Report 
Generator adds the extension.rpt to the report 
file. At a later time, you can open the saved file 
using a text editor.

“Creating and saving 
service data reports” 
(page 354)

Save Report 
Template

Overwrites the current report template file if you 
have already saved. If you have not already 
saved, Save Report Template opens a Save 
Report Template dialog box that lets you save 
the report template as a new file. 

“Saving the report template” 
(page 368)

Save As Report 
Template

Opens a Save Report Template dialog box that 
lets you save the report template as a new file. 
When you save for the first time the tool 
automatically adds the extension .rtp to the 
report template file name.

“Saving the report template” 
(page 368)

Load Report 
Template

Opens a file selection dialog box. Locate the 
report template that you want to open and click 
OK.

“Loading a report template” 
(page 369)

Print Opens a Print dialog box.

Exit Exits the Report Generator. If you have made 
changes a dialog box opens prompting you to 
save your changes.

“Exiting the Report 
Generator” (page 371)
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View menu
The table “View menu commands” (page 329) describes the menu 
commands.

Table 30
Edit menu commands

Menu command Description of menu command Related information

Undo Lets you undo any previous actions, such as 
editing filters, deleting rows, loading templates, 
clearing filters, expanding and compressing 
components, back to the point when the Report 
Generator was launched. The Undo label in the 
edit menu changes to reflect the action being 
undone; for example, Undo Select Component.

“Undoing previous actions” 
(page 340)

Redo Lets you redo previously undone actions. If you 
undo actions and then perform a new action, the 
redo command is disabled. This indicates that 
the previously undone operations have been 
lost. The Redo label in the edit menu changes to 
reflect the action being undone; for example, 
Redo Select Component.

“Redoing actions” 
(page 340)

Copy Copies the selected component information from 
the Report Generator window to a clipboard. You 
can open a text editor and paste the copied 
information to a text editor. 

“Copying component data 
reports to a text editor” 
(page 370)

Delete Row(s) Deletes a selected row from the Component 
Data panel.

“Deleting rows in 
component data reports” 
(page 353)

Find Launches a component filter dialog box that lets 
you search for a subset of component 
information. This dialog box works in the same 
manner as the dialog box that opens when you 
select Add/Edit Filter in the Tools menu. 

“Filtering dialog boxes” 
(page 333)

“Creating a component data 
report on a subset of 
component data” 
(page 356)

Select All Select All selects all the visible components in 
the Component Data panel. 

“Selecting all components in 
the Component Data panel” 
(page 352)
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Tools menu
The table “Tools menu commands” (page 329) describes the commands.

Selected menu
The table “Selected menu commands” (page 330) describes the commands.

Note: The Search, Hide, and Hide Children commands are enabled only 
when you select a component in the component hierarchy that has too 
many instances to display. These components are represented by a folder. 

Table 31
View menu commands

Menu command Description of menu command Related information

Toolbar Displays or hides the tool bar “Displaying and hiding the 
tool bar” (page 341)

Statusbar Displays or hides the status bar “Displaying and hiding the 
status bar” (page 342)

Table 32
Tools menu commands

Menu command Description of menu command Related information

Add/Edit Filter Opens the Filter Component Data dialog box. “Creating a component data 
report on a subset of 
component data” 
(page 356)

Save Filter Opens a Save dialog box. Specify a filename 
and location to save the filter. When you save for 
the first time the tool automatically adds the 
extension .ftr to the filter file name.

“Creating a component data 
report on a subset of 
component data” 
(page 356)

Load Filter Load Filter opens a file selection dialog box to 
locate and open a saved filter.

Clear Filter Clears the current filter
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Table 33
Selected menu commands

Menu command Description of menu command Related information

Sort selected 
column

Provide the options to reorganizing component 
data in a selected column in the Component 
Data panel by ascending or descending order

“Sorting component data” 
(page 344)

Select 
Component

Selects or deselects the currently selected 
component in the component hierarchy.

“Selecting and deselecting 
components in the 
component hierarchy” 
(page 345)

Select All Selects a component and all of its visible 
children in the component hierarchy. The tool 
retrieves the component data and displays it in 
the Component Data panel.

“Selecting all components” 
(page 346)

Clear All Deselects a selected component and all of its 
visible children. The component data is removed 
from the Component Data panel.

“Clearing component data” 
(page 347)

Search Opens the Search dialog box which lets you 
search for component instances or a subset of 
component instances, for large components that 
exceed a pre-defined maximum number of 
instances. You can add a component to the 
component hierarchy. The data for the 
component is retrieved and displayed in the 
Component Data panel. 

“Searching for a component 
in a large instance set” 
(page 120)

Hide Removes the selected child of a folder from the 
component hierarchy in the Component 
Selection panel. 

“Hiding a child in a folder” 
(page 348)

Hide Children Removes all the children for a selected folder 
from the component hierarchy in the Component 
Selection panel.

“Hiding all children in a 
folder” (page 349)

Expand/Collapse Expands or collapses the selected component to 
show or hide its children.

“Expanding or collapsing a 
component and its children” 
(page 350)

Expand All Expands the selected component and all its 
children.

“Expanding a component 
and its children” (page 351)
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Help menu
The table “Help menu commands” (page 331) describe the commands.

Tool bar
The tool bar contains the following icons:

• save icon
The save icon saves the report. If you have already saved the file, 
selecting Save overwrites the current saved version. If this is the first time 
that you have saved the file, the Save dialog box opens. 

• exit icon
The exit icon closes the Report Generator tool.

• search icon
The search icon opens the Component Data dialog box. See “Filtering 
dialog boxes” (page 333).

• copy icon
The copy icon copies selected data to a clipboard.

• delete row(s) icon
The delete row(s) icon deletes a selected row of data in the Report 
Generator.

• undo icon
The undo icon lets you undo previous actions.

Note: The undo text tool tips change to reflect the action being undone; 
for example, Undo Select Component.

Table 34
Help menu commands

Menu command Description of menu command Related information

On Help Opens information on using help. “Help options” (page 32)

On Window Opens the online documentation for the Report 
Generator window.

“Accessing Help on the 
main window” (page 34)

About Report 
Generator

Provides the Report Generator version and 
copyright information.
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• redo icon
The redo icon lets you redo previous actions.

Note: The redo text tool tips change to reflect the action being undone; 
for example, Redo Select Component.

Title field
The Title field displays a default title. You can edit this field and enter your 
own title to be added to the saved file.

Component Selection panel
The component selection panel displays a copy of the component that you 
have selected in the Nodal Provisioning tool window, and any visible children 
at the time that you opened the Report Generator window. 

When you select a component in the Component Selection panel, you can 
perform the following actions by either selecting commands from the pop-up 
menu or from the Selected menu:

Note: the Search, Hide, and Hide Children commands are enabled only 
for folders.

• select a component

• select all components in the hierarchy tree

• clear all components in the hierarchy tree

• search for component instances

• hide a child

• hide all children

• expand or collapse a selected component 

• expand the selected component and all its children 

Component Data panel
The component data panel displays the data for the selected component and, 
if the component hierarchy is expanded, the data for the visible children. It 
provides a list of components, their attributes and their values. 
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The Component Data panel has a pop-up menu that contains the following 
commands:

• Copy copies the component data for the component that you have 
selected in the Component Data panel

• Delete deletes the rows that you have selected in the Component Data 
panel

• Select All selects all the contents of the Component Data panel.

• Sort provides the following options to sort the components:

— Ascending

— Descending

Status bar
The status bar is found at the bottom of the Report Generator window. It 
shows the filename and the date and time of the last save.

Filtering dialog boxes
A filtering dialog box opens when you select Add/Edit Filter from the Tools 
menu, or Find from the Edit menu, in the Report Generator window. 

All the data for the selected component and its visible children are displayed 
in the Report Generator window. The filtering dialog box lets you specify 
criteria to filter component data. You can specify one or more filters 
(compound filter) and subfilters.

You can save your filters to file and open the saved filter at a later time.

For an illustration of the filtering dialog box that opens when you select Add/
Edit Filter in the Tools menu see the figure “Filter dialog box for a simple 
filter” (page 334). This illustration shows the Filter Component Data dialog 
box for a simple filter. 
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Figure 25
Filter dialog box for a simple filter

For an illustration of the Filter Component Data dialog box for a compound 
filter, see “Filter dialog box for a compound filter” (page 334).

Figure 26
Filter dialog box for a compound filter
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You can further refine the subset of data by apply a sub filter. For an 
illustration of a compound filter with a subfilters, see “Compound filter 
showing a sub-filter” (page 335).

Figure 27
Compound filter showing a sub-filter

For a description of the parts of the Filter Component Data dialog box, see the 
following sections:

• “Fields” (page 336)

• “Find” (page 336)

• “Matching criteria buttons” (page 336)

• “Add Sub Filter command button” (page 336)
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• “Command buttons” (page 337)

Note: The Fields drop down list, Find field, matching criteria buttons and 
Add Subfilters buttons are repeated in each filter and sub filter.

For the procedures to display a subset of component data by using filters, see 
“Creating a component data report on a subset of component data” 
(page 356).

Fields
Use the Fields drop down list to select the field on which you want to search. 
You have the following options:

• All searches in all fields. When you open the Find Component Data 
dialog box, All is the default. 

• Component searches in the Component field.

• Name searches in the Name field

• Value searches in the Value field

Find
In the Find field enter a find string to match the subset of data that you want 
to find. 

Matching criteria buttons
The following check boxes let you customize your search:

• Match Case lets you select or deselect the option to search for an item 
with specific capitalization.

• Match Whole Word lets you match on a complete word. Enter a word 
in the Find field and select Match Whole Word.

Add Sub Filter command button
The Add Sub Filter command button lets you search for a subset of the data 
generated by the filter.
241-6001-610   14.3RSUP   



Chapter 12 Report Generator   337
Command buttons
The Find Component Data dialog box contains the following command 
buttons:

• OK completes the search. The Filter Component Data dialog box closes. 
The Report Generator window displays the results of the search.

• Apply apply the search. The Filter Component Data dialog box remains 
open. The Report Generator window displays the results of the search.

• Cancel cancels the search. The Filter Component Data dialog box closes 
and you return to the Report Generator window.

• Add Filter expands the Filter component data dialog box to add another 
filter to the data.

• Help accesses the online help information for the Filter Component Data 
dialog box.

Using the Report Generator tool 
See the following for procedures to use the Report Generator tool:

• “Starting Report Generator” (page 339)

• “Undoing and Redoing actions” (page 340)

• “Displaying and hiding the tool bar” (page 341)

• “Displaying and hiding the status bar” (page 342)

• “Sorting component data” (page 344)

• “Selecting and deselecting components in the component hierarchy” 
(page 345)

• “Selecting all components” (page 346)

• “Clearing component data” (page 347)

• “Hiding a child in a folder” (page 348)

• “Creating a component data report on a subset of component data” 
(page 356)

• “Retrieving saved Report Generator files” (page 358)

• “Saving the report template” (page 368)
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• “Loading a report template” (page 369)

• “Copying component data reports to a text editor” (page 370)

• “Exiting the Report Generator” (page 371)
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Starting Report Generator
Purpose
Use this procedure to start the Report Generator from the Nodal Provisioning 
window.

Prerequisites
The following conditions must exist:

• You have started Nodal Provisioning. See the section “Starting Nodal 
Provisioning” (page 39).

• You are connected to a Passport device. See the section “Connecting to a 
Passport device” (page 51).

Procedure
1 In the Nodal Provisioning window, select a valid component in the 

component hierarchy.

Note:  A folder is not a valid component.

2 Select one of the following steps:

• On the selected component, right-click and from the pop-up menu, 
select Generate Report.

• In the Nodal Provisioning window, select Selected -> Generate 
Report.

The Report Generator window opens.
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Undoing and Redoing actions
For related procedures, see the following sections:

• “Undoing previous actions” (page 340)

• “Redoing actions” (page 340)

Undoing previous actions
You can undo any previous actions, such as editing filters, deleting rows, 
loading templates, clearing filters, expanding and compressing components to 
the point that you started Report Generator. 

Note: The Undo label in the Edit menu, is dynamic, that is, it reflects the 
action being undone.

Procedure
1 From the Edit menu, select Undo... .

The previous action is undone. For example, if your last action was to 
select a component, the Undo command is labelled as Undo Selected 
Component.

Redoing actions
The Redo command lets you redo previously undone actions.

Note: The Redo label in the Edit menu, is dynamic, that is, it reflects the 
action being undone. If you undo actions and then perform a new action, 
the Redo command is disabled. This indicates that the previously undone 
actions have been lost.

Procedure
1 From the Edit menu, select Redo... .

The previous Undo action is undone. For example, if your last action was 
to Undo Selected Component, the Redo command is labelled as Redo 
reSelected Component.
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Displaying and hiding the tool bar

Procedure
1 From the View menu in Report Generator, select Toolbar.

If the tool bar is displayed, it is hidden.

If the tool bar is hidden, it becomes visible.
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Displaying and hiding the status bar

Procedure
1 From the View menu in Report Generator, select Statusbar.

If the status bar is displayed, it is hidden.

If the status bar is hidden, it becomes visible.
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Manipulating component data overview
See the following sections for procedures to adjust the data in the Component 
Data panel.

• “Sorting component data” (page 344)

• “Selecting and deselecting components in the component hierarchy” 
(page 345)

• “Selecting all components” (page 346)

• “Clearing component data” (page 347)

• “Hiding a child in a folder” (page 348)

• “Hiding all children in a folder” (page 349)

• “Expanding or collapsing a component and its children” (page 350)

• “Expanding a component and its children” (page 351)

• “Selecting all components in the Component Data panel” (page 352)

• “Deleting rows in component data reports” (page 353)

• “Copying component data reports to a text editor” (page 370)
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Sorting component data

Purpose
Use this procedure to reorganize component data for a selected column in 
ascending or descending order.

Procedure
1 In the Component Data panel, select the column that you want to sort. 

You can select the Component, Name or Value column.

2 If you want to sort the column data in ascending order, in the Selected 
menu, select Sort selected column -> Ascending 

If you want to sort the column data in descending order, in the Selected 
menu, select Sort selected column -> Descending.

The data is sorted in the columns in the specified manner.
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Selecting and deselecting components in the component 
hierarchy

You can select and deselect a component data in the component hierarchy. 

Procedure
1 Select the component in the component hierarchy

2  From the Selected menu, select Select Component.

The component is checked in the component hierarchy to indicate that it 
is selected.

Deselecting the component removes the check.
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Selecting all components 

Procedure
1 In the component hierarchy, select the component.

2 complete one of the following steps:

• From the Selected menu, select Select All.

• From the component’s pop-up menu, select Select All.

The component and all its visible children are selected in the component 
hierarchy and the component data for the component and its children are 
retrieved and displayed in the Component Data panel.
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Clearing component data

Purpose
Use this procedure to clear all component data from the Component Data 
panel.

Procedure
1 In the Component Selection panel, select the component that you want 

to clear.

2 Complete one of the following steps:

• From the Selected menu, select Clear All.

• right-click on the component and from the pop-up menu, select Clear 
All.

The selected component and its visible children are deselected in the 
Component Selection panel and the components’ data is cleared from the 
Component Data panel.
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Hiding a child in a folder

Purpose
Use this procedure to remove a selected child component from a folder in the 
component hierarchy in the Component Selection panel. 

Procedure
1 In the component hierarchy, select the folder containing the child 

component.that you want to hide.

2 From the Selected menu, select Hide.

The selected child component is removed from the component hierarchy 
in the Component Selection panel.
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Hiding all children in a folder

Purpose
Use this procedure to remove all child components of a folder from view in 
the component hierarchy in the Component Selection panel. 

Procedure
1 In the component hierarchy, select the folder containing the children that 

you want to hide.

2 From the Selected menu, select Hide Children.

All child components of the folder are removed from the component 
hierarchy in the Component Selection panel.
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Expanding or collapsing a component and its children

Procedure
1 Select the component that you want to expand or collapse.

2 Complete one of the following steps:

• From the Selected menu, select Expand/Collapse.

• Right-click on the component and from the pop-up menu, select 
Expand/Collapse.

The selected component and all its children are expanded or collapsed to 
show or hide its children in the component hierarchy.
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Expanding a component and its children

Procedure
1 Complete one of the following steps:

• From the Selected menu, select Expand All.

• Right-click on the component and from the pop-up menu, select 
Expand All.

The selected component and all its child components are expanded in the 
component hierarchy.
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Selecting all components in the Component Data panel

Purpose
You can select all the component data in the Component Data panel. You can 
then copy or delete the selected data.

Procedure
1 From the Edit menu, select Select All.

All the visible components in the Component Selection panel are 
selected and displayed in the Component Data panel.
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Deleting rows in component data reports 

Procedure
1 In the Component Data panel, select the row, or rows, that you want to 

delete.

2 From the Edit menu, select Delete Row(s) or use the delete icon in the 
toolbar. 

The selected row, or rows, of data is removed from the Component Data 
panel.
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Creating and saving service data reports

Purpose
Use this procedure to create and save a report on a selected component in the 
component hierarchy.

Procedure
1 In the Nodal Provisioning window, expand the component hierarchy to 

display the children that you want to report on.

2 Right-click on any valid component in the component hierarchy.

Note:  Folders are not valid components.

3 Complete one of the following steps:

• From the View menu, select Generate Report.

• right-click on the component and from the pop-up menu, select 
Generate Report.

The Report Generator window opens, and shows the component and its 
visible subcomponents and their attributes and values.

4 Change the file title, if desired.

5 Adjust the report, as desired:

If you wish to create a report on a subset of the data, in the Tools menu, 
select Add/Edit Filter. This opens the Filter Component Data dialog 
box. For the procedure to select a subset of the data, see “Creating a 
component data report on a subset of component data” (page 356).

6 From the File menu, select Save.

If you have not previously saved the file, the Save Report dialog box 
opens allowing you to select or specify the file name to save the report as. 

If you want to specify a different file name, or if you are saving for the first 
time, select Save As from the File menu. The Save Report dialog box 
opens. Specify a location and provide a filename for the report and then 
select Save to save the file to the specified location.

Select Cancel to return to the Report Generator window without saving.

The report is saved with the .rpt extension.

7 From the File menu, select Exit to close the Report Generator window.
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If you have changed the report data, a dialog box opens asking you if you 
want to save the changes.

Click Yes to save the changes.

Click Cancel to return to the Report Generator window.

8 Select Save As to open a Save Report dialog box.

9 Specify a location and enter a file name for the report.

10 Click Save.

The report is saved to the specified location with the extension .rpt.
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Creating a component data report on a subset of 
component data

Purpose
Use this procedure to filter component data to create a report on a subset of 
component data.

Procedure
1 Start the Report Generator. See “Starting Report Generator” 

(page 339).

2 To open the Filter Component Data dialog box, do one of the following:

• From the Tools menu of the Report Generator window, select Add/
Edit Filter.

• From the Edit menu of the Report Generator window, select Find.

The Filter Component Data dialog box opens.

3 From the Fields drop down list, select the field on which you wish to 
perform a search. You options are All, Component, Name, or Value.

Note:  The fields drop down list corresponds to the columns in the Report 
Generator spreadsheet.

4 In the Find field, enter a find string.

To restrict the search to match the capitalization in the find string, select 
Match Case.

To restrict the search to match the whole word, select Match Whole 
Word.

5 If this completes your search, click OK to close the Find Component 
Data dialog box. The data matching the search criteria appear in the 
Report Generator window.

Click Apply to apply the search without closing the Find Component 
Data dialog box. You can continue to add filters for your search.

If you want to cancel the search, click Cancel. This action closes the Find 
Component Data dialog box.

If you want to search for a subset of the component data, click Add 
Subfilter. The Filter Component Data dialog box expands to add 
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another filter panel labelled as Filter 2 sub-filter of Filter 1. Repeat steps 
3 to 5 for the subfilter.

If you want to add another filter Click Add Filter. This expands the Filter 
Component dialog box to add another filter, labelled as Filter 2. Repeat 
steps 3 to 5.
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Retrieving saved Report Generator files

Purpose
Use this procedure to retrieve Report Generator files using a text editor or 
spreadsheet.

Procedure
1 Open a text editor.

2 Select the file that you want to retrieve.

For an illustration of the saved file that is retrieved using a text editor, see 
“Saved Report Generator file” (page 359).
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Figure 28
Saved Report Generator file
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Example
The following example assumes that you wish to find the following subset of 
component data for the FrUni/1:

• all the dna data containing out in the data name

• all the Ca data containing bandwidth in the data name.

1  In Nodal Provisioning window, select FrUni/1.

2 Open the Report Generator. See see “Starting Report Generator” 
(page 339)
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3 In the Component Selection panel of the Report Generator window, 
select FrUni/1.

4 the Tools menu in the Report Generator window, select Add/Edit Filter.

5 In the Filter 1 area, do the following:
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a. In the Fields drop down list, select Component.

b. In the Find field, enter Dna

c. If desired, select a matching case.

The Report Generator window shows all the FrUni/1 Dna components.

6 In the Filter Component Data (Filter 1), select Add Sub Filter.

The Filter Component Data dialog box expands to add another filter 
panel (Filter 2 with subfilter of Filter 1).
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7 In the Filter 2 sub-filter of Filter 1 panel, do the following:

a. In the Fields drop down list, select Name

b. In the Find field, enter out

c. If desired, select a matching case.

The Component Data panel shows the FrUni/1 Dna components with the 
Name out.

8 Select Add Filter.

The Find Component Filter dialog box expands to show another Filter 
panel (Filter 3)
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9 In the Filter 3 panel, do the following:

a. in the Fields drop down list, select Component

b. in the Find field, Ca
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c. if desired, select Match Case.

The Component Data panel now shows the FrUni/1 Dna 
components with the name out and all the Ca components.
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10 In the Filter 3 section, select Add Sub Filter.

The Find Component Filter dialog box expands to show another Filter 
panel (Filter 4 Sub Filter of Filter 3)

11 In the panel, do the following:

a. in the Fields drop down list, select Value

b. in the Find field, 1000

c. if desired, select a Matching Case

The Component Data panel now shows the FrUni/1 Dna 
components with the name out and all the Ca components with the 
value 1000.
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Saving the report template

Procedure
1 If you have previously saved the report template, from the File menu, 

select Save Report Template.

If this is the first time that you save the report template, from the File 
menu, select Save As Report Template. A Save Report Template 
dialog box opens. Proceed to step 2.

2 In the save dialog box, select a location and specify a file name for the 
report template.

3 Click Save.

The report template is saved to the specified location with the file 
extension rtp.
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Loading a report template 

Purpose
Use this procedure to retrieve a saved report template.

Procedure
1 From the File menu, select Load Report Template.

A Load Report Template file browser dialog box opens.

2 Select the file that you want to retrieve.

3 Click OK.

The saved report template is retrieved.
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Copying component data reports to a text editor

Purpose
Use this procedure to copy some or all component data displayed in the 
Report Generator window to a text editor.

Procedure
1 Edit the service data report contained in the Report Generator window, 

as desired. 

2 In the Edit menu, of the Report Generator window, select Select All if 
you want to copy all the data contained in the report. 

If you only want to copy a subset of the data, select the rows that you want 
to copy.

3 In the Edit menu, select Copy.
The selected data are copied to a clipboard.

4 Open a text editor.

5 In the Edit menu, select Paste.

The selected component data appear in the text editor.
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Exiting the Report Generator

Procedure
1 In the Report Generator window, select File -> Exit.

The Report Generator window closes.
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Nodal Provisioning Log Viewer 

This section provides information on the Nodal Provisioning Log Viewer and 
how to use it. This section contains the following topics:

• “Log Viewer overview” (page 373)

• “Log Viewer window” (page 374)

• “Starting Log Viewer on a Preside MDM workstation” (page 379)

• “Starting Log Viewer on a client workstation” (page 380)

• “Viewing or hiding the time stamp and logging messages” (page 381)

• “Disabling logging options” (page 382)

• “Copying logging messages” (page 385)

• “Clearing logging messages” (page 386)

• “Saving logging messages” (page 387)

• “Exiting Log Viewer” (page 388)

Log Viewer overview
The Log Viewer window displays a real-time view of all log messages 
produced by Nodal Provisioning processes. Log Viewer supports the 
following types of logging:

• state

• error

• debug
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You can filter logging messages by disabling the error, state, or debug logging 
at source so that the Log Viewer does not receive the messages.

Log Viewer appends a time stamp that displays the event time.

Log Viewer window
The following sections describe the Log Viewer window:

• “Log Viewer menu bar” (page 375)

• “Tool bar” (page 378)

• “Messages panel” (page 378)

• “Status bar” (page 378)

For an illustration of the Log Viewer window, see the figure “Log Viewer 
window” (page 375).
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Figure 29
Log Viewer window

Log Viewer menu bar
The menu bar contains the following menus:

• “File menu” (page 375)

• “Logging menu” (page 376)

• “Edit menu” (page 376)

• “View menu” (page 377)

• “Help menu” (page 377)

File menu
See the table “File menu commands” (page 376) for a description of the 
commands.

menu bar

tool bar

messages area

status bar
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Logging menu
See the table “File menu commands” (page 376) for a description of the 
commands.

Edit menu
See the table “Edit menu commands” (page 376) for a description of the 
commands.

Table 35
File menu commands

Command Description Related information

Save Saves all the currently displayed log messages to 
file.

“Saving logging 
messages” (page 387)

Save As Opens a dialog box to specify a name for the 
message file, and saves the messages to a 
specified file.

“Saving logging 
messages” (page 387)

Exit Exits Log Viewer. “Exiting Log Viewer” 
(page 388)

Table 36
Logging menu command

Command Description Related information

Options Opens the Logging Options dialog box which lets 
you disable logging options at source.

“Disabling logging options” 
(page 382)

Table 37
Edit menu commands

Command Description Related information

Copy Copies selected text to a clipboard. “Copying logging 
messages” (page 385)

 (Sheet 1 of 2)
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View menu
The View menu provides toggled commands to view or hide the type of log 
messages that display in the messages panel. Although messages may be 
hidden, they are still generated. See the table “View menu commands” 
(page 377) for a description of the commands.

Help menu
The Help menu provides access to the online help for the Log Viewer 
window. See the table “Help menu command” (page 378) for a description of 
the commands.

Clear Clears all the logging messages and resets the 
log.

“Clearing logging 
messages” (page 386)

Select All Selects all the logging messages. “Copying logging 
messages” (page 385)

Table 38
View menu commands

Command Description Related information

Time stamp Displays or hides the time stamps for the 
messages that are generated.

“Viewing or hiding the time 
stamp and logging 
messages” (page 381)

State messages Displays or hides state logging messages. “Viewing or hiding the time 
stamp and logging 
messages” (page 381)

Error messages Displays or hides error logging messages. “Viewing or hiding the time 
stamp and logging 
messages” (page 381)

Debug messages Displays or hides debug messages. “Viewing or hiding the time 
stamp and logging 
messages” (page 381)

Table 37  (continued)
Edit menu commands

Command Description Related information

 (Sheet 2 of 2)
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Tool bar
The tool bar contains two icons:

• The Save icon opens the Save dialog box which lets you select a location 
and specify a file name to save the log messages.

• The Copy icon copies selected messages to a clipboard.

Messages panel
The Messages panel displays the log messages. The messages that appears in 
the messages panel depend on the type of log message that you select from 
the View menu.

Status bar
The status bar shows the error messages that are enabled and visible.

Table 39
Help menu command

Command Description Related information

Help on Help Provides general information on using Help. “Help options” (page 32)

Help on Window Accesses the online documentation for the Log 
Viewer window.

“Accessing Help on the 
main window” (page 34)

About Box Provides version and copyright information.
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Starting Log Viewer on a Preside MDM workstation

Purpose
Use the -Dlogview=true option from the command line to start Log Viewer 
on a Preside Multiservice Data Manager (MDM) workstation,.

Procedure
1 On a MDM workstation, type the following command:

/opt/MagellanNMS/bin/anpui -Dlogview=true
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Starting Log Viewer on a client workstation

Purpose
Use the -Dlogview=true option from the command line to start Log Viewer 
on a client workstation.

Procedure
1 On a Preside MDM workstation, type the following command:

/opt/MagellanNMS/bin/anpui -Dlogview=true
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Viewing or hiding the time stamp and logging messages 

Purpose
Use this procedure to view or hide the time stamp, and the type of logging 
messages that display in the messages panel of the Log Viewer window. 

Procedure
1 From the View menu select one or more of the following options:

• To display or hide the time stamp, select Time Stamp.

• To display or hide state messages, select State Messages.

• To display or hide error messages, select Error Messages.

• To display or hide debug messages, select Debug Messages.
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Disabling logging options 

Purpose
Use the Logging Options dialog box to specify the types of logging messages 
that you want to receive from Log Viewer.

• the types of logging options to enable or disable at source so that you will 
only receive the messages that you enable. Your choices are Error, State, 
and Debug.

• the types of logging options to save. Your choices are Error, State, and 
Debug.

• where to save the log messages

Note: By disabling the State and Debug logging, you increase the speed 
of the application.

Procedure
1 In the Logging menu in the Log Viewer window, select Options.

The Logging Options dialog box opens.

2 Select the types of logging messages you want to receive. Your options 
are Error, State, and Debug.
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3 If you wish to save your logging messages to a file, click Yes and proceed 
to step 4.

If you do not wish to save your logging messages to file, click No and 
proceed to step 8.

4 Select the type of log messages you wish to save to file. You choices are 
Error, State, and Debug. 

5 Complete one of the following steps:

• Type a file name in the File Name field and click OK to close the 
Logging Options dialog box.

• Click Browse to open a Save file browser dialog box and proceed to 
step 6.
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6 In the Save dialog box, select the location for your file, and specify a file 
name in the Enter file name field.

7 Click Save.

You return to the Logging Options window.

8 Click OK.

When you expand nodes in the component hierarchy in the Nodal 
Provisioning window, or drag templates onto nodes, the log file you 
specified appears in the location you specified. The log file contains the 
log messages that arrived since exiting the Logging Options dialog box. 
You will only receive messages of the type that you enabled.
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Copying logging messages

Purpose
Use this procedure to copy some or all the messages from the Log Viewer 
window to a clipboard. This information can then be pasted into a text editor.

Procedure
1 Complete one of the following steps:.

• In the messages area of the Log Viewer window, select the 
messages that you want to copy.

• To select all the information in the Log Viewer window, from the Edit 
menu, select Select All.

2 From the Edit menu, select Copy.

The logging messages are copied to a clipboard.
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Clearing logging messages

Purpose
Use this procedure to clear log messages from the Log Viewer window.

Procedure
1 From the Edit menu, select Clear.

1 The Log Viewer messages area is cleared of logging messages.
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Saving logging messages

Purpose
Use this procedure to save logging messages to a file.

Procedure
1 If you have already saved the messages to file, from the File menu, select 

Save.

If you are saving the logging messages for the first time, proceed to step 
2.

2 From the File menu, select Save As.

A Save dialog box opens.

3 Select a location and specify a file name for the logging options file.

4 Click Save.

The logging messages are saved to the specified file.
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Exiting Log Viewer

Purpose
Use this procedure to exit Log Viewer.

Procedure
1 From the File menu, select Exit.

The Log Viewer window closes and you return to the Nodal Provisioning 
window.
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Chapter 14
Embedded Nodal Provisioning

This section describes the Preside Multiservice Data Manager (MDM) 
Embedded Nodal Provisioning application and how to use it. It contains the 
following sections:

• “Overview” (page 389)

• “Embedded Nodal Provisioning interface” (page 393)

• “User logs” (page 416)

• “Using Embedded Nodal Provisioning” (page 416)

Overview
Embedded Nodal Provisioning provides a simple internal interface through 
which key elements of Nodal Provisioning are integrated into the Passport 
Shelf View so that you can perform component and service provisioning 
tasks. From Passport Shelf View, you can both surveil and configure a 
Passport device from a single shelf view.

Embedded Nodal Provisioning supports the following devices:

• Passport 6000

• Passport 7000

• Passport 15000

• Passport 20000
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Passport Shelf View is a diagnostic tool that lets you troubleshoot problems 
in real time. Therefore, provisioning tasks performed while in Passport Shelf 
View should focus on solving single, discrete problems that involve small 
changes to a small number of components in the current, active Passport view. 
For the effects of the provisioning tasks to be reflected in the Passport Shelf 
View, provisioning tasks are always performed on the current view, and are 
automatically activated when applied.

For a description of Passport Shelf View and how to use it, see 241-6001-011 
Preside MDM Fault Management User Guide.

You should use Nodal Provisioning if you wish to navigate and provision a 
large number of Passport components in a variety of Passport views. In this 
case, the performance of Nodal Provisioning is better than that of Embedded 
Nodal Provisioning since Nodal Provisioning uploads the entire Passport 
view file at startup instead of one component at a time as is the case with 
Embedded Nodal Provisioning. Thereafter, component access is faster. As 
well, Embedded Nodal Provisioning does not automatically retrieve possible 
values for link attributes available in Nodal Provisioning. In Embedded Nodal 
Provisioning, you need to search for possible link values. This may be slow, 
since the entire Passport view has not been loaded.

Embedded Nodal Provisioning provides launch points for Nodal Provisioning 
and the service provisioning tools. For additional information, on the service 
provisioning tools and Nodal Provisioning, see the following NTPs:

• 241-6001-600 Preside MDM Service Provisioning for ATM User Guide

• 241-6001-601 Preside MDM Service Provisioning for IP VPN Global 
Update User Guide

• 241-6001-602 Preside MDM Service Provisioning for CES SVC User 
Guide

• 241-6001-603 Preside MDM Service Provisioning for Frame Relay User 
Guide

• 241-6001-610 Preside MDM Nodal Provisioning User Guide

• 241-6001-611 Preside MDM Nodal and Service Provisioning Reference 
Guide
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The following sections describe the provisioning capabilities of Embedded 
Nodal Provisioning in greater detail:

• “Provisioning in Passport Shelf View” (page 391)

• “Simultaneous provisioning” (page 392)

Provisioning in Passport Shelf View
You can select a component in Passport Shelf View and perform the following 
provisioning actions:

• add, modify and delete subcomponents

• apply a service template form to link the component to a service or to 
provision service sub-components.

You can perform these same actions from the Embedded Nodal Provisioning 
interface. 

Embedded Nodal Provisioning uses the same component creation, 
component edit, and service creation forms as are used by Nodal 
Provisioning. For a description of these forms, see 241-6001-610 Preside 
MDM Nodal Provisioning User Guide.

For the effects of provisioning actions to be reflected in the client MDM 
application, provisioning is always performed on the current view and 
automatically activated when applied.

From the Embedded Nodal Provisioning interface, you can activate any 
number of discrete provisioning tasks, consisting of operations on any 
number of Passport components. 

Adding, modifying, and deleting subcomponents
You can add subcomponents from either Passport Shelf View or the 
Embedded Nodal Provisioning window. To add a subcomponent, you must 
first identify the parent component. Once you have selected the parent 
component, you need to select the type of subcomponent to create. 

You can also modify and delete components from Passport Shelf View and the 
Embedded Nodal Provisioning window.
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See the following sections for additional information: 

• “Adding a subcomponent from Passport Shelf View” (page 426)

• “Adding a subcomponent from the Embedded Nodal Provisioning 
window” (page 429)

• “Modifying a component from Passport Shelf View” (page 432)

• “Modifying a component from the Embedded Nodal Provisioning 
window” (page 433)

• “Deleting a component from the Passport Shelf View” (page 436)

• “Deleting a component from the Embedded Nodal Provisioning 
window” (page 437)

Applying a service template
You can apply a service template from either Passport Shelf View or the 
Embedded Nodal Provisioning window. To apply a service template, you 
need to first identify the component to which the service template is being 
applied. One the component is identified, you then need to identify the name 
of the template to apply to that component, 

See the following sections for additional information: 

• “Applying a service template in Passport Shelf View” (page 439)

• “Applying a service template from the Embedded Nodal Provisioning 
window” (page 441)

Simultaneous provisioning
Embedded Nodal Provisioning permits simultaneous provisioning tasks on a 
Passport device. Provisioning through Embedded Nodal Provisioning does 
not reserve the Passport provisioning session until you activate the task. 
Multiple users can initiate the provisioning and activation processes on-
switch, even if they have not secured the provisioning session on-switch. This 
capability is achieved by the queueing of provisioning requests. These 
requests are processed serially on a first-come-first-served basis. Automatic 
provisioning session retry ensures that you do not have to intervene to have 
your request processed and you can move on to the next provisioning task 
while your previous tasks, or tasks from another user, are being activated.
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The Embedded Nodal Provisioning session secures the on-switch Passport 
provisioning session when you activate a provisioning change. If the 
provisioning session is available when the request is issued, the activation 
proceeds. If the provisioning session is unavailable, the task periodically tries 
to obtain the provisioning session. You can configure the retry period in the 
Nodal Provisioning Server Administration tool. See 241-6001-303 Preside 
MDM Administrator Guide. 

You can cancel the activation of a provisioning task at any time while the 
automatic provisioning session retry is ongoing. 

Note: Embedded Nodal Provisioning does not notify you if the current 
view has changed between the time you start a provisioning task and the 
time you activate the provisioning task. It also does not identify or 
resolve conflicts caused by more than one person trying to initiate 
provisioning or activation processes on-switch at the same time. Such 
conflicts may occur when more than one person makes incompatible 
changes to the same Passport components. Conflict checking and 
identification is done through the Passport semantic checks, and you 
must manually resolve the conflict.

Embedded Nodal Provisioning interface
The Embedded Nodal Provisioning interface consists of a single window 
from which you can provision the Passport device viewed in Passport Shelf 
View. Each instance of the Passport Shelf View opens one instance of 
Embedded Nodal Provisioning for provisioning purposes.

Provisioning changes are organized into individual, tasks which can be 
activated. Each task can include any number of the following provisioning 
actions:

• create components 

• modify components

• delete components

• apply a service template

For an overview of Embedded Nodal Provisioning and its functionality, see 
“Overview” (page 389).
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For a description of the Embedded Nodal Provisioning interface, see the 
following sections:

• “Menu bar” (page 397)

• “Provisioning Tasks panel” (page 404)

• “Provisioning forms panel” (page 407)

• “Task Activation Queue panel” (page 415)

• “Status bar” (page 416)

• For a description of the user logs, see “User logs” (page 416)

For the procedures to use Embedded Nodal Provisioning, see the following 
sections:

• General procedures

— “Starting Embedded Nodal Provisioning” (page 419)

— “Authenticating to a device” (page 421)

— "Viewing on-line help" on page 422

— “Exiting Embedded Nodal Provisioning” (page 423)

• Provisioning procedures

— “Provisioning tasks overview” (page 424)

— “Adding a subcomponent from Passport Shelf View” (page 426)

— “Selecting the task in which to add or move an action” (page 456)

— “Adding a subcomponent from the Embedded Nodal Provisioning 
window” (page 429)

— “Modifying a component from Passport Shelf View” (page 432)

— “Modifying a component from the Embedded Nodal Provisioning 
window” (page 433)

— “Refreshing a component modification form” (page 435)

— “Deleting a component from the Passport Shelf View” (page 436)

— “Deleting a component from the Embedded Nodal Provisioning 
window” (page 437)
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— “Applying a service template in Passport Shelf View” (page 439)

— “Applying a service template from the Embedded Nodal 
Provisioning window” (page 441)

— “Linking a new service to a new port” (page 449)

• Organizing provisioning tasks and actions

— “Adding a new provisioning task” (page 454)

— “Changing the order of provisioning actions” (page 455)

— “Selecting the task in which to add or move an action” (page 456)

— “Adding a provisioning action” (page 458)

— “Renaming a provisioning task” (page 460)

— “Removing a provisioning action” (page 461)

— “Removing a provisioning task” (page 462)

— “Removing all provisioning tasks that are completed” (page 463)

— “Rearranging the order of tasks for activation” (page 464)

• Activating tasks

— “Activation scenarios” (page 465)

— “Activating a task” (page 470)

— “Activating a task when you have insufficient provisioning 
privileges” (page 471)

— “Setting the options for saving and activating provisioning changes” 
(page 473)

— “Saving and activating provisioning changes” (page 476)

— “Viewing the Task Activation Queue” (page 479)

— “Viewing the state of the provisioning session” (page 480)

— “Canceling the activation of a single provisioning task” (page 481)

— “Canceling the activation of more than one provisioning task” 
(page 482)

• Concurrent provisioning conflicts and error resolution
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— “Concurrent provisioning conflicts and resolution” (page 483)

— “Error messages” (page 484)

See also...

• “Repairing service creation errors” (page 188)

• “Resolving a restorePossible error condition” (page 190)

• “Resolving a journalDisabledReason error condition” (page 191)

For an illustration of the Embedded Nodal Provisioning interface, see the 
figure “Embedded Nodal Provisioning interface” (page 397).
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Figure 30
Embedded Nodal Provisioning interface

Menu bar
The Embedded Nodal Provisioning user interface has the following menus:

• “File menu” (page 398)

• “Edit menu” (page 398)

• “Task menu” (page 399)

• “Action menu” (page 401)

• “View menu” (page 402)
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• “Tools menu” (page 403)

• “Help menu” (page 404)

Each task and provisioning action in the task navigation tree, has a pop-up 
menu which contains commands that correspond to the commands contained 
in the Task and Action menus.

File menu
The table “File menu commands” (page 398) describes the menu commands.

Edit menu
The table “Edit menu commands” (page 398) describes the menu commands.

Table 40
File menu commands

Command Description Related information

Exit Exits the provisioning window. If you have not 
completed some tasks, a confirmation dialog box 
prompts for confirmation. If there is a task 
currently being activated on the Passport device, 
the Exit command is disabled.

“Exiting Embedded Nodal 
Provisioning” (page 423)

Table 41
Edit menu commands

Command Description Related information

Cut Cuts the selected text.

Copy Copies the selected text.

Paste Pastes the copied text.

Save/Activate 
Options...

Opens a dialog box to set the activation options 
for this window.

“Setting the options for 
saving and activating 
provisioning changes” 
(page 473)
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Task menu
The Task menu provides the commands to manipulate the tasks in the task 
navigation tree. The table “Task menu commands” (page 400) describes the 
menu commands.

The following commands also appear in the pop-up menu when you right-
click on a provisioning task in the task navigation tree:

• New Action... opens a dialog from which a new provisioning action can 
be added to the task. It is disabled if no task is selected.

• Remove Task removes the selected provisioning task from the 
Embedded Nodal Provisioning. It is disabled if no provisioning task is 
selected.

• Save/Activate Task activates the currently selected task and adds it to the 
Task Activation queue. It is disabled if no task is selected, or if the 
selected task is in retry or being activated.

• Cancel Activation cancels the activation of the selected task if it is in the 
retry state. The task returns to the open state and is removed from the 
Task Activation Queue. It is disabled if there is no task selected or if the 
selected task is not in the retry state.
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Table 42
Task menu commands

Command Description Related information

New Task Adds a new task to the provisioning task tree. “Adding a new provisioning 
task” (page 454)

Move Task Up Changes the order in which the tasks in the 
queue are activated. This menu item moves the 
selected provisioning task up in the queue above 
the preceding task. If the selected task is the first 
in the queue, it becomes the last.
This command is disabled under the following 
circumstances 

• if no provisioning task is selected

• if the selected task is not in the activation 
queue, or

• if the selected task is “In progress”

“Rearranging the order of 
tasks for activation” 
(page 464)

Move Task Down Changes the order in which the tasks in the 
queue are activated. This command moves the 
selected provisioning task down in the queue 
below the task that formerly followed it. If the 
selected task is the last in the queue, and the first 
task is not in activating or retry state, it becomes 
the first. Otherwise it stays in the last position. 
This command is disabled under the following 
circumstances:

• if no provisioning task is selected

• if the selected task is not in the activation 
queue, or

• if the selected task is “In progress”

“Rearranging the order of 
tasks for activation” 
(page 464)

Remove Task Removes the selected provisioning task from 
Embedded Nodal Provisioning. This command is 
disabled if you have not selected a task or if the 
task is in progress.

“Removing a provisioning 
task” (page 462)

Remove 
Completed Tasks

Removes all the tasks that have been 
successfully activated and are complete.

“Removing all provisioning 
tasks that are completed” 
(page 463)
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Action menu
The Action menu provides the commands to manipulate the actions in the 
task navigation tree. The table “Action menu commands” (page 402) 
describes the menu commands.

The following commands also appear in the pop-up menu when you right-
click on a provisioning action in the task navigation tree. They have the same 
effect as when you select the command from the Action menu.

• Move Action Up

• Move Action Down

• Move Action to Task...

• Remove Action

Save/Activate 
Task

Activates the currently selected tasks and adds it 
to the Task Activation Queue. This command is 
disabled under the following circumstances:

• if no task is selected

• if the selected task is in retry, or

• if the selected task is being activated

“Setting the options for 
saving and activating 
provisioning changes” 
(page 473)

“Saving and activating 
provisioning changes” 
(page 476)

Cancel Activation Cancels the activation of the selected task if it is 
in retry state or queue status. The task returns to 
the open state. This command is disabled when 
there is no task selected or if the selected task is 
not in the retry state.

“Canceling the activation of 
a single provisioning task” 
(page 481)

Cancel 
Activations

Opens a dialog box to cancel one or more 
activations that are in the retry state or queue 
status. This command is disabled if there are no 
activations in the retry state.

“Canceling the activation of 
more than one provisioning 
task” (page 482)

Table 42  (continued)
Task menu commands

Command Description Related information
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View menu
The table “External Tools menu commands” (page 403) describes the menu 
commands.

Table 43
Action menu commands

Command Description Related information

New Action... Opens a dialog box from which a new 
provisioning action can be added to the task. 
This command is disabled if you have not 
selected a task.

“Adding a provisioning 
action” (page 458)

Move Action Up Changes the order in which the provisioning 
actions in the task are applied. This command 
moves the selected provisioning action up so 
that it precedes the action that formally preceded 
it. If the selected action is the first in the task, if 
becomes the last. This command is disabled if 
no provisioning action is selected.

“Changing the order of 
provisioning actions” 
(page 455)

Move Action 
Down

Changes the order in which the provisioning 
actions in the task are applied. This command 
moves the selected provisioning action down so 
that it will follow the action that formerly followed 
it. If the selected action is the last in the task, it 
becomes the first. This command is disabled if 
no provisioning action is selected.

“Changing the order of 
provisioning actions” 
(page 455)

Move Action to 
Task...

Opens a dialog box to move the selected 
provisioning action to another task. This 
command is disabled if you have not selected a 
provisioning action.

“Selecting the task in which 
to add or move an action” 
(page 456)

Remove Action Removes the selected provisioning action from 
the task. This command is disabled if you have 
not selected a provisioning action.

“Removing a provisioning 
action” (page 461)
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Tools menu
The tools menu provides launch points for the Nodal Provisioning and service 
provisioning tools. The table “External Tools menu commands” (page 403) 
describes the menu commands.

Table 44
View menu commands

Command Description Related information

Provisioning 
Session...

Displays or hides the state of the provisioning 
session. 

Displays who is using the session when the 
provisioning session is in use.

“Viewing the state of the 
provisioning session” 
(page 480)

Task Activation 
Queue

Displays or hides the Task Activation Queue 
panel at the bottom of the window. 

“Viewing the Task Activation 
Queue” (page 479)

Table 45
External Tools menu commands

Command Description Related information

Nodal 
Provisioning

Starts Nodal Provisioning. “Launching external tools 
from Embedded Nodal 
Provisioning” (page 491)

Nodal 
Provisioning 
Template Editor

Starts the Nodal Provisioning Template Editor. “Launching external tools 
from Embedded Nodal 
Provisioning” (page 491)

Service 
Provisioning 

Opens a sub-menu of commands to start the 
following service provisioning tools:

• ATM

• CES SVC

• Frame Relay

• IP VPN Global Update

“Launching external tools 
from Embedded Nodal 
Provisioning” (page 491)
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Help menu
The Help menu provides a launch point to the on-line documentation. The 
table “Help menu command” (page 404) describes the menu command.

Provisioning Tasks panel
The left side of the Embedded Nodal Provisioning window is the 
Provisioning Tasks panel. This panel contains the task navigation tree. This 
tree lets you browse the components being changed through the activation of 
each task. 

Provisioning actions are ordered top to bottom under each task in the task 
navigation tree. Each provisioning action is applied to the Passport device in 
the order in which it appears in the task. You are provided menu options and 
tool bar buttons that let you do the following:

• change the order of provisioning actions by menu options and tool bar 
buttons. 

• add provisioning tasks and actions to the task navigation tree. 

• remove provisioning tasks and actions from the task navigation tree. 

Icons indicate the nature of the provisioning change to the component. For a 
description of the tree icons, see the following tables:

• “Task navigation tree task icons” (page 405). The tree icons for tasks 
display the type of provisioning change to the component and their 
status.

• “Task navigation tree action icons” (page 406). The tree icons for actions 
display the actions within each task. 

You can add and remove provisioning tasks and actions from the tree by using 
the main menu and pop-up menu commands.

Table 46
Help menu command

Command Description Related information

On Window Opens the online help documentation for the 
Embedded Nodal Provisioning window.
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You are also provided tool tips for each task and action in the task navigation 
tree. These tooltips display the full name of the task or action, so you have this 
information when the tree width is too small to display the full text of the 
tasks and actions.

Table 47
Task navigation tree task icons

Icon Name Meaning

Task Open The provisioning task has not been 
activated.

Task Completed The provisioning task has been activated 
and is now complete. No further work can 
be done with this task.

Task in Retry You have requested to activate this 
provisioning task. However, the 
provisioning session is currently in use. 
Retry is in progress and this task will be 
activated as soon as the provisioning 
session is free.

Task in Queue You have requested to activate this 
provisioning task. However, the 
provisioning session is currently in use 
and there is already a task in Retry. This 
task is in the queue pending activation.

 (Sheet 1 of 2)
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Task Activating The provisioning task is in the process of 
being activated.

Errors in Task The user has requested to activate the 
provisioning task. However, the 
activation failed because the provisioning 
task did not pass the Passport semantic 
checks. You may modify the task and try 
to activate again.

Table 48
Task navigation tree action icons

Icon Name Meaning

Service Template action This is a service template that is applied a 
component.

Add Component action This is a new component to be created.

Change Component action This is a component to be modified.

Delete Component action This is a component to be deleted.

Table 47  (continued)
Task navigation tree task icons

Icon Name Meaning

 (Sheet 2 of 2)
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The bottom of the task navigation tree also provides the shortcut buttons. See 
the table “Task navigation tree shortcut buttons” (page 407).

Provisioning forms panel
The right side of the Embedded Nodal Provisioning user interface is dynamic 
and displays the forms associated with the provisioning action selected in the 
task navigation tree. 

When you select an action in the task navigation tree, the provisioning forms 
panel displays the forms corresponding to the selected provisioning action. 
These forms are the same as those used in Nodal Provisioning. You can set 
provisionable attribute values. Attribute entry field have tooltips that display 
the range and type of data that is valid for that attribute.

Attribute value range and type checking is done when the form displayed in 
the Provisioning Forms panel changes, or when the task which contains the 
component creation is activated, whichever comes first. The range and type 
are checked against those defined in the Passport Command Description 

Table 49
Task navigation tree shortcut buttons

Toolbar icon Action

This icon is the same as Action -> Move Action up menu command. It 
changes the order in which the provisioning actions in the task are 
applied. It moves the selected provisioning action up so that it precedes 
the action that formerly preceded it. This icon is disabled if you have not 
selected a provisioning action.

This icon is the same as Action -> Move Action Down menu command. 
It changes the order in which the provisioning actions in the task are 
applied. It moves the selected provisioning action down so that it 
follows the action that formerly followed it. This icon is disabled if you 
have not selected a provisioning action.

This icon is the same as Task -> Save/Activate Task... menu 
command. This icon activates the currently selected task and adds it to 
the Task Activation Queue. This icon is disabled if you have not 
selected a task or if the selected task is in retry or is being activated.
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Language (CDL). If an invalid attribute is found, the task, action, and attribute 
that is in error is identified in a message dialog box, as well as the Task Details 
panel.

• “Provisioning forms panel for the Add Component action” (page 408)

• “Provisioning forms panel for the Change Component action” 
(page 409)

• “Provisioning forms panel for the Delete Component action” (page 411)

• “Provisioning forms panel for the Service Template action” (page 412)

Provisioning forms panel for the Add Component action 
When you select Add Component, the panel displays a component creation 
form. You need to identify the component that is to be the parent of the new 
subcomponent. This component may, or may not, exist in the current view on 
the Passport device. If it does not exist in the current view, you need to create 
the parent component by the same task, and before the new subcomponent is 
created. 

The component creation form lets you specify the instance identifier for the 
new component, as well as modify any of the provisionable attributes for the 
new component.

Note: When you add a new parent component, you can change or delete 
automatically added subcomponents in the same task.

For an illustration of the Provisioning Forms panel when you have selected an 
Add Component action, see the figure “Provisioning Forms panel for an Add 
Subcomponent action” (page 409). This figure shows an example of creating 
a new DS1 component as a subcomponent of Lp/1. 
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Figure 31
Provisioning Forms panel for an Add Subcomponent action

Provisioning forms panel for the Change Component action 
When you select Change Component, the panel displays a component edit 
form. The form lets you modify any of the provisionable attributes for the 
component. The form contains a Refresh button to retrieve the component 
data from the Passport device and redisplay it in the Component edit form. 
When you refresh, you lose any changes that you have already made in the 
form. The form also displays the date and time of the last refresh.
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For an illustration of the Provisioning Forms panel when you have selected an 
Change Component action, see the figure “Provisioning Forms panel for an 
Change Component action” (page 410). This figure is an example for 
modifying the Lp/2 X21/0.

Figure 32
Provisioning Forms panel for an Change Component action
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Provisioning forms panel for the Delete Component action 
When you select Delete Component, the panel displays a component deletion 
form. You can view the provisionable attributes for the component. However, 
the form is disabled so you can not make any changes to the component data.

For an illustration of the Provisioning Forms panel when you have selected an 
Delete Component action, see the figure “Provisioning Forms panel for an 
Delete Component action” (page 411).

Figure 33
Provisioning Forms panel for an Delete Component action
Preside MDM Nodal Provisioning User Guide   14.3RSUP



412   Chapter 14 Embedded Nodal Provisioning
Provisioning forms panel for the Service Template action 
When you select Service Template, the panel displays a service template 
form. This form lets you modify the visible provisionable attributes for the 
components contained in the template.

For an illustration of the Provisioning Forms panel when you have selected an 
Service Template action, see the figure “Provisioning Forms panel for a 
Service Template action” (page 413). This figure shows an example for 
applying the Create ATM Interface Service Template to Lp/1
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Figure 34
Provisioning Forms panel for a Service Template action

Task Details panel
If you select a task in the task navigation tree, the right side of the Embedded 
Nodal Provisioning window displays the activation details for the selected 
task. You can change the name and view the activation status of the task. If a 
task has not yet been activated, the status text states:

 This task has not yet been activated.
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The activation status provides a log of all the steps performed by the system 
after you request to activate a task. The activation status will display the 
following types of information:

• acquiring the provisioning session

• creating, modifying or deleting components

• applying service templates

• checking, saving, activating the view

• confirming and committing the view 

• releasing the provisioning session

• warning or error messages encountered during the activation

You can change the name of the task by entering a name in the Task Name 
field of the Task Details panel. The task name is updated in the task navigation 
tree.

The figure “Task Details panel” (page 415) shows an example of the Task 
Details panel for a task that is currently being activated.
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Figure 35
Task Details panel

Task Activation Queue panel
The Task Activation Queue panel is an optional panel that appears at the 
bottom of the Embedded Nodal Provisioning window. It shows the tasks in 
decreasing order of activation from top to bottom. 

You can show the Task Activation Queue by selecting Task Activation Queue 
from the View menu.

You can cancel the activation of any task that has the status “Waiting for 
provisioning session by selecting Cancel Activation command from either the 
Task menu, or the task pop-up menu. You can also reorder tasks by using the 
Move Task Up and Move Task Down commands from the Task menu.
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Status bar
The status bar shows the host name, CDL version, and the Passport device to 
which you are connected.

User logs
User logs are provided to capture the following information during each 
session of Embedded Nodal Provisioning.

• start of the provisioning session

• the name of each action that is applied to the current view when a task is 
activated

• Passport semantic check results

• Passport activation results

• End of provisioning session

Error logs are stored in /opt/MagellanNMS/data/enp.

Using Embedded Nodal Provisioning
See the following sections for the procedures for Embedded Nodal 
Provisioning:

• General procedures

— “Starting Embedded Nodal Provisioning” (page 419)

— “Authenticating to a device” (page 421)

— "Viewing on-line help" on page 422

— “Exiting Embedded Nodal Provisioning” (page 423)

• Provisioning procedures

— “Provisioning tasks overview” (page 424)

— “Adding a subcomponent from Passport Shelf View” (page 426)

— “Selecting the task in which to add or move an action” (page 456)

— “Adding a subcomponent from the Embedded Nodal Provisioning 
window” (page 429)

— “Modifying a component from Passport Shelf View” (page 432)
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— “Modifying a component from the Embedded Nodal Provisioning 
window” (page 433)

— “Refreshing a component modification form” (page 435)

— “Deleting a component from the Passport Shelf View” (page 436)

— “Deleting a component from the Embedded Nodal Provisioning 
window” (page 437)

— “Setting a context for a component” (page 443)

— “Getting a context for a component” (page 444)

— “Applying a service template in Passport Shelf View” (page 439)

— “Applying a service template from the Embedded Nodal 
Provisioning window” (page 441)

— “Linking a new service to a new port” (page 449)

• Organizing provisioning tasks and actions

— “Adding a new provisioning task” (page 454)

— “Changing the order of provisioning actions” (page 455)

— “Selecting the task in which to add or move an action” (page 456)

— “Adding a provisioning action” (page 458)

— “Renaming a provisioning task” (page 460)

— “Removing a provisioning action” (page 461)

— “Removing a provisioning task” (page 462)

— “Removing all provisioning tasks that are completed” (page 463)

— “Rearranging the order of tasks for activation” (page 464)

• Activating tasks

— “Activation scenarios” (page 465)

— “Activating a task” (page 470)

— “Activating a task when you have insufficient provisioning 
privileges” (page 471)
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— “Setting the options for saving and activating provisioning changes” 
(page 473)

— “Saving and activating provisioning changes” (page 476)

— “Viewing the Task Activation Queue” (page 479)

— “Viewing the state of the provisioning session” (page 480)

— “Canceling the activation of a single provisioning task” (page 481)

— “Canceling the activation of more than one provisioning task” 
(page 482)

• Concurrent provisioning conflicts and error resolution

— “Concurrent provisioning conflicts and resolution” (page 483)

— “Error messages” (page 484)

— “Repairing service creation errors” (page 188)

— “Resolving a restorePossible error condition” (page 190)

— “Resolving a journalDisabledReason error condition” (page 191)
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Starting Embedded Nodal Provisioning 
Use this procedure to open the Embedded Nodal Provisioning window.

Prerequisites
This procedure assumes that you have opened Passport Shelf View. For 
information on how to open Passport Shelf View, see 241-6001-011 Preside 
MDM Fault Management User Guide.

Procedure
1 In Passport Shelf View, select a component and right click to open the 

component’s popup menu.

Note:  Passport Shelf View opens with the State Summary tab selected. 
However, you can also select a component from the Physical Shelf or 
Component Information panels.

2 Right click on the component, and from the pop-up menu, select 
Configuration.

3 Select any one of the following provisioning sub-menu items:

• Add Subcomponent

• Change

• Delete

• Apply Service Template

4 If more than one Configuration Manager is specified in the configuration 
file, a Select Server  dialog box opens. You need to select a Configuration 
Manager server. See "Selecting the Configuration Manager server" on 
page 420.

5 A Provisioning Login dialog box opens. See “Authenticating to a device” 
(page 421).

After you click OK in the Provisioning Login dialog box, a read-only 
session of Embedded Nodal Provisioning opens. The provisioning 
action selected in Passport Shelf View shows as a new provisioning task 
in the task navigation tree in the Provisioning Tasks panel.
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Selecting the Configuration Manager server 
Select a Configuration Manager server when the configuration file contains 
more than one Configuration Manager server. When you start Embedded 
Nodal Provisioning and multiple Configuration Manager servers exist, the 
Select Server dialog box opens automatically. This dialog box displays a list 
of servers from which you can make a selection. 

Procedure steps
1 In the Select Server dialog box, select the desired configuration manager 

server from the list servers. 

2 Click OK.
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Authenticating to a device
Use this procedure to enter a user ID and password before you activate the 
first provisioning change to the device. This userid and password is 
remembered and used for all subsequent provisioning changes. 

Prerequisites
You need to have sufficient provisioning capabilities to successfully login.

Procedure
1 In the User name and Password fields, enter a valid user name and 

password that will allow you to provision the device.

2 Click OK.

This opens a read-only session of Embedded Nodal Provisioning. The 
provisioning action selected in Passport Shelf View shows as a new 
provisioning task in the task navigation tree in the Provisioning Tasks 
panel.

If you enter a user ID or password with insufficient provisioning 
capabilities, the Provisioning Login dialog box shows again. Return to 
step 1.

If you enter an invalid user ID or password, an error dialog box opens and 
you are asked to enter a valid user ID and password. Return to step 1

Cancel closes the dialog box.
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Viewing on-line help
Use this procedure to view the on-line help about the Embedded Nodal 
Provisioning window.

Prerequisites
This procedure requires that you have started Embedded Nodal Provisioning.

Procedure
1 From the Help menu in the Embedded Nodal Provisioning window, 

select On Window.

The online documentation for the Embedded Nodal Provisioning 
window opens in a Netscape window.
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Exiting Embedded Nodal Provisioning
Use this procedure to exit Embedded Nodal Provisioning. 

Prerequisites
This procedure requires that Embedded Nodal Provisioning is not holding a 
provisioning session and is not in the process of activating a task. If 
Embedded Nodal Provisioning has the provisioning session and is in the 
process of activating a task, the Exit menu item is disabled.

Procedure
1 From the File menu, select Exit.

The Embedded Nodal Provisioning window closes.

If there are tasks in the task navigation tree that have not yet been 
completed, either because they have not been activated, or the activation 
was unsuccessful, a dialog box opens confirming that you want to exit the 
Embedded Nodal Provisioning window.

2 Click Yes  to exit the Embedded Nodal Provisioning window. All the 
tasks are lost.

Click No to return to the Embedded Nodal Provisioning window.

Click Cancel to cancel the operation.
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Provisioning tasks overview
This section describes the procedures to make provisioning changes from 
Passport Shelf View and from Embedded Nodal Provisioning.

You can add a new provisioning action to the Embedded Nodal Provisioning 
window in two ways:

• by selecting a component in Passport Shelf View and using the 
component’s pop-up menu to select the type of provisioning action to 
perform on the component. The selected action and component is then 
added as a new task in the Embedded Nodal Provisioning window using 
the following rules:

— If the Embedded Nodal Provisioning window is not already open, or 
if there is no Open task in the Provisioning Tasks panel, the action is 
added to a new task with an auto generated name

— If there is only one Open task in the Provisioning Tasks panel, the 
action is added to that open task

— If there is more than one Open task in the Provisioning Tasks panel, 
a Move To Task dialog box opens and prompts you to choose the 
task in which to place the action. For the procedure to choose the 
task, see “Selecting the task in which to add or move an action” 
(page 456).

• From the Action menu of the Embedded Nodal Provisioning window, 
select New Action..., or select a task in the Provisioning Tasks panel, and 
then select the New Action... command from the task’s pop-up menu. 

See the following sections for provisioning actions:

• “Adding a subcomponent from Passport Shelf View” (page 426)

• “Adding a subcomponent from the Embedded Nodal Provisioning 
window” (page 429)

• “Modifying a component from Passport Shelf View” (page 432)

• “Modifying a component from the Embedded Nodal Provisioning 
window” (page 433)

• “Refreshing a component modification form” (page 435)
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• “Deleting a component from the Passport Shelf View” (page 436)

• “Deleting a component from the Embedded Nodal Provisioning 
window” (page 437)

• “Applying a service template in Passport Shelf View” (page 439)

• “Applying a service template from the Embedded Nodal Provisioning 
window” (page 441)

• “Linking a new service to a new port” (page 449)
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Adding a subcomponent from Passport Shelf View
Use this procedure to add a subcomponent to a parent component in Passport 
Shelf View. To create a component you need to first identify its parent 
component in Passport Shelf View. Once you select the parent component. 
you need to select the type of the subcomponent that is to be created using the 
Select Component Type dialog box.

Prerequisites
This procedure requires the following conditions

• you have opened Passport Shelf View and located a parent component 
from the State Summary, Physical Shelf, or component information 
panel. For information about Passport Shelf View, see 241-6001-011 
Preside MDM Fault Management User Guide.

• you have sufficient privileges to provision the device.

Procedure
1 In Passport Shelf View, select a component and right click to open the 

component’s popup menu.

Note:  Passport Shelf View opens with the State Summary tab selected. 
However, you can also select a component from the Physical Shelf or 
Component Information panels.

2 From the component’s pop-up menu, select Configuration -> Add 
Subcomponent.
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The Select Component Type dialog box opens.

3 Select the type of component that you wish to create, and click OK.

The Select Component Type dialog box closes and the new action is 
placed in a task in the task navigation tree, according to the following 
rules:

• If the Embedded Nodal Provisioning window is not already open, 
or there is no “open” task in the Embedded Nodal Provisioning 
interface, the action is added to a new task with an auto generated 
name. The task navigation tree in the Provisioning Tasks panel 
shows the subcomponent as a child of the task. The icon for the 
subcomponent is the Create Component icon, and the label is the 
subcomponent type. 

• If there is only one “open” task, the action is added to that open task.

• If the Embedded Nodal Provisioning window is already open and 
has more than one open task, a Move to Task dialog box opens. 
Select the task to which to add the action. See the procedure 
“Selecting the task in which to add or move an action” (page 456).

4 In the task navigation tree, select the new component.

The Add <subcomponent type> form appears in the panel on the right 
side of the Embedded Nodal Provisioning window. 

5 Enter the component identifier for the new subcomponent, and modify 
attribute values, as desired.
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Optionally, set or get the context for this component. See “Setting a 
context for a component” (page 443) or “Getting a context for a 
component” (page 444).

6 Optionally, add more provisioning actions to the task by repeating steps1 
to 5.

7 Optionally, modify or delete automatically added subcomponents of the 
parent component. See “Modifying a component from the Embedded 
Nodal Provisioning window” (page 433) or “Deleting a component from 
the Embedded Nodal Provisioning window” (page 437).

8 Activate the task. See “Task Activation overview” (page 465).

If the activation is successful, the new subcomponent is added.
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Adding a subcomponent from the Embedded Nodal 
Provisioning window

Use this procedure to add a subcomponent in the Embedded Nodal 
Provisioning window.

Prerequisites
This procedure requires the following conditions:

• You have opened Embedded Nodal Provisioning.

• You have sufficient privileges to provision the device

• You know the full name of the parent component.

Procedure
1 Select a task from the task navigation tree in the Provisioning Tasks panel.

2 Select one of the following options:

• From the task popup menu, select New Action... .

• From the Action menu, select New Action....

The New Action dialog box opens. 

3 Complete the fields in the New Action dialog box. 

• In the Component Name field, enter the name of the parent 
component to which the subcomponent is to be added. This may be 
the name of an existing component or the name of a component that 
will be created as part of the same provisioning task. 

Optionally, set or get the context for this component. See “Setting a 
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context for a component” (page 443) or “Getting a context for a 
component” (page 444).

• From the Provisioning Action drop down list, select Add 
Subcomponent.

• Specify the task into which to add this provisioning action. To add the 
action to an existing task, select existing and then select the task 
name from the drop down list. Otherwise select new and the task 
name is automatically generated. You can choose to use the default 
name for the new task or modify it to provide a new name.

For additional information, see “Adding a provisioning action” (page 458).

4 Click OK.

The Select Component Type dialog box opens.

5 Select the type of component to create and click OK.

The Select Component Type dialog box closes. The subcomponent to 
be created appears in the task navigation tree as a child of the task 
selected in step 5. The icon for the subcomponent is the Add Component 
icon and the label is the subcomponent type.

6 In the task navigation tree, select the new action.

7 The Add <subcomponent type> form opens on the right side of the 
Embedded Nodal Provisioning window.
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8 Enter the component identifier for the new subcomponent and set the 
attribute values, as required.

9 Optionally, add more provisioning actions to this task.

10 Optionally, modify or delete automatically added subcomponents of the 
parent component. See “Modifying a component from the Embedded 
Nodal Provisioning window” (page 433) or “Deleting a component from 
the Embedded Nodal Provisioning window” (page 437).

11 Activate the task. See “Task Activation overview” (page 465).
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Modifying a component from Passport Shelf View
Use this procedure to modify a component from Passport Shelf View.

Prerequisites
This procedure requires the following conditions:

• You have opened Passport Shelf View.

• You have sufficient provisioning privileges to provision the device.

• You have located the component that you want to modify.

For information on Passport Shelf View, see 241-6001-011 Preside MDM 
Fault Management User Guide.

Procedure
1 In Passport Shelf View, select the component that you want to modify.

Note:  Passport Shelf View opens with the State Summary tab selected. 
However, you can also select a component from the Physical Shelf or 
Component Information panels.

2 From the component’s pop-up menu, select Configuration -> Change....

If the Embedded Nodal Provisioning window is not already open, it now 
opens.

The component to be modified appears in the task navigation tree of the 
Provisioning Tasks panel. It displays as a child of the task. The icon for 
the subcomponent is the Change Component icon and the label is 
Change <component name>.

3 Select the new action in the task navigation tree.

The Change <component name> form appears on the right of the 
Embedded Nodal Provisioning window. 

4 Modify the provisional attribute values in the form, as desired.

5 Optionally, add more provisioning actions to the task.

6 Activate the task. See “Task Activation overview” (page 465).
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Modifying a component from the Embedded Nodal 
Provisioning window

Use this procedure to modify a component from the Embedded Nodal 
Provisioning window.

Prerequisites
This procedure requires the following conditions:

• You have opened the Embedded Nodal Provisioning window.

• You have sufficient privileges to provision a device.

• You know the full name of the component that you want to modify.

Procedure
1 Select one of the following steps:

• Select a task in the task navigation tree, right-click, and from the pop-
up menu, select New Action... .

• From the Action menu in the Embedded Nodal Provisioning window 
select New Action....

The New Action dialog box opens.

2 In the New Action dialog box, complete the following steps:

• Type a Component Name.

• From the Provisioning Action drop down list, select Change.

• Specify the task into which to place this provisioning action.
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See the procedure “Adding a provisioning action” (page 458).

3 Click OK.

The component to be modified appears in the task navigation tree of the 
Provisioning Tasks panel. It displays as a child of the task selected in 
step 4. The icon for the subcomponent is the Change Component icon 
and the label is the component name.

4 Select the new action in the task navigation tree.

The Change <component name> form appears on the right of the 
Embedded Nodal Provisioning window.

5 Modify the provisional attribute values in the form, as desired.

6 Optionally, add more provisioning actions to the task.

7 Activate the task. See “Task Activation overview” (page 465).
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Refreshing a component modification form
Use this procedure to refresh the display of a component modification form 
with the data from the current view of the Passport device.

Procedure
1 In the task navigation tree in the Embedded Nodal Provisioning window, 

select a Change Component action.

The Change Component form appears on the right of the window.

2 In the Change Component form, click Refresh.

The Last refresh timestamp is updated with the current date and time. 
The component data is replaced with data from the Passport current view.

If ENP is unable to retrieve the component data from the Passport, an 
error message is displayed, as follows:

Unable to refresh the form for [component name] 

[Passport error message]

A possible cause of the error is that the component may have been 
deleted from the Passport.
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Deleting a component from the Passport Shelf View
Use this procedure to delete a component that you have located in Passport 
Shelf View.

Prerequisites
This procedure requires the following conditions:

• You have opened Passport Shelf View.

• You have sufficient privileges to provision a device.

Procedure
1 In Passport Shelf View, select a component.

Note:  Passport Shelf View opens with the State Summary tab selected. 
However, you can also select a component from the Physical Shelf or 
Component Information panels.

2 Right-click and from the component’s popup menu, select Configuration 
-> Delete....

If the Embedded Nodal Provisioning window is not already open, it 
opens.

The component to be deleted appears in the task navigation tree of the 
Provisioning Tasks panel. It displays as a child of the task. The icon for the 
subcomponent is the Delete Component icon and the label is the 
component name.

3 In the task navigation tree, select the new delete action.

The Delete <component name> form opens on the right of the Embedded 
Nodal Provisioning window. The provisionable attributes are visible but 
disabled so that you cannot change them.

4 Optionally, add more provisioning actions to the task.

5 Activate the task. See “Task Activation overview” (page 465).
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Deleting a component from the Embedded Nodal 
Provisioning window

Use this procedure to delete a component from the Embedded Nodal 
Provisioning window.

Prerequisites
This procedure requires the following conditions:

• You have opened Embedded Nodal Provisioning.

• You have sufficient privileges to provision a device.

• You know the full name of the component that you want to delete.

Procedure
1 Select one of the following steps:

• Select a task in the task navigation tree, right-click, and from the pop-
up menu, select New Action... .

• From the Action menu in the Embedded Nodal Provisioning 
window select New Action....

The New Action dialog box opens.

2 In the New Action dialog box, complete the following steps:

• In the Component Name field, type the name of the component that 
you want to delete

• From the Provisioning Action drop down list, select Delete.
Preside MDM Nodal Provisioning User Guide   14.3RSUP



438   Chapter 14 Embedded Nodal Provisioning
• Specify the task into which to place this provisioning action.

See the detailed procedure “Adding a provisioning action” (page 458).

3 Click OK.

The component to be deleted appears in the task navigation tree as a 
child of the task selected in step 1. The icon for the subcomponent is the 
Delete Component icon and the label is the component name.

4 In the task navigation tree, select the new action.

You can view the provisionable attribute values in the component but they 
are disabled so you cannot change them.

5 Optionally, add more provisioning actions to the task.

6 Activate the task. See “Task Activation overview” (page 465).
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Applying a service template in Passport Shelf View
Use this procedure to apply a service template to a component that you have 
located in the Passport Shelf View. You will use the Select Service Template 
dialog box to select a service template.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened Passport Shelf View.

• You have sufficient privileges to provision the device.

Procedure
1 In Passport Shelf View, select a component.

Note:  Passport Shelf View opens with the State Summary tab selected. 
However, you can also select a component from the Physical Shelf or 
Component Information panels.

2 Right-click and from the component pop-up menu, select Configuration 
->  Apply Service Template....

The Select Service Template dialog box opens. 
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3 Select a template to apply from the Templates list and click OK.

See “Selecting a service template” (page 445) for the procedure to select 
a service template.

The Embedded Nodal Provisioning window opens if it is not already 
open. The component to which the service template is being applied 
appears in the task navigation tree as a child of the task. The icon for the 
subcomponent is the Apply Template icon and the label contains the 
name of the template and the name of the component that it is being 
applied to.

4 In the task navigation tree, select the new action.

The Apply Service Template form displays on the right of the Embedded 
Nodal Provisioning window. 

5 Enter the required component identifier and attribute values.

6 Optionally, add more provisioning actions to the task.

7 Activate the task. See “Task Activation overview” (page 465).
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Applying a service template from the Embedded Nodal 
Provisioning window

Use this procedure to apply a service template to a component that you have 
located in the Embedded Nodal Provisioning window.

Prerequisites
This procedure requires that the following conditions are met:

• you have opened the Embedded Nodal Provisioning window

• you have sufficient privileges to provision the device

• you know the full name the component to which to apply the service 
template.

Procedure
1 Select one of the following steps:

• Select a task in the task navigation tree, right-click, and from the pop-
up menu, select New Action... .

• From the Action menu in the Embedded Nodal Provisioning window 
select New Action....

The New Action dialog box opens.

2 In the New Action dialog box, complete the following steps:

• In the Component Name field, type the name of the component to 
which you want to apply the service template

• From the Provisioning Action drop down list, select Apply Service 
Template.

• Specify the task into which to place this provisioning action.

See the detailed procedure “Adding a provisioning action” (page 458).

3 Click OK.
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The Select Service Template dialog box opens.

4 Select a service template and click OK. See the procedure “Selecting a 
service template” (page 445).

The Select Service Template dialog box closes. The component to 
which the template will be applied appears in the task navigation tree as 
the child of the selected task. The icon for the subcomponent is the Apply 
Template icon and the label contains the name of the template and the 
name of the component it is applied to in the form <template name> to 
<component name>.

5 From the task navigation tree, select the new action.

The Apply Service Template form appears on the right side of the 
Embedded Nodal Provisioning window.

6 Enter the service template data, including the component identifiers and 
attribute values.

7 Optionally, add more provisioning actions to the task.

8 Activate the task. See “Task Activation overview” (page 465).
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Setting a context for a component
Use this procedure together with the “Adding a subcomponent from the 
Embedded Nodal Provisioning window” (page 429) to set the context for a 
selected component. Once a context is set for a component, this context can 
be applied to other components.

Prerequisites
This procedure requires the following conditions:

• you have opened the Embedded Nodal Provisioning window and have 
added a new component

• you have sufficient privileges to provision the device

• you know the full name of the component that you want to set as the 
context.

Procedure steps
1 In the New Action dialog box right click the Component Name text field.

2 Select Set Context from the pop-up menu.

The Set Context Completed confirmation dialog opens.
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Getting a context for a component
Use this procedure to get the context for a selected component from another 
component in the component hierarchy. 

Prerequisites
This procedure requires the following conditions:

• you have opened the Embedded Nodal Provisioning window and have 
added a new component

• you have sufficient privileges to provision the device

• you know the full name of the component that you want to set as the 
context.

Procedure steps
1 In the New Action dialog box right click the Component Name text field.

2 Select Get Context from the pop-up menu.

The context component name appears in the text field.
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Selecting a service template
Use this procedure to select a service template to apply to a component from 
either Embedded Nodal Provisioning or Passport Shelf View. You use the 
Select Service Template dialog box to select the service template to apply. 
The Select Service Template dialog box is populated with the names of all the 
templates that can be applied to the selected component, including custom 
templates.

Prerequisites
This procedure requires the following conditions:

• You have sufficient privileges to provision the device.

• You have selected the component to which the template will be applied.

• You have selected the Apply Service Template command from a 
component’s pop-up menu in Passport Shelf View, or in Embedded 
Nodal Provisioning, from the Provisioning Action drop down list in the 
New Action dialog box.

Procedure
1 Optionally, use the Service Group drop down list and the Template 

Name list to restrict the templates shown in the Templates list.

• From the Service Group drop down list, select a service group. The 
Service Group list contains all of the template categories for which 
there are templates that can be applied to the component. Minimally 
one category is required for the dialog box to open.
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• In the Templates Name field start to enter the name of the template 
that you want to apply. The template that most closely matches what 
you type in this field is highlighted in the list.

2 Click OK to apply the selected template.

Click Cancel to cancel the operation.

selected service 
template for the apply 
service template 
operation
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Browsing for available component instances
Use this procedure to browse for component instances for Passport 
component attributes that have a value that is in reference to another 
component instance. You can type the component name of the other instance 
in the attribute value text field, or you can use the Component Link Search 
dialog box to search for such component instances. A browse button[...] is 
provided beside each attribute with a component instance.

The ability to browse for component instances improves the ability to handle 
situations where there are large numbers of components for a linked attribute. 

Prerequisites
This procedure requires that the following conditions are met:

• You have opened Embedded Nodal Provisioning.

• You have sufficient privileges to provision the device.

• The component attribute has a value that is a reference to another 
component instance, as indicated by a browse button [...] beside the 
attribute.

Procedure
1 For those attributes that have a value that is in reference to another 

component instance, type the component name of the other instance in 
the text field, or click the browse button [...] next to the attribute with a 
component instance.

2 If you click the browse button, the Component Link Search dialog box 
opens.

3 Enter search criteria in the Search Criteria panel:

• In the Start Search at Component field, type the name of the other 
instance or use the wild card (*) to search for all instances.

• In the Max Number to Retrieve, type the number of instances to 
retrieve. The default is 100.

4 Click Search.

The list of available component links found as a result of the search, are 
listed in the Search Results panel.

5 Select a component link from the list and click OK.
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The selection is entered in the field beside the browse button.
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Linking a new service to a new port
Use this procedure as an example of how you can create a new port and link 
a new service to it in a single task.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened Passport Shelf View.

• You have sufficient privileges to provision the device.

Procedure
1 In Passport Shelf View, select an LP.

Note:  Passport Shelf View opens with the State Summary tab selected. 
However, you can also select a component from the Physical Shelf or 
Component Information panels.

2 From the component’s pop-up menu, select Add Subcomponent (for 
example, Lp/1).

The Select Component Type dialog box opens.
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3 Select the port component from the Type Name list (for example DS3)

4 Click OK.

The Select Component Type dialog box closes and the add port action 
appears in the task navigation tree in the Provisioning Tasks panel of the 
Embedded Nodal Provisioning window.

5  From the menu bar, select Action -> New Action.

The New Action dialog box opens.

6 In the Component Name field, type the name of the parent component of 
the new service component that is being created, (for example, EM/
Atlanta, EM, or empty string).

7 From the Provisioning Action drop down list, select the Add 
Subcomponent action.
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8 In the Provisioning Tasks panel, select the task that was created in step 
4, and click OK.

The Select Component Type dialog box opens.

9 From the type Name list, select a service component type (for example, 
AtmIf) and click OK.

The Select Component Type and the New Action dialog boxes close. 
The add service action is added to the task created in step 4.
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10 Select the add port action which was added to the task navigation tree in 
step 4.

The Add Lp/1 DS3 form appears in the right side panel of the Embedded 
Nodal Provisioning window.

11 Type the component identifier for the new port and modify the attribute 
values, as desired. Do not set the Application Framer Name attribute.

12 Select the add service action.

13 The Add EM/Atlanta AtmIf form displays on the right side of the 
Embedded Nodal Provisioning window.

14 Type the component identifier for the new service and set the attribute 
values, as desired.

15 Type Lp/1 DS3/2 for the value of the Interface attribute.

16 Activate the task. See “Task Activation overview” (page 465).
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Organizing provisioning tasks and actions overview
This section describes the procedures for organizing provisioning actions into 
provisioning tasks as well as reorganizing actions within a task. See the 
following procedures for additional information:

• “Adding a new provisioning task” (page 454)

• “Changing the order of provisioning actions” (page 455)

• “Selecting the task in which to add or move an action” (page 456)

• “Adding a provisioning action” (page 458)

• “Renaming a provisioning task” (page 460)

• “Removing a provisioning action” (page 461)

• “Removing a provisioning task” (page 462)

• “Removing all provisioning tasks that are completed” (page 463)

• “Rearranging the order of tasks for activation” (page 464)
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Adding a new provisioning task
Use this procedure to add a new provisioning task to the task activation tree.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened the Embedded Nodal Provisioning window.

• You have sufficient privileges to provision the device.

Procedure
1 From the Task menu bar in the Embedded Nodal Provisioning window, 

select New Task.

A new task is added to the bottom of the task navigation tree with the 
format Task_X, where X is a unique number in the task list. Tasks are 
automatically added sequentially.

2 Select the new task.

The panel on the right side of the Embedded Nodal Provisioning 
window displays the task details.

3 If desired, in the task details panel, change the name of the new task in 
the Task Name field.
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Changing the order of provisioning actions
Use this procedure to change the order in which the provisioning actions in a 
provisioning task are applied to the view when the task is activated.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened the Embedded Nodal Provisioning window.

• You have sufficient privileges to provision the device.

• The task navigation tree contains one or more tasks with several actions.

Procedure
1 In the task navigation tree in the Embedded Nodal Provisioning window, 

select a provisioning action.

2 Complete one of the following steps to switch the order with the one above 
it:

• From the Action menu, select Move Action Up.

• Right-click on the action in the task navigation tree and select Move 
Action Up from the pop-up menu.

If the provisioning action is the first one in the task, it becomes the last.

Complete one of the following steps to switch the order of the action with 
the one below it:

•  From the Action menu, select Move Action Down.

• Right-click on the action in the task navigation tree and select Move 
Action Down  from the popup menu.

 If the provisioning action is the last one in the task, it becomes the first.
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Selecting the task in which to add or move an action
Use this procedure to select a task in which the provisioning action will be 
performed, or to move a provisioning action from one task to another task. 
The Move to Task dialog box opens automatically when you specify an action 
and there is more than one open task in the Embedded Nodal Provisioning 
window. 

Prerequisites
This procedure requires the following conditions:

• You have opened Embedded Nodal Provisioning.

• You have sufficient privileges to provision the device.

• The Move to Task dialog box is open, either because Embedded Nodal 
Provisioning has more than one open task, or you have selected Move to 
Task from the menu bar.

Procedure
1 In the Move to Task dialog box, select the task in which you wish to add 

or move the action:

If you wish to create a new task to which to add or move the action, select 
new. The text box displays the name of the new task to which the action 
will be added or moved.

If you wish to add or move the action to an existing task, select existing 
and select the task from the dropdown list of tasks.

2 Click OK to add or move the action to the selected task and to close the 
Move to Action dialog box.

Click Cancel to cancel the operation.
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If moving a provisioning action from one task to another, the action is 
removed from the task that it is currently in and is added as the last 
provisioning action in the task that you selected in step 1.

If adding a provisioning action to a task, the task is added as the last 
provisioning action in the task that you selected in step 1.
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Adding a provisioning action
Use this procedure to add a provisioning action to a task.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened the Embedded Nodal Provisioning window.

• You have sufficient privileges to provision the device.

• You know the name of the component to which the subcomponent is to 
be added.

Procedure
1 From the menu bar, select Action -> New Action.

2 In the Component Name field, enter the name of the parent component 
that the action will operate on. This may be the name of an existing 
component or the name of a component that will be created as part of the 
same provisioning task.

Note:  The only provisioning action appropriate to a component that does 
not yet exist is Add Subcomponent. Any other action will result in an 
error message, since the provisioning form cannot open for a component 
that does not exist.

3 From the Provisioning Action drop down list, select an action. You have 
the following options:.

• Add

• Change

• Delete deletes a subcomponent
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• Add Subcomponent

• Apply Template 

4 Specify the task into which the current provisioning action will be placed;

• If in an existing task, select existing and then select from the list of 
existing task names in the drop down list. 

• If in a new task, select  new. The new task name is automatically 
generated. 

5 Click OK.

6 Use the existing name of the task, or optionally, select the task in the task 
navigation tree and change the name in the Task Name field in the task 
details panel. See “Renaming a provisioning task” (page 460).
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Renaming a provisioning task
Use this procedure to rename a provisioning task.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened the Embedded Nodal Provisioning window.

• You have sufficient privileges to provision the device.

• The task navigation tree contains at least one task.

Procedure
1 In the task activation tree in the Embedded Nodal Provisioning window, 

select a provisioning task.

2 In the Task Name field in the task details panel, change the name of the 
task. The task name must be different than any existing task name.

The task name is updated in the task navigation tree when the focus 
moves from the Task Name field. If the new task name is the same as one 
of the existing task names, it reverts to the previous task name.
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Removing a provisioning action
Use this procedure to remove a provisioning action from a provisioning task.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened the Embedded Nodal Provisioning window.

• You have sufficient privileges to provision the device.

• The task navigation tree contains at least one task and one action.

Procedure
1 In the task activation tree in the Embedded Nodal Provisioning window, 

select a provisioning action.

2 In the Action menu, select Remove Action.

The provisioning action is removed from the task navigation tree.
Preside MDM Nodal Provisioning User Guide   14.3RSUP



462   Chapter 14 Embedded Nodal Provisioning
Removing a provisioning task
Use this procedure to remove a provisioning task from the task navigation 
tree.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened the Embedded Nodal Provisioning window.

• You have sufficient privileges to provision the device.

• The task navigation tree contains at least one task.

Procedure
1 In the task activation tree in the Embedded Nodal Provisioning window, 

select the task that you want to remove.

2 Select one of the following options:

• From the selected task’s pop-up menu, select Remove Task.

• From the Task menu, select Remove Task.

If the task has not been completed through a successful activation, you 
are prompted to confirm that you want to remove the task.

3 Click OK to remove the task and all of its provisioning actions from the 
task navigation tree.
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Removing all provisioning tasks that are completed
Use this procedure to remove all the tasks from the task navigation tree that 
have been completed, that is successfully activated.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened the Embedded Nodal Provisioning window.

• You have sufficient privileges to provision the device.

• The task navigation tree contains at least one or more tasks that have been 
successfully activated

Procedure
1 From the Task menu, select Remove Completed Tasks.

The completed tasks are removed from the task navigation tree.
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Rearranging the order of tasks for activation
Use this procedure to rearrange the order of activation of any task in the Task 
Activation Queue. This procedure applies to either moving a task up the 
queue or moving a task down a queue.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened the Embedded Nodal Provisioning window.

• You have sufficient privileges to provision the device.

• The Task Activation Queue contains more than one task waiting for 
activation

Procedure
1 In the Task Activation Queue, select the task whose order of activation 

you wish to change.

2 Complete one of the following steps to move a task up the queue:

• From the Task menu, select Move Task Up. 

This step moves the order of the selected task up the queue to precede 
the task that formerly preceded it. If the selected task is the first in the 
queue, it becomes the last.

Complete one of the following steps to move a task down the queue:

• From the Task menu, select Move Task Down.

This step moves the order of the selected task down the queue to that it 
follows the task that formerly followed it. If the task is the last in the queue, 
and the first task status is not in an activating or retry state, then it 
becomes the first. Otherwise, it remains at the end of the queue.
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Task Activation overview
This section describes the procedures and processes for activating 
provisioning changes:

• “Activation scenarios” (page 465)

• “Activating a task” (page 470)

• “Activating a task when you have insufficient provisioning privileges” 
(page 471)

• “Setting the options for saving and activating provisioning changes” 
(page 473)

• “Saving and activating provisioning changes” (page 476)

• “Viewing the Task Activation Queue” (page 479)

• “Viewing the state of the provisioning session” (page 480)

• “Canceling the activation of a single provisioning task” (page 481)

• “Canceling the activation of more than one provisioning task” (page 482)

Activation scenarios
The following sections describe the various activation scenarios that may 
occur after you have activated the provisioning changes:

• “Activation process when the Passport provisioning session is available” 
(page 465)

• “Activation process when the Passport provisioning session is in use” 
(page 466)

• “Activation process when a task, component creation, modification, or 
deletion fails” (page 467)

• “Activation process when a service creation fails” (page 468)

Activation process when the Passport provisioning session is 
available

When you successfully activate a task the following events occur:

1 The task icon changes to the Activating icon.
Preside MDM Nodal Provisioning User Guide   14.3RSUP



466   Chapter 14 Embedded Nodal Provisioning
2 The task is placed at the head of the Task Activation Queue, and its status 
is “Activation in progress”.

3 The Passport provisioning session is opened. An edit view is initialized 
to be the same as the current view.

4 The provisioning actions in the task are applied in order to the Passport 
edit view. Each action is logged in the Task Details panel.

5 The Passport semantic check is done to verify that the provisioning 
details are valid. The results of the semantic check are logged to the Task 
Details panel.

6 The Passport edit view is activated, and becomes the current view.

7 The activation is confirmed.

8 The task icon changes to the Completed icon.

9 The task is removed from the Task Activation Queue.

Activation process when the Passport provisioning session is 
in use

When you activate a task and the Passport provisioning session is in use, the 
task activation enters retry mode:

1 The task icon changes to the Task In Queue icon.

2 The task is placed at the end of the Task Activation Queue, and its status 
is Waiting for provisioning session.

3 The task tries to obtain the Passport provisioning session, as per the 
configured Retry interval. The default is every minute. This is logged in 
the Task Details panel.

4 When the Passport provisioning session becomes free, the task obtains 
the Passport provisioning session for itself. 

5 The task moves to the head of the Task Activation Queue, and its status 
is Activation in progress.

6 The Passport provisioning session is opened. An edit view is initialized 
to be the same as the current view.

7 The provisioning actions in the task are applied in order to the Passport 
edit view. Each action is logged in the Task Details panel.
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8 The Passport semantic check is done to verify that the provisioning 
details are valid. The results of the semantic check are logged to the Task 
Details panel.

9 The Passport edit view is activated, and becomes the current view.

10 The activation is confirmed.

11 The task icon changes to the Completed icon.

12 The task is removed from the Task Activation Queue.

Activation process when a task, component creation, 
modification, or deletion fails

1 The task icon changes to the Activating icon.

2 The task is placed at the head of the Task Activation Queue, and its 
status is Activation in progress.

3 The Passport provisioning session is reserved. The edit view is initialized 
to be equivalent to the current view.

4 The provisioning actions in the task are applied in order to the Passport 
edit view. Each action is logged in the Task Details panel.

5 The task icon changes to the Errors icon.

6 The task is removed from the Task Activation Queue.

7 The error message appears and you are asked if you wish to hold on to 
the provisioning session while they repair the errors. If no, the Passport 
provisioning session is released.

8 The Activation Error dialog box opens.

9 You acknowledge the error, and click Yes to cancel other task activations, 
or No to leave the Task Activation Queue unchanged.

10 The Task Activation Error dialog box closes.

11 Resolve the problem and activate the task again. If the Check Prov has 
failed, see the next step.

12 The Check Prov of a component creation task can fail in some cases. 
Normally, Passport adds subcomponents with a default set of attributes 
and the user is not required to perform any other task if the default 
attributes are acceptable. In some cases, though, (for example, FRUNI), 
the Check Prov fails because of missing or invalid information set by 
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Passport when the subcomponent is added (for example, in the case of 
FRUNI, the FRUNI DNA (DataNetwork Address and the FRUNI 
FRAMER interfaceName attribute must be set). 

Resolve the problem with one of the procedures below if it fits this 
situation:

• Modify the existing task

— Select the existing task and right click and select New Action.

— In the Component Name field, enter the name of the component 
that caused the error.

— From the Provisioning Action drop down list, select Change.

— Click OK.

— Enter the new values for the attributes to fix the problem.

— From the Task Menu, select Save/Activate.

• Use the applicable service template if one exists for creating 
the component

— From the Task Menu, select New Task

— Select the newly-created task and right click and select New Action.

— Choose Apply Service Template and type the drop site name in the 
Component Name field.

— The Select Service Template dialog is displayed. Select the service 
group and the applicable template.

— When the template is displayed, enter the attribute values in the 
specific fields. 

— From the Task Menu, select Save/Activate for the newly-created 
task.

Activation process when a service creation fails
1 The task icon changes to the Activating icon.

2 The task is placed at the head of the Task Activation Queue, and its 
status is Activation in progress.
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3 The Passport provisioning session is reserved. The current view is copied 
into the edit view.

4 The provisioning actions in the task are applied in order to the Passport 
edit view. Each action is logged in the Task Details panel.

5 A service creation fails. The error is logged in the Task Details panel.

6 The Service Creation Errors dialog box opens. If this window is open 
for more than 3 minutes, you are prompted to confirm that you wish to 
continue holding the Passport provisioning session. If you do not 
respond, the task icon changes to an Errors icon, the task is removed 
from the Task Activation Queue and the Passport provisioning session 
is released. You are prompted to determine if you want to cancel other 
pending activations as well.

7 If you select Accept or Delete All, the task activation continues.

8 If you select Cancel, the Service Creation Errors dialog box closes. 
The task icon changes to the Errors icon. The task is removed from the 
Task Activation Queue. The Passport provisioning session is released. 
You are prompted to determine if you want to cancel other pending 
activations as well.

9 If you select Repair, the Service Creation Errors dialog closes. A 
repair dialog opens in which you can modify the service values that were 
involved in the service creation failure. If the repair dialog remains open 
for more than 3 minutes, you are prompted to confirm hat you wish to 
continue holding the Passport provisioning session. If you do not 
respond, the task icon changes to an Errors icon, the task is removed 
from the Task Activation Queue and the Passport provisioning session 
is released. You are prompted to determine if you want to cancel other 
pending activations as well.
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Activating a task
Use this procedure to apply the provisioning actions contained by the task to 
the current Passport view.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened Embedded Nodal Provisioning.

• You have sufficient privileges to provision the device.

Procedure
1 In the task navigation tree of the Embedded Nodal Provisioning 

window, select a task.

2 From the Task menu, select Save/Activate Task... or click the Save/
Activate button at the bottom of the Provisioning Tasks panel.

If you have configured the Embedded Nodal Provisioning session to 
prompt for confirmation before each activation, the confirmation dialog 
opens. Click OK.

If you have configured the Embedded Nodal Provisioning session to 
prompt for save/commit options before each activation, the Save/Activate 
Options dialog box opens. Proceed to the procedure “Saving and 
activating provisioning changes” (page 476).

3 Refer to the section “Activation scenarios” (page 465) for a description of 
the following possible outcomes.

• “Activation process when the Passport provisioning session is 
available” (page 465)

• “Activation process when the Passport provisioning session is in use” 
(page 466)

• “Activation process when a task, component creation, modification, 
or deletion fails” (page 467)

• “Activation process when a service creation fails” (page 468)

4 Optionally, set the context for the activation task. Select the task and right 
click to select Set Context.
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Activating a task when you have insufficient provisioning 
privileges

Use this procedure to activate a task when your userid has insufficient 
provisioning privileges.

Prerequisites
This procedure requires that the following conditions are met:

• The Passport Shelf View userid and password do not have sufficient 
impact to Provision a Passport device

Procedure
1 In the task navigation tree of the Embedded Nodal Provisioning 

window, select a task.

2 From the Task menu, select Save/Activate Task..., or click the Save/
Activate Task button in the Provisioning Tasks panel.

If you have configured the Embedded Nodal Provisioning session to 
prompt for confirmation before each activation, the confirmation dialog 
opens. Click OK.

If you have configured the Embedded Nodal Provisioning session to 
prompt for save/commit options before each activation, the Save/Activate 
Options dialog box opens. Proceed to the procedure “Saving and 
activating provisioning changes” (page 476).

3 The Device Authentication dialog box opens.

4 Enter a userid and Password for provisioning and click OK.

The Device Authentication dialog closes. The task icon changes to the 
“Activating” icon. 

5 Refer to the section “Activation scenarios” (page 465) for a description of 
the following possible outcomes.

• “Activation process when the Passport provisioning session is 
available” (page 465)

• “Activation process when the Passport provisioning session is in use” 
(page 466)
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• “Activation process when a task, component creation, modification, 
or deletion fails” (page 467)

• “Activation process when a service creation fails” (page 468)
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Setting the options for saving and activating provisioning 
changes

Use this procedure to set the options for saving and activating provisioning 
changes. You use the Save/Activate Options dialog box to preset your save 
and activation options to save provisioning changes to a named view file and 
to commit the saved view. 

These options can only be set for this Embedded Nodal Provisioning session.

Procedure 
1 To pre-select your save/activate options, from the Edit menu bar, select 

Save/Activate Options... .
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The Save/Activate Options dialog box opens.

2 In the Save View panel, select Save and then from the Type drop down 
list, select one of the following format options for saving the view:

• ascii saves the view in ASCII format.

• delta saves the view in delta format

• portable saves the view in portable format.

• portable and ascii saves the view in both portable and ascii formats

3 From the view mode drop down list, select one of the following view mode 
options: User Specified, Keyed, and Dated. 

• If you select Keyed, type a valid key in the Key field. The key is used 
to search for service data views. The service data view that matches 
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the pattern and that has the highest index is found, and the next view 
in the sequence is created. You can name a file by using one to six 
alphanumeric characters or by using a 1 digit fully numeric download 
key. A fully numeric download key cannot be less than three digits.

• If you select Dated, type today or type a date in the format yymmdd 
where yy is the year, mm is the month, and dd is the day. When you 
enter a date, the service data view with the highest two digit index 
(nn) is found and the next view in the sequence is created, in the 
format <yymmdd><nn>. For example 03012901. See “Date 
Convention” (page 31) for more information on the date format. 
When you enter today, the view is saved with today’s date, in the 
format yymmd<nn>.

• If you selected User Specified view mode, in the File field, enter a 
file name or click Browse to open a Select View file browser dialog 
box containing a list of user specified views. Select a view name and 
click OK.

• If you select Same as Opened View, the adjacent field is pre-filled 
with the name of the opened view used in step 3 and the extension 
full.<nnn>.

Alternatively, if you select User Specified, click Browse... and in the file 
browser, select a file name and location to save the file.

4 If you also wish to commit the saved view, select Commit, otherwise 
proceed to step 5.

Note:  The Activate option is selected an can not be deselected.

5 If you want the Save/Activate Options dialog box to display with each 
activation, ensure that the Show this form with each activation check 
box is selected. Modified 

6 Click OK to close the Save/Activate Options dialog box.

Subsequent task actions will result in the current view being saved to the 
chosen named view. If you also selected Commit, any subsequent task 
actions will result in the current view being saved to the chosen named 
view and that named view will also be committed.
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Saving and activating provisioning changes
If “Show this form with each activation is selected, the Save/Activate Options 
dialog box will open each time you click Save/Activate in the Embedded 
Nodal Provisioning window or Save/Activate Task from the Task menu or 
popup menu. If you have preselected the save/activate options, the dialog box 
opens with these options. If you do not want this dialog box to open with each 
activation, you need to deselect this option. See the procedure “Setting the 
options for saving and activating provisioning changes” (page 473).

For an illustration of the figure that opens, see the figure “Save/Activate 
Options dialog box when you select Save/Activate Task” (page 477). This 
dialog box is the same as the dialog box that opens when you select Save/
Activate Options... from the Edit menu except the “Show the form with each 
activation” check box does not appear.
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Figure 36
Save/Activate Options dialog box when you select Save/Activate Task

If “Show this form with each activation”, is deselected, this dialog box does 
not open and the task is saved and activated using the default options if you 
have not made changes to them or, if you have made changes to the default 
options, with the options that you have selected.

Each provisioning change is made to the current Passport view and activated 
and confirmed when applied. The provisioning view is checked for semantic 
errors before it is activated. By default, the changes are not saved to a named 
view file and are not committed. 
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Procedure 
1 To save/activate your provisioning changes, do one of the following: 

• click Save/Activate in the Provisioning Task panel

• select Save/Activate Task from the Task popup menu

• select Save/Activate Task from the Task menu

If “Show this form with each activation” is selected, the Save/Activate 
Options dialog box opens. Proceed to step 2.

If the “Show this form with each activation” is deselected, the Save/
Activate Options dialog box does not open and the provisioning changes 
are saved and activated using the default options if you have not made 
changes to them or, if you have made changes to the default options, with 
the options that you have selected

2 Make changes to the preset selections, as desired, and click OK.
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Viewing the Task Activation Queue
Use this procedure to display or hide the Task Activation Queue in a panel at 
the bottom of the Embedded Nodal Provisioning window. The Task 
Activation Queue shows the provisioning tasks that are waiting for the 
Passport provisioning session to become free before you can begin 
provisioning the device. You can also view the order in which these pending 
tasks will be applied to the device.

Procedure
1 From the View menu, select Task Activation Queue to display order in 

which tasks will be activated and their present status in the task activation 
queue at the bottom of the Embedded Nodal Provisioning window.

To hide the task activation queue, deselect Task Activation Queue.
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Viewing the state of the provisioning session
Use this procedure to display the state of the provisioning session. 

Procedure
1 From the View menu, select Provisioning Session... to display the state 

of the provisioning session. 

If the provisioning session is in use, you are provided details on who is 
using the session.
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Canceling the activation of a single provisioning task 
Use this procedure to cancel the activation of a single task.

Prerequisites
This procedure requires that the following condition is met:

• The task must be waiting for a provisioning session in the Task 
Activation Queue.

Procedure
1 In the Task Activation Queue, select the task whose activation you wish 

to cancel.

2 Complete one of the following steps:

• In the Task menu, select Cancel Activation.

• Right-click on the task in the Task Activation Queue, and from the 
pop-up menu, select Cancel Activation.

The task icon changes to the “Open” icon, and the task is removed from 
the Task Activation Queue.
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Canceling the activation of more than one provisioning task
Use this procedure to cancel the activation of one or more tasks showing in 
the Task Activation Queue.

Prerequisites
This procedure requires that the following condition is met:

• There is more than one task waiting for a provisioning session in the Task 
Activation Queue.

Procedure
1 Complete one of the following steps:

• In the Task menu, select Cancel Activations

• Right-click on the task in the Task Activation Queue, and from the 
pop-up menu, select Cancel Activations.

The Cancel Activations dialog box opens. It displays all of the 
provisioning tasks that have been activated, but are waiting for the 
Passport provisioning session to be free.

2 Select one or more of the provisioning tasks.

3 Click OK.

The Cancel Activations dialog box closes. The icons on the selected 
tasks change to the Open icon, and the selected tasks are removed from 
the Task Activation Queue.
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Concurrent provisioning conflicts and resolution
See the table “Concurrent provisioning conflicts and resolution” (page 483) 
for information on identifying and resolving conflicts arising from having one 
or more persons provisioning at the same time

Table 50
Concurrent provisioning conflicts and resolution

Conflict condition Remedial action

Concurrent component creation 

Two people try to create the same Passport 
component on the same device, the first person to 
activate the component creation on the device 
succeeds. When the second person tries to 
activate the component creation, the activation 
fails because the component already exists in the 
current view.

The second person can create a different 
component ID, or remove the component 
creation action from the task being activated, or 
create the new change action on the same 
component.

Concurrent component modification 

Two people try to modify the same Passport 
component on the same device, the last person to 
activate the component modification on the 
device succeeds. The first person to activate will 
not know that their modifications may have been 
lost, and the second person to activate will not 
know that they may have overwritten another 
person’s changes.

Reduce the chance of concurrent component 
modification conflict by clicking Refresh on the 
component modification form as close as 
possible to the time of activation for that 
component modification.

 (Sheet 1 of 2)
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Error messages
The table “Error messages” (page 486) describes the error messages that you 
may encounter while using Embedded Nodal Provisioning.

If error messages are encountered during Passport Check Prov, you are asked 
if you wish to keep the provisioning session open while they fix the problem. 

If an attempt to create a service is only partially successful, a Service Creation 
Errors dialog opens. The provisioning session remains open while the Service 
Creation Errors dialog is open.

In both cases, as long as the Passport provisioning session is held by the task, 
the Task Repair timeout value is used to limit the amount of time you hold 
onto the provisioning session. The timeout is configurable by the 
administrator. For the procedure to set the Timeout, see the section about the 
Nodal Provisioning Administration tool in 241-6001-303 Preside MDM 
Administrator Guide. 

Concurrent component deletion 

Two people try to delete the same Passport 
component on the same device, the first person to 
activate the component deletion on the device 
succeeds. When the second person tries to 
activate the component deletion, the activation 
fails.

Remove the component deletion action from 
the task being activated.

Concurrent service template activation

Two people try to create the same service on the 
same device, the first person to activate the 
service creation succeeds. When the second 
person tries to activate the service creation, the 
activation may fail if both of the service templates 
defines the same component creations, 
deletions, and modifications.

The second person needs to change the 
component instance IDs that are set in the 
service template form.

Table 50 (continued)
Concurrent provisioning conflicts and resolution

Conflict condition Remedial action
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When the timeout value has elapsed, you are prompted to confirm that you 
still want to hang on the provisioning session. You are given thirty seconds to 
respond to the prompt. If you do not respond in this time frame, the 
provisioning session is released and the entire task activation fails. Other 
tasks pending activation in the Task Activation Queue do not proceed to be 
activated until you acknowledge the task failure. At this point, you are given 
the chance to cancel one or more of the pending activations.

If the provisioning session to the device is lost, Embedded Nodal 
Provisioning automatically tries to re-establish the connection a specific 
number of times. You can configure the number of retries in the Nodal 
Provisioning Administration tool. If the connection cannot be reestablished, 
Embedded Nodal Provisioning terminates with an error message.

If Embedded Nodal Provisioning is in the process of activating a task when 
the server connection is lost, one of the following occurs:

• If the connection is lost before the new Passport view is saved or 
activated, the provisioning changes are lost.

• If the connection is lost after the new Passport view is saved, but before 
it is activated, the provisioning changes are in the saved view, but are not 
active on the device. You need to manually activate the saved view.

• If the connection is lost after the new Passport view is activated, but 
before the activation is confirmed, the provisioning changes are activated 
for a short period of time, and you must manually confirm the activation.
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Table 51
Error messages

Error condition Error message Remedial action

Cannot connect to the 
Configuration Manager 
server. This can occur when 
you start Passport Shelf 
View and it cannot connect 
to the ConfigMan server, or if 
the connection to the server 
cannot be established when 
a provisioning action is 
initiated from Passport Shelf 
View.

Unable to connect to the 
Configuration Manger 
Server. Verify that the 
server is running and 
that there is no value 
defined for the server 
port.

Check the server configuration 
and restart the server if required.

Connection to the 
Configuration Manager is 
lost.

The connection to the 
Configuration Manager 
Server for provisioning 
has been lost. Verify 
that the server is 
running.

Restart the server, if required.

Passport semantic check 
completed with errors during 
the activation of the 
provisioning task. The actual 
Passport semantic check 
error message is also 
displayed in this dialog

Passport semantic check 
completed with errors.
[Passport Check Prov 
Error Message]
This task will not be 
activated. Do you wish to 
retain the provisioning 
session while you repair 
the problem?

Click Yes or No to acknowledge 
the error and to optionally retain 
the provisioning session while 
repairing the problem. Click. The 
Task Repair Timeout is applied 
to this dialog. The dialog 
automatically selects No and 
closes after waiting for the 
timeout value. You are shown 
the remaining amount of time 
before timeout on the “No” 
button.
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Errors from Passport 
semantic check; provisioning 
session released.

This message is displayed if 
the Passport semantic check 
completed with warnings/
errors during the activation of 
a provisioning task. You 
selected to release the 
provisioning session.

Passport semantic check 
completed with errors.
[Passport Check Prov 
Error Message]
This provisioning 
session has been 
released. Do you wish to 
proceed with activation 
of the remaining tasks.

Click Yes or No to optionally 
proceed with other task 
activations in the queue. Until 
you respond, no other tasks in 
the Task Activation Queue are 
activated, even though the 
provisioning session has been 
released.

Passport semantic check 
completed with warnings 
during the activation of a 
provisioning task. The actual 
semantic check warning 
message is also displayed in 
this dialog.

Passport semantic check 
completed with warnings 
[Passport Check Prov 
Warning Message]
Do you wish to retain the 
provisioning session 
while you repair the 
problem?

Click Yes or No to acknowledge 
the warning message and 
optionally retain the provisioning 
session while repairing the 
problem. The Task Repair 
Timeout is applied to this dialog. 
The dialog automatically selects 
No and closes after waiting for 
the timeout value. You are 
shown the remaining timeout on 
the No button.

Passport semantic check 
completed with warnings 
during the activation of a 
provisioning task. You 
selected to release the 
provisioning session.

Passport semantic check 
completed with warnings 
[Passport Check Prov 
Warning Message]
The provisioning session 
has been released. Do you 
wish to proceed with the 
activation of the 
remaining tasks.

Click Yes or No to optionally 
proceed with other task 
activations in the queue. Until 
you respond, no other tasks in 
the Task Activation Queue are 
activated, even though the 
provisioning session has been 
released.

Table 51 (continued)
Error messages

Error condition Error message Remedial action
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Errors encountered while a 
service is being created on 
the device

Service Creation errors dialog 
box opens.

See the procedure “Repairing 
service creation errors 
overview” (page 183)

Provisioning servers are 
unable to connect to the 
Passport device either to 
read data from the Passport 
or provision data on the 
device.

Unable to connect to [Passport 
name] for provisioning. 

Insufficient provisioning 
privileges on the device

The device authentication dialog 
box opens.

See the procedure 
“Authenticating to a device” 
(page 421)

Unable to Create/Modify/
Delete Component because 
the provisioning actions in 
the task could not be 
performed on the current 
Passport view

Activation failed for [task name]. 
Unable to [create/modify/delete] 
[component name].

[Passport error message].

The task will not be activated. Do 
you wish to retain the 
provisioningsession while you 
repair the problem?

Click Yes or No to acknowledge 
the activation failure and 
optionally retain the provisioning 
session while repairing the 
problem. The Task Repair 
Timeout is applied to this dialog. 
The dialog automatically selects 
No and closes after waiting for 
the timeout value. You are 
shown the remaining timeout on 
the No button.

Table 51 (continued)
Error messages

Error condition Error message Remedial action
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Unable to Create/Modify/
Delete Component because 
the provisioning actions in 
the task could not be 
performed on the current 
Passport view. You have 
chosen to release the 
provisioning session.

Activation failed for [task name]. 
Unable to [create/modify/delete] 
[component name].

[Passport error message].

The provisioning session has 
been released. Do you wish to 
proceed with the activation of the 
remaining tasks?

Click Yes or No to optionally 
proceed with other task 
activations in the queue. Until 
you respond, no other tasks in 
the Task Activation Queue are 
activated, even though the 
provisioning session has been 
released.

If a component could not be 
deleted because it does not 
exist in the current view, remove 
the component from the 
provisioning task.

If a component could not be 
created because if already 
existed in the current view, 
remove the component from the 
provisioning task, or assign 
another component instance ID 
to it in the Component Creation 
form, or change the Add action 
into a change action.

If a component could not be 
modified because it does not 
exist in the current view change 
the component modification 
action to a component creation 
action.

Table 51 (continued)
Error messages

Error condition Error message Remedial action
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In a Component Modification 
form, the Embedded Nodal 
Provisioning is unable to 
retrieve the component data 
from the Passport, possibly 
because the component to 
be modified has been 
deleted from the current 
Passport view.

Unable to refresh the form for 
[component name]. 

[Passport error message] 

Check if the component to be 
modified has been deleted from 
the current Passport view.

An attribute in an activated 
task is invalid according to 
the CDL range and type

An invalid value has been 
specified for [attribute name] in 
[provisioning action name]. Enter 
a value in the valid range and 
reactivate the task. 

Enter a valid attribute and 
reactivate the task.

Internal software error 
detected in the provisioning 
window.

An internal software error has 
occurred in the ENP provisioning 
window. The provisioning 
window will now close.

The Embedded Nodal 
Provisioning window closes. 
This is unlikely to affect the 
operation of Passport Shelf 
View. Only errors affecting the 
Java virtual machine, such as an 
out of memory error, will cause 
Passport Shelf View to shut 
down.

Table 51 (continued)
Error messages

Error condition Error message Remedial action
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Launching external tools from Embedded Nodal 
Provisioning

Use this procedure to launch any of the following tools from the Embedded 
Nodal Provisioning window: 

• Nodal Provisioning

• Nodal Provisioning Template Editor

• Service Provisioning

— ATM

— CES SVC

— Frame Relay

— IP VPN Global Update

Procedure
1 From the External tools menu, select the desired tool:

• Nodal Provisioning

• Nodal Provisioning Template Editor

• Service Provisioning -> ATM to open the ATM service provisioning 
tool.

• Service Provisioning -> CES SVC to open the CES SVC service 
provisioning tool

• Service Provisioning -> Frame Relay to open the Frame Relay 
service provisioning tool

• Service Provisioning -> IP VPN Global Update to open the IP VPN 
Global Update tool
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component layout tree 281
adding the first non-top level component in the 

template editor component layout 
tree 279

adding the first top-level component in the 
template editor component layout 
tree 277

ANP nodal provisioning forms 101
component form 101
service form 108

ANP nodal provisioning main window
component pop-up menu 75
service palette 76, 97

architecture 25
attribute descriptive help

accessing 35
attribute details in template editor

modifying 299
attribute range tool tip help

accessing 37
Preside 
C
CDL version

selecting in template editor 259
component

adding a component 138
compressing 119
deleting 153
expanding 118
searching 120

Component Data panel 324, 332
component data report

copying to a text editor 370
on subset of component data 356

component data reports
removing rows 353

component form
about 101

component hierarchy navigation tasks
compressing a component 119
expanding a component 118

component model file 30
component model generator 29
component parent designation

selecting 293
component provisioning procedures

adding a component 138
deleting a component 153

Component Selection panel 332
compound filter 334
compressing a component 119
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CONFIGMAN 29
see configuration manager 29

configuration manager 29
configuration server

Passport configuration server 29
creating a new service template 258
creating and saving service data reports 354

D
date convention 31
default query output for version checking 

tool 321
deleting a component 153
details panel in component layout tab

description 225
details panel in template editor main 

window 230
device configuration servers

about 29
Passport configuration server 29

E
Edit menu for the report generator tool main 

window 327, 328
Embedded Nodal Provisioning

interface description 393
overview 389

emplate editor procedures
saving service template files 312

expanding a component 118

F
File menu - report generator tool main 

window 326
filter dialogs 333

compound filter 334
simple filter 334
sub-filter

sub-filter 335
form layout tree in template editor

adding groups 306
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hiding components 309
removing groups 308
removing tabs 305
showing components 310

H
Help

accessing from the ANP nodal provisioning 
main window 34

on component forms 36
on service forms 36
on service template forms 36

hiding component in form layout tree in 
template editor 309

hierarchy model file 30

L
Log Viewer

about 373
main window 375

M
menu bar

template editor 225
menu bar for report generator tool 326
model files 30

component model 30
hierarchy model 30
service model 30
service template model 30

modifying attribute details in template 
editor 299

modifying template identification 
attributes 274

O
opening a service template file 254
overview 23

P
Passport configuration server 29
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PCSERVER
see Passport configuration server 29

R
removing a component in template editor form 

layout tree 311
removing a dropsite in template editor 292
removing groups from form layout tree in 

template editor 308
removing tabs in form layout tree in template 

editor 305
report generator tool

component data report 370
component data reports on subset of 

component data 356
compound filter 334
creating and saving service data 

reports 354
filter dialogs 333
menu bar 326
overview 323
procedures 337
removing rows in component data 

reports 353
sub-filter 335
using 337

report generator tool main window 324
Component Data panel 332
Component Selection panel 332
Edit menu 327, 328
File menu 326
menu bar 326
Selected menu 329
Title field 332
Tool bar 331
Tools menu 329

S
sample outputs for version checking tool 320
saving service template files

312
Preside 
searching for a component 75, 120
Selected menu for report generator tool main 

window 329
selecting a component parent designation in 

template editor 293
selecting a parent dropsite in template 

editor 289
service data reports

creating and saving 354
service form

about 108
service model file 30
service palette

about 76, 97
service creation templates 76, 97

service provisioning procedures
adding a service 168

service template
see Service Template Editor

Service Template Editor
overview 30

service template file
opening 254

service template files
location 221
saving 312

service template model file 30
service templates

about 76, 97
showing components in template editor form 

layout tree 310
simple filter

report generator tool
simple filter 334

starting the ANP nodal provisioning application
on a workstation running NMS 51

with context 43
starting the version checking tool 320
STE

see Service Template Editor
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T
tabs and groups in template editor

renaming 302, 303
template editor 219

Choose CDL Version dialog 259
main window at startup 222
overview 220
selecting a CDL version 259
starting 250
tabs and groups 302, 303
version checking tool 319

template editor dialogs
Choose CDL Version 259

template editor form layout
adding tabs 304

template editor main window
after loading a service template file 224
component layout tab details panel 225
details panel 230
form layout tab 234
menu bar 225
template identification panel 229

template editor main window after loading a 
service template file 224

template editor main window at startup 222
template editor procedures

adding a link dropsite 291
adding components 276

adding components in template editor 
component layout tree 280

adding groups to the form layout tree 306
adding subcomponents 281
adding tabs to the form layout tree in 

template editor 304
adding the first non-top level 

component 279
adding the first top-level component 277
creating a new service template 258
hiding a component in the form layout 

tree 309
modifying attribute details 299
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modifying template identification 
attributes 274

opening a service template file 254
removing a component from the form layout 

tree
form layout tree in template editor

removing a component 311
removing a dropsite 292
removing groups from the form layout 

tree 308
removing tabs from form layout tree 305
renaming tabs and groups 302, 303
selecting a component parent 

designation 293
selecting a parent dropsite 289
showing components in the form layout 

tree 310
template identification attributes

modifying 274
template identification panel in template editor 

main window 229
Tool bar for report generator tool main 

window 331
Tools menu for report generator tool main 

window 329

U
using the report generator tool 337

V
version checking tool

about 319
default query output 321
sample outputs 320
starting 320

Version Selection dialog 61
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